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Window OperationsWindow Operations

How to Dock a BarHow to Dock a Bar
Various tools, short-cuts and commands are gathered on "Toolbars" (strips with symbols). These can be
used either as "palettes" (separate windows) or you can "dock" them to the window edges. The following
Toolbars are available:
- The Control Bar
- The Transport
- The Toolbox
- The Snapshot Toolbar
There are two ways to dock a Toolbar:
• Drag the Toolbar window (by its title bar) to any of the sides of the application window and release the

mouse button.
The outline shows you the shape of the toolbar at the docked position.

• Double click on the title bar of a Toolbar window.
It will return to its last docked position.

Please note that you can stack Toolbars and put them side by side, to create any type of layout you desire.

How to Turn a Bar into a windowHow to Turn a Bar into a window
There are two ways:
• Drag the gray border surrounding the Toolbar’s buttons, out from the docked position, or...
• Double click somewhere on the gray border.

Using non-modal dialogsUsing non-modal dialogs
WaveLab uses non-modal dialogs for many of the processors, among other things. This allows you to
select from menus and work in other windows without closing the dialog in between. Here are a few hints
on what non-modal dialogs allow you to do:
- You can play back the wave without closing the dialog.
- You can Undo and Redo without closing the dialog.
- You can adjust the selection before reprocessing.
- There are useful hot key commands for use from non-modal dialogs (and also from all other windows

in fact) :
[F2] Toggle focus between the dialog and the document window
[Control] - [F2] Open list of open windows
[F3] Undo
[F4] Redo
[F6] Play selection
[Shift]-[F6] Turn on Loop and play selection
[F7] Stop / Move to selection start / Move to beginning
[F8] Play (from current position)

Folding dialogsFolding dialogs
By double clicking on the dialog's title bar, you can fold it in so that it occupies less screen space. To unfold
it, double click on the title bar again.
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Showing/Hiding ToolbarsShowing/Hiding Toolbars
There are various ways to show/hide a Toolbar:
• Use the main Windows menu, or...
• Press the right mouse button anywhere on a Toolbar and select from the menu that appears, or...
• Use the keys [F9] to [F12].

Each of these keys "toggles" the display of one of the Toolbars.
• You can of course hide a Toolbar by clicking its Close box.

Changing the appearance of ToolbarsChanging the appearance of Toolbars
• To change the shape of a Toolbar between different variations on horizontal, square and vertical, drag

the right or bottom edge as when resizing any other window.
• To change the size of the buttons in the Toolbar, open the Preferences dialog, click the

"Toolbars/Control Bar" tab and adjust the "Button size" setting.

How to Check what a Bar button doesHow to Check what a Bar button does
1. Select Preferences from the Options menu and click on the Toolbars/Status Bar tab.
2. Make sure "Show Tips" is activated.
3. Close the Preferences dialog.
4. Move the pointer over an item on the Toolbar and wait a moment.

A text showing the name of the button appears.

The Document Switch BarThe Document Switch Bar
A quick way to switch between the open document windows is to use the Document Switch Bar. This is a
row of "tabs", by default positioned at the bottom of the screen. Each open document window has a
corresponding tab - clicking the tab brings the window to the front.
• If you position the mouse pointer over a tab on the Document Switch Bar, and leave it there for a

second, a tool tip appears, displaying the full path for the audio file/montage file in the corresponding
document window.

• The Document Switch Bar is also useful when dragging and dropping material (e.g. audio selections)
between document windows: If you drag from one window and position the pointer over the other
window's tab, the other window will automatically be activated and brought to front.
This makes it easier to drag and drop between windows that obscure each other.

• By using the Document Switch Bar submenu on the View menu, you can position the Bar at the top,
bottom, left or right side of the screen.
This submenu also lets you to hide the Document Switch Bar, if you like.

How to Adjust pane sizesHow to Adjust pane sizes
1. Position the mouse somewhere over the divider between the two panes.
2. Drag the divider to adjust the pane size.

How to Hide PanesHow to Hide Panes
In some windows, a pane can be hidden altogether.
• To hide a pane, drag the border between the two panes all the way up or double click anywhere on it.
Hiding/showing the Overview pane in the Wave window can also be achieved by pressing [O] on the
computer keyboard or by double clicking on the divider.

How to Reveal PanesHow to Reveal Panes
• To reveal a hidden pane, drag the miniature border symbol (above the vertical scroll bar) down or

double click on it.
Hiding/showing the Overview pane in the Wave window can also be achieved by pressing [O] on the
computer keyboard.
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How to Fold a windowHow to Fold a window
If you find a window takes up too much screen space, but still don’t want close it, you can "fold it in" to
temporarily make it smaller.
• To "fold in" a window, click on the fold-in icon on the title bar.

For dialogs, you can also double click on the title bar.
• To return to normal size, just click again.

How to Use Speed menusHow to Use Speed menus
Most displays have speed menus associated with them.
• To bring up a speed menu, click with the right mouse button in the desired area.
In the Wave windows for example there is one speed menu for the level ruler, one for each of the time
rulers and one for each of the waveform displays.
The Speed menus double up for the main menus (some items can be found both on speed and main menus)
but some speed menus also contain unique items.
When searching for a function, don’t forget to check the speed menus in the window in which you are
working!

How to Maximize the Width of a windowHow to Maximize the Width of a window
• Selecting the Maximize Width item on the View menu makes the window as big as the screen (or other

factors) permit.

Working with multipe windows of the same dataWorking with multipe windows of the same data
You can edit the same data in more than one window. Among other things this allows you to work on
different sections of a wave file (for example the start and end), without scrolling back and forth.

Creating a Second window using MenusCreating a Second window using Menus
1. Make sure the desired window is the active one.

If it isn’t, click once in its title bar.
2. Select Duplicate View from the View menu.

Creating a Second window by draggingCreating a Second window by dragging
1. Make sure "Create windows using mouse" is activated in the Display part of the Preferences dialog.
2. In some empty free area of the WaveLab application window, drag to make up a box.

This must be of a certain minimum size. If you don’t get a new window, try again with a bigger box.

Working with two windowsWorking with two windows
When you have two windows open that are views of exactly the same data, any change you make in one
window is immediately apparent in the other.

ClosingClosing

How to Close one windowHow to Close one window
You can close one document window by:
• Clicking its close button.
• Selecting Close from the File menu.
• Pressing [Control]-[W].

There’s a slight difference between these: If one wave is being edited in several windows (see Working
with multiple windows of the same data), Close on the File menu and [Control]-[W] closes all those
windows at the same time.

If the document window(s) contain unsaved changes, you will be asked whether you want to save those
changes before closing.
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How to Close all windowsHow to Close all windows
• You can close all Wave Windows, or all Windows (Waves, Projects and Databases) by selecting the

corresponding option from the Window menu.
If the document window(s) contain unsaved changes, you will be asked whether you want to save those
changes before closing.

MinimizingMinimizing

How to Minimize one windowHow to Minimize one window
WaveLab windows are minimized, like any other, by clicking the minimize icon on the title bar. See your
Windows documentation for details.

How to Minimize all windowsHow to Minimize all windows
• You can minimize all Wave Windows, or all Windows (Waves, Projects and Databases) by selecting

the corresponding option from the Window menu.
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General OperationsGeneral Operations

Optimizing the virtual memory settingsOptimizing the virtual memory settings
If you use Windows 95 (as opposed to Windows NT) it is important that your virtual memory settings are
correct, to optimize the speed of various operations in WaveLab.
1. Make sure no programs are running.
2. Click on the Start button on the Taskbar and select the Control Panel.
3. In the Control Panel window, double click on System.
4. Click the Performance tab.
5. Click the Virtual memory button.
6. Click on the button "Let me specify my own virtual memory settings".
7. Specify 40 (MegaBytes) as the minimum, and twice your RAM size as maximum.
8. Click OK, Yes, Close and Yes in the dialogs that appear.

The computer will be restarted.

Optimizing the color settingsOptimizing the color settings
You might want to optimize the number of colors you use when you run WaveLab.
- WaveLab operates best in 256-color mode.
- 16 colors is on some systems slightly slower than 256 colors, and doesn’t let you take full advantage of

WaveLab’s color capabilities.
- Thousands of colors (or more) is not advised since it will make WaveLab run slower and consume more

memory than in the other modes.
See your Windows documentation for instructions on how to change the number of colors used on your
computer.

Setting up the audio cardSetting up the audio card
You need to "inform" WaveLab about which audio card you want to use:
1. Select "Preferences" from the Options menu.
2. Click on the "General" tab.
3. Select the audio card you want to use for recording and playback, from the Devices pop-ups.

If you only have one audio card you can possibly also select the "Microsoft Sound Mapper" options,
(the Sound Mapper is a "virtual audio card" which "maps" all audio to your real card). However this
does not let you take full advantage of the card’s driver when recording, and is therefore not
recommended.

Deciding where "temp" files are putDeciding where "temp" files are put
You need to specify where WaveLab should store its temporary files. Temporary files are mainly used for
Undo, as explained below.
1. Create a separate folder to store your "temp" files in.

This is done from the Desktop, using the Explorer.
This folder should be on your fastest hard disk and you should make sure you have plenty of room
available on that hard disk (or partition).

2. In the Preferences dialog, click the File tab.
3. Either type in the path to the directory or click the Browse button to locate and select the folder.

Save the PreferencesSave the Preferences
To make permanent the settings you just made, proceed as follows:
1. Click on the General tab in the Preferences dialog.
2. Make sure that "Save preferences on exit" is activated.
3. Close the Preferences dialog.
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Temp files and UndoTemp files and Undo
When WaveLab needs to create a file for Undo, it puts this in the "temp" folder you have specified and
gives it the extension "$$$". These files are automatically deleted when you quit WaveLab or when you use
Purge Undo. If you find any such files when you are not running WaveLab, you can delete them.

Checking which formats the card supportsChecking which formats the card supports
You can check whether your audio card supports the three most common sample rates.
1. Select Preferences from the Options menu.
2. Click on the General tab.
3. Click the two question mark icons to find out which sample rates and bit resolutions are supported for

playback and recording, respectively.
Unfortunately, there is no provision in Windows for checking all sample rates that a card supports, so the
result of this test only tells whether these three rates are supported or not. The card may still support other
rates. Please check the user documentation for the card.

Setting values in dialog boxes and windowsSetting values in dialog boxes and windows
In dialog boxes, you will find yourself adjusting values. The following techniques apply:

Typing ValuesTyping Values
Like in most other Windows programs you can "tab to" or click directly on a value and type in a new one.

Using the Spin ControlsUsing the Spin Controls
All values can be set using the regular Windows spin controls – two arrows pointing up/down.
• Clicking either arrow raises/lowers the value.
• Keeping the mouse button pressed over an arrow makes the value "scroll".
• Holding down [Control] makes the value change in larger steps.
• Holding down [Control]+[Shift] changes the value to its minimum/maximum.
• The last adjusted control can be changed using the up and down arrow keys, also in combination with

[Control] or [Control]+[Shift] as described above.

Using Sliders and pop-upsUsing Sliders and pop-ups
Many times, the most convenient way to change a value is using WaveLab’s proprietary sliders and pop-
ups:
1. Click with the right mouse button on the spin control.
2. If a pop-up menu appears, select one of the options on it.
3. If one or more sliders appear, drag the handle(s) or click the arrows to set the value.

The setting is shown in the value box "behind" the slider window.
4. When you are done, click outside the slider window.
- If the value is "segmented" (for example divided into minutes and seconds etc.), more than one slider

will appear, each used for adjusting one of the "segments".
- The slider window can be dragged to any position on the screen, using the "title bar" at the top.
- The last used slider can be adjusted using the up and down arrow keys on the computer keyboard.

Using an "Intellimouse"Using an "Intellimouse"
If you have access to a Microsoft Intellimouse™ or compatible pointing device, you can take advantage of
the wheel for various operations in WaveLab:

ScrollingScrolling
• If you point at a waveform, the wheel scrolls the view horizontally.

ZoomingZooming
• If you hold down [Ctrl] and point at a waveform, the wheel zooms the view horizontally.
• If you hold down [Ctrl] and [Shift] and point at a waveform, the wheel zooms the view vertically.
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Changing ValuesChanging Values
• If you point at an edit field in a dialog, the wheel can be used to adjust the value.
• If you also hold down [Ctrl], the value changes in bigger steps and if you hold down [Ctrl] and [Shift] it

jumps to the bottom/top values.

Master SectionMaster Section
• When working in the Master Section window, the wheel can be used to adjust the master volume. If

you hold down [Shift] the value changes in steps of 6dB (rather than 1dB).
• If you hold down [Alt] you can change the Master Section volume, regardless of which window is

active. This can be combined with [Shift] as described above.

Setting up PreferencesSetting up Preferences
In the Preferences dialog (reached from the Options menu) you will find a number of settings that can be
used to tailor the look and behavior of the program.
The settings are collected on tabs. To find out what each one does, please use the context sensitive on-line
help.

Saving the PreferencesSaving the Preferences
To make sure the Preference settings "stick", proceed as follows.
1. Open the Preferences dialog and click on the General tab.
2. Make sure "Save preferences on exit" is activated.

Creating start-up PreferencesCreating start-up Preferences
To make sure the program starts with one and the same Preference settings each time you launch it,
proceed as follows:
1. Set up all Preferences as desired.

See Set up Preferences
2. Make sure "Save preferences on exit" is activated.
3. Quit the program.
4. Launch the program again, and deactivate "Save preferences on exit".

Now you can change the Preferences for this session, but the settings you had when you last Quit will
be the ones you get the next time you launch the program.

Checking the available hard disk spaceChecking the available hard disk space
The available disk space for recording and Undo is limited by the size of the disk where you store your
temporary files.
• To find out how much disk space you have available on each of your volumes, select "Free Disk Space"

from the File menu.
The window that appears displays this information both graphically and as a number.

Putting a limit on the Undo functionPutting a limit on the Undo function
If you run out of hard disk space or if you are applying processing to extremely long sections of waves, you
might want to put a limit on the Undo function:
1. Select Preferences from the Options menu.
2. Click on the Editing tab.
3. Uncheck the "Unlimited" option in the Undo/Redo section.
4. Change the Limit number to the desired value.
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Clearing the Undo functionClearing the Undo function
There might be situations where you have "collected" a large number of Undo possibilities that you know
you don’t need. You might then clear the whole Undo "buffer" for one file at a time. This will free up some
primary memory (RAM) but more importantly it will also delete all the "undo files" from your hard disk, to
free up space.
1. Select "Purge undo" from the Edit menu.

A window appears informing you of how much RAM and hard disk space you will gain by this
operation.

2. Click OK.
Please note that this function only works on one document at a time. It is only the Undo buffer for the file
in the active window that will be cleared.

Displaying the ClipboardDisplaying the Clipboard
• If you want to see the contents of the WaveLab clipboard (not the main Windows clipboard), select

Clipboard from the Edit menu and Show from the sub-menu that appears.
The Clipboard window opens.

The Clipboard is a Wave window like any other (it is always in stereo) and any type of editing can be
applied to it except those involving Cut, Copy or Paste. You can even Undo and Redo operations on the
Clipboard!

Clearing the ClipboardClearing the Clipboard
If the clipboard is wasting hard disk space for other Temporary files, you way want to clear it.
• Pull down the Edit menu, select Clipboard and from the sub-menu that appears, select Clear.

Use PresetsUse Presets

Applying a PresetApplying a Preset
1. Open the dialog  where you want to Apply the Preset, and click on its Presets tab.
2. Double click on the Preset you want to use, in the list.

Alternatively you can click on the Preset once, and then click the Load button.
3. Click Apply.

Quick Loading of PresetsQuick Loading of Presets
• A quick way to load a Preset from the Settings tab of a dialog is to press the right mouse button on the

Preset tab and select from the menu that appears.

Creating a PresetCreating a Preset
1. Open the dialog for which you wish to create a Preset, and set up the dialog as desired.
2. Click on the Presets tab.
3. Click on the name line and type in a name for the Preset.
4. Click the Add button.

Modifying a PresetModifying a Preset
1. Open the dialog for which you wish to modify a Preset, and select and load the Preset.
2. Click the Settings tab and modify the settings.
3. Click the Preset tab.
4. Select the Preset you want to overwrite with the new settings.

If this is the same Preset as the original, you can skip this step, since that Preset is already selected.
5. Click the Update button.

Deleting a PresetDeleting a Preset
1. In the Presets tab, click on the Preset you want to delete.
2. Click the Delete button.
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Basic Wave OperationsBasic Wave Operations

Create a working environmentCreate a working environment

Setting ruler formatSetting ruler format
You can specify the time and level (amplitude) formats for each ruler in each window:
1. Press the right mouse button over the ruler, to bring up the speed menu for that ruler.
2. Select a format from the available options.

For details about each format, select it from the menu, and with the menu still up, press [F1].
3. If you have specified Time code or Meter as your time format, open the Preferences dialog, click on the

Tempo/Time code tab and specify details for the format.
See the dialog's context sensitive help for details.

Setting a ruler start positionSetting a ruler start position
Normally, the ruler is set so that the beginning of the file represents position "0". However, for editing
purposes you may want to set the "0" position to some other point in the file.
1. Click on the ruler at the point where you want position "0" to be.
2. Click with the right mouse button on the time ruler and select "Set origin at cursor" from the menu that

appears.
The ruler start point is moved to the cursor position.

Setting a format for dialogsSetting a format for dialogs
You can specify how units of time and level should be displayed in dialog boxes:
1. Select Preferences from the Options menu.
2. Click on the Units tab.
3. Use the radio buttons to select an option.

For details about the formats, use the context sensitive help. The "As active window" option means that
the formats in dialogs and on the status bar will follow the unit setting of the ruler in the active window.

4. If you have specified Time code or Meter as your time format, click on the Tempo/Time code tab and
specify details for the format.
Again, see the context sensitive help for details.

Changing Preferences that affect "looks"Changing Preferences that affect "looks"
The Preferences dialog contains various options that affect the "look" of the program.
1. Select Preferences from the Options menu.
2. Click on the desired tab, and change the settings:
- The Toolbar/Status Bar contains settings for all Toolbars and the Status Bar.
- The Display tab is used for various settings that affect the Wave window's appearance.
- The Units and Tempo/Time Code tabs contain various settings for time and level formats.
For details about the options in each tab, use the context sensitive help in the dialog.

Styling wave displaysStyling wave displays
For each channel in each wave display you can make settings that affect the following:
Waveform Elements
To select which elements should be visible, and their appearance, proceed as follows:
1. Press the right mouse button with the pointer somewhere within a channel in the main view or

overview.
2. From the menu that appears, select Elements and then select the desired item from the sub-menu that

appears.
For details about each item, select it from the menu, and with the menu still up, press [F1].

Color
You can also set the color of various items (background, waveform etc). See Changing Color.
Ruler Style
You can change the look of rulers, see Styling rulers.
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Applying Styles
All of the above can be defined as a Style, see Saving Styles.
To select a style for the current window, proceed as follows:
1. Pull down the Options menu.
2. Select Style, and from the sub-menu that appears, select the desired Style.

The Style setting is not saved with the file.

Styling rulersStyling rulers
To change the look of the rulers, proceed as follows:
1. Click on the ruler with the right mouse button.
2. From the menu that appears, select Style.
3. Select an option.

For details about each item, select it from the menu, and with the menu still up, press [F1].

Changing ColorChanging Color
To set the color of a certain element in the display, proceed as follows:
1. Click the right mouse button in the waveform display.

Please note that for all elements it matters whether you click in the overview or in the main wave
display and in which channel. If you for example want to change the color of the waveform in the left
channel in the main view, click there.

2. Select Color, and then select an element from the sub-menu that appears.
The standard Windows color dialog appears.

- Please note that the Wave cursor is shown in inverse video to speed up screen redraw! Hence it will be
shown in the "opposite" color compared to what you select.

3. Select or define a color and click OK.

Saving StylesSaving Styles
If you have made settings for Waveform elements, Colors and Ruler Style as described  on the cards
describing Waveform Elements, Styling rulers and Changing Color you have essentially created a Style.
You can save and recall six styles.
To create your own style, proceed as follows:
1. Set up the window as you want it, with regards to colors, rulers etc.
2. Pull down the Options menu.
3. Select Style and from the sub-menu that appears, then select Save.
4. In the dialog that appears, click one of the radio buttons and type in a name.
5. Click OK.

The Styles are saved globally, that is all windows have access to the same six styles.

The Default StyleThe Default Style
The top item on the Style menu and in the Style Save dialog is called Default. This is the Style that will be
used when you first open a window or create a new one by selecting New.

Working with Screen LayoutsWorking with Screen Layouts
Screen Layouts are used for creating various "work displays" for different situations. The following items
are stored in a Screen layout:
- The size and location of document windows.

This does not include the contents of the window, just the properties of the window "frame" itself. For
example, if some Database window was included in the Screen Layout, the Database you currently
have open when you Load the Preset will be sized and moved accordingly.

- Positions of "modeless" dialog boxes, such as the off-line processors.
This includes opening any such windows.

- Positions of plug-in processor panels.
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Creating and Recalling a Screen Layout
A Screen Layout is created just like regular Presets. To create a Screen Layout, proceed as follows:
1. Set up the display the way you want it.

This includes the locations and appearance of the items in the list above.
2. Select Screen Layouts from the View menu.
3. Use the Add and Update options to create and name the Screen layout.

This is done just as with Presets.
To Recall a Screen layout, proceed as follows:

1. Bring up the Screen Layout dialog.
2. Select the Layout in the list.
3. Click Load.

The display will be reorganized. Windows that are already open will never be closed as a result of
recalling a Screen Layout.

Set the Zoom factorSet the Zoom factor

Using the Zoom controlsUsing the Zoom controls
Both the main view and the overview have horizontal and vertical zoom controls located next to the scroll
bars. These are operated just like scroll bars:
- You can drag the handle to any position.
- You can click anywhere on the scale to move the handle there.
- You can click on the arrows at either end to change the zoom factor in smaller steps.

Either way, the zoom factor on the Status Bar is updated continuously.

Using the Magnifying glass in the main viewUsing the Magnifying glass in the main view
The Magnifying glass tool is used to specify any section of the waveform and have it occupy the entire
window.
Selecting the Tool
The Magnifying Glass Tool can of course be selected from the Tool box, but there are two other options:
- When you hold down [Control] and move the pointer over the main view, the magnifying glass is

automatically selected.
This is just a momentary selection, as soon as you release [Control] the pointer returns to the previous
tool.

- When you move the pointer over the overview, it turns into the Magnifying Glass automatically.
Using the Tool
1. Press the mouse button with the pointer somewhere in the waveform.
2. Drag left or right to make up a box, and then release the mouse.

The area that was inside the box will now fill the entire window.

Using the magnifying glass in the overviewUsing the magnifying glass in the overview
The Magnifying Glass is used in the overview, just as in the main view, see Using the Magnifying glass in
the main view. However, even though you use the tool in the overview, it is the main view that is zoomed.
You can for example use this as follows: Keep the overview zoomed out all the way and use the
magnifying tool to display any section in the main view.

Using Zoom selectionUsing Zoom selection
If you have made a selection, you can automatically zoom the window so that the selection fills the entire
display.
1. Make a selection.
2. Click the right mouse button in the main view or the overview.
3. From the menu that appears, select "Zoom selection".

Alternatively, you can press [K].
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Mouse ZoomingMouse Zooming
Using the mouse, you can continuously change the zoom factor by dragging:
1. Position the mouse pointer over the ruler in the main view.
2. Press the mouse button and drag up or down.
3. The zoom factor changes continuously.
- To freeze the cursor position, hold down [Shift].
- To make vertical zoom adjust automatically to the peaks in the waveform, hold down [Control].
- To switch to scrolling, hold down [Alt].
This technique works very well in combination with the fact that you can move the song position by
dragging horizontally in the ruler. By dragging in both directions, you can quickly find a certain position in
the file and display it at the desired magnification factor.
Using mouse zooming to its full effect requires some practice - but it is worth the effort!
Setting Sensitivity for Mouse Zooming
On the editing tab in the Preferences dialog, there’s a Sensitivity setting for mouse zooming. The higher the
value, the less sensitive the function. You might want to raise this value when you first try out the function.

Zooming via the keyboardZooming via the keyboard
A number of short-cuts are available for zooming, see Keyboard Commands - Zooming.

Using "Auto Zoom for overview"Using "Auto Zoom for overview"
This setting, found in the editing section of the Preferences dialog, allows you to have the zoom factor
automatically adjusted, so that it always shows the entire wave. This is mainly intended for the overview
pane (hence the name) but can be applied to the main view too. Below we assume you will use it for the
overview.
1. Activate "Auto zoom for overview" in the Preferences dialog.
2. Zoom out on the overview so that you see the entire wave.
Now, when you resize the window, the overview zoom factor is automatically adjusted so that the entire
wave is always shown. If you later zoom in on the overview, the automatic zooming is deactivated until
you zoom out all the way again.

Navigate through the fileNavigate through the file

Navigating using the range indicatorNavigating using the range indicator
In the overview, a striped line called the "range indicator" tells you which section of the file that is currently
displayed in the main view.
Furthermore, the range indicator moves while you drag the scroll bar handle. This means that by observing
the overview you can easily find positions in the main view when scrolling, even though the main view
might be zoomed right in.
The range indicator can be displayed at the top or bottom of the overview, by pressing the right mouse
button in the overview, selecting Elements and then selecting "Range indicator at top/bottom".

Navigating using the Scroll To  menuNavigating using the Scroll To  menu
There are two ways to bring up the "Scroll To" menu:
• Select Scroll To from the main View menu, or...
• Click with the right mouse button in the overview or in the main view.

The difference between the two methods is that the main menu always affects the main view, while the
speed menus affect either view depending on where you clicked.

For details about each item, select it from the menu, and with the menu still up, press [F1].

Move the cursorMove the cursor

Navigating using the TransportNavigating using the Transport
The transport is used for moving the wave cursor. If "Scroll during playback" on the Options menu is
activated, use of the Transport will also scroll the display.
Displaying the Transport
If the Transport is hidden, select Transport from the Windows menu.
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The Transport controls
To find out what the Transport buttons do, simply move the mouse pointer over a button and wait for a
pop-up to appear. If this doesn't seem to work, make sure Show Tips is activated in the Preferences dialog.
The Stop button
The Stop button has a special function related to the selection:
- If the program is stopped and you click the Stop button, the wave cursor is moved to the beginning of

the selection.
- If there is no selection, or if the wave cursor is already to the left of the selection, it is moved to the

beginning of the file.

Navigating using the keyboardNavigating using the keyboard
A number of short-cuts are available for navigating, see Keyboard Commands - Navigating.

Navigating using "Move cursor to"Navigating using "Move cursor to"
This menu is found on the View menu. The options on this are similar to the Scroll To menu, see
Navigating using the Scroll To menu.
For details about each item, select it from the menu, and with the menu still up, press [F1].
There’s one additional option called "Position" which allows you to specify any position, in the format
selected in the Preferences dialog (under the "Units" tab)

Moving the cursor to a MarkerMoving the cursor to a Marker
To move the wave cursor to a certain marker, do one of the three following:
• Double click on the marker triangle.

This is probably the most convenient option if the Marker is currently visible in the window. This even
works during playback!

• Double click in the ruler, select one of the markers in the list that appears, and click Close.
This is probably the most convenient option if the Marker is outside the current view.

• Activate "Magnetize bounds" on the Options menu. Click on the ruler, close to the Marker or drag the
cursor to a position close to the Marker.

Using "Snap Cursor"Using "Snap Cursor"
This function – which can be reached from the "Move cursor to" item on the View menu and from the
main wave display speed menu – moves the cursor position automatically for you. There are two options
• Move to the closest zero crossing to the left of the cursor position.

To get this effect, make sure Snap to time unit is turned off on the Options menu.
• Move to the zero crossing closest to a major time unit.

This can be for example to the zero crossing closest to a whole second on the time ruler. To get this
effect, make sure Snap to time unit is turned on, on the Options menu.

In the last case, the "time unit" mentioned depends on which type of scale is selected for the ruler:

Option:Option: Cursor moves to:Cursor moves to:

Time Closest whole second
Samples Function not available
Time code Closest frame
Meter Closest whole beat
File size Function not available

Play AudioPlay Audio

Playing - Using the TransportPlaying - Using the Transport
To play a section of audio, using the Transport, proceed as follows:
1. Click the Play button.
2. To stop playback, click the Stop button.

If the wave reaches the end, it stops automatically.
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Playing - Setting the Start PointPlaying - Setting the Start Point
The Start Point button on the transport brings up a menu that allows you to specify where playback will
start.
For example, if you select "Play from start of file", then as soon as you hit Play, the wave cursor will jump
back to the beginning of the file and playback starts from there.
For detailed info about the options on this menu, use the context sensitive help.

Playing - Setting the Stop/Loop positionPlaying - Setting the Stop/Loop position
The Stop Point/Loop button on the Transport bar allows you to select where playback should stop, and
when looping, whether it should loop indefinitely.
Automatic Stop
For example, if you select "Stop at next marker", playback will stop as soon as the program reaches a
marker or the end of the file, whichever comes first.
Looping
Let's say you have chosen "Loop selection" mode. Now, if some piece of the wave is selected, this will be
repeated indefinitely (as long as you don't start playback from a position later than the selection).
If no selection is made, the entire wave is looped.
For detailed info about the options on the Stop point/Loop menu, use the context sensitive help.
About Loop Updating and Short Loops
The loop points are updated continuously during playback, which means that if you change the loop start
or end during playback, the loop changes. This is a great feature for auditioning selection points for
rhythmic material!
Please note that it takes some time for the positions to be updated (1/2 to 3 seconds, depending on the file's
bit resolution and sample rate). If you don't want to wait, there are two ways:
• Activate Restart on loop change on the Options menu.

When this is activated, the Loop starts over as soon as you adjust the selection or move a Loop Start
marker.

• Press [F5].
This causes the loop points to be updated immediately (a small glitch in the audio might occur).

Playing - Skipping sectionsPlaying - Skipping sections
You can have playback automatically jump past certain positions during playback.
This selection is done using the Skip button on the Transport.
For example, if you have added Mute markers to your file and select "Muted regions", you will be able to
audition what the material would sound like with certain sections cut out, before the actual edits are made.

Using the Play ToolUsing the Play Tool
The Play tool allows you to play from any point by clicking there. It is also the only option that allows you
to play only one channel in a stereo file.
Selecting the Play tool momentarily
The Play tool can of course be selected by clicking in the Toolbox, but there are situations when you are
working with another tool and just momentarily want to use the Play tool.
• To momentarily select the Play tool, hold down [Alt]. When you are done playing, release [Alt].
Using the Play tool
The play Tool allows you to play back from any position:
1. Point at the position where you want playback to start.
2. If the wave is in stereo, move the pointer up or down to decide whether only either channel should be

played back.
Watch the cursor shape, it indicates what will be played back (L, R or both).

3. Press the mouse button.
Playback continues for as long as the mouse button is down, or until the wave ends.
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The Jog functionThe Jog function
This can be viewed as dragging the audio past a "playback point", much like dragging a reel-to-reel tape
past the playback head:
1. Zoom in so that you can get a good visual feedback.
2. Click the Jog/Shuttle button on the Transport Bar or press [F10].

A vertical line appears in the middle of the Wave window. This is the "playback point".
3. Move the pointer to the upper half of the Wave window.

The pointer takes on the shape of a hand.
4. Click and drag to the left or right to drag the audio past the playback point.

The audio is played back, forwards (if you drag the audio to the left) or backwards (if you drag to the
right), at the speed with which you drag.

- The Jog and Shuttle functions are CPU-intensive because of the real-time scrolling that occurs. If you
experience stuttering playback, try reducing the window size (this will reduce CPU usage
proportionally).

The Shuttle functionThe Shuttle function
This can be viewed as playing back with a continuous control for tape speed and direction:
1. Zoom in so that you can get a good visual feedback.
2. Activate the Jog/Shuttle button on the Transport Bar or press [F10].
3. Move the pointer to the lower half of the Wave window.

The pointer takes on the shape of a speaker.
4. Click and hold the mouse button to the left or right of the vertical line.

Clicking to the left of the line will play the audio backwards. The playback speed is determined by the
distance from the line to the pointer, so that the further away from the line you move the pointer, the
faster the playback.

5. Release the mouse button to stop playback.
6. Deactivate the Jog/Shuttle button on the Transport Bar or by executing any stop command when

finished.
- The Jog and Shuttle functions are CPU-intensive because of the real-time scrolling that occurs. If you

experience stuttering playback, try reducing the window size (this will reduce CPU usage
proportionally).

Playing - Using the KeyboardPlaying - Using the Keyboard
A number of short-cuts are available for navigating, see Keyboard Commands - Navigating.

Playing the selectionPlaying the selection
There are four ways to play the selected part of the wave only:
• Press the right mouse button in the overview or the main view and select Play Selection from the menu

that appears.
• Drag and drop the selection on the Play button on the Transport.
• Hold down [Control] and click on the Play button.
• Press [F6].

Playing only one channel or bothPlaying only one channel or both
If you need to play only one channel in a stereo file, use the Play Tool.

Using the Playback BrowserUsing the Playback Browser
The Playback Browser feature helps you find certain position in an audio file, by restarting playback
repeatedly when you click or drag to move the wave cursor.
1. Activate playback using the regular Play function, or select the Play Tool.

Note that depending on your Preferences settings, Playback Browsing may only be available for the
Play Tool.

2. Click or drag in the ruler.
If you click playback jumps immediately to the position you clicked at. If you drag continuously, a short
snippet if audio is played from each new position.
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Playback Browser Preferences
On the Audio Card tab in the Preferences dialog you will find two Preferences for Playback Browsing:
- The Sensitivity setting is used to determine the size of the "snippets of audio" played back when you

drag.
- When the "Restrict to Play Tool" option is activated, Playback Browsing is not available when you

activate Playback using the transport or computer keyboard.
On the Options menu you will also find an option called "Stop after playback browsing", which
determines what happens when you release the mouse button: playback continues (deactivated) or stops
(activated).

Setting Playback levelSetting Playback level
1. Click on the speaker button on the Control bar.
2. Set the volume using the slider that appears.

This sets the overall level of audio playback from the card. The previous level is restored when you quit
WaveLab.

3. Click outside the slider.

Playing - with 8-bit resolutionPlaying - with 8-bit resolution
If you need to, you can play back with 8-bit resolution, even though you have a 16-bit card. This could for
example be used to test what a wave will sound like when played back on an 8-bit card.
• To do this, activate Play as 8-bit from the Options menu.
Don’t forget to turn this option off when you don’t need it any more!
Please note that this is a quick "on the fly" conversion from 16 to 8 bit. It is possible to achieve much better
quality in your 8 bit audio files by using the Dynamic process to compress the audio and then Save Convert
the files to 8 bit.

Record AudioRecord Audio

Basic Recording ProceduresBasic Recording Procedures
This topic describes how to record a new audio file and have it appear in a Wave window. Recording in the
Audio Montage is described in the topic Recording in the Montage.
Preparations
To record a new file, proceed as follows:
1. Click the Record button, or press [*] on the numeric key pad.

The Record dialog appears.
2. Decide whether you want to record to a "final" or a "temporary" file, by selecting from the pop-up at the

top of the dialog.
Temporary files are practical to use, since you don’t need to name the file beforehand, you just "hit
record and go". On the other hand, you will need to save the file at a later stage. Also note that if you
plan to make a long recording (many minutes) we recommend that you record to the final file directly.

3. If you have selected "Create Final File", in the step above, type in the path to the file on the line below
the pop-up or click the folder button and specify a file location.
If you activate the Auto number checkbox, a three-digit number will be added to the file name. Starting
at the number you specify in the value field to the left of the checkbox, the Auto number will be
incremented with each new recording, to prevent existing files from being overwritten.

4. Click the Attributes button, and decide on a recording format:
For details, see the context sensitive help for the dialog.

- Note that if the Audio attributes window is opened from within the Record dialog, the last Bit
Resolution option is named "24-bit Alt". This is an alternate way of transmitting 24-bit audio, used by
certain audio hardware. If you plan to record 24-bit audio, you should consult your audio hardware’s
documentation to find out whether you should use "24-bit" or "24-bit Alt".

- If you choose a format not supported by your audio card, you will not be able to record.
5. Activate the desired recording options (the checkboxes below the Attributes button).

For descriptions, use the context sensitive help.
6. You may also want to make additional settings by clicking the Settings button.

This opens the Record Settings dialog (see the context sensitive help). Note that some of the settings in
this dialog are directly related to the recording options in the Record dialog.
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7. While the Settings dialog is open, make settings for monitoring.
The four metering checkboxes allow you to have Monitoring automatically activated or deactivated
when you start or end recording, etc.

- If your audio hardware doesn’t support full duplex (simultaneous playback and recording), make sure
the option "Stop playback when metering/recording" is activated.

8. Click OK to close the Record Settings dialog.
9. If needed, click the Mixer button to adjust the relative volume of your card’s inputs.

See the topic Using the mixer.
10. Use the meters in the record dialog to check the input level.

See the topic Checking Levels.
11. Check the Disk Capacity indicator at the bottom of the dialog to make sure you have enough disk space

for the recording.
This indicator shows the amount of available disk space on the hard disk specified in the Create Final
File path, or the hard disk you have selected for your temporary files. Please note that this is an
approximate value.

- When there is less than ten seconds of available hard disk space, the Disk Capacity indication is
displayed in red.

Start Recording!
1. When all the preparations are done, click Record to start the actual recording.

If you have selected one of the Auto-start options in the Record dialog, the recording will go into Pause
mode (the Record button will blink), until the specified Auto-start criteria are met.
When recording starts, the Record button will be "lit" and the Recorded Time value will indicate how
much you have recorded.
If you have selected the "Auto-stop after specific duration" option, the "Remaining Time" value will
indicate how much recording time you have left.

- If you like, you can pause the recording by clicking the Pause button at any time.
The Record button will blink to indicate Pause mode. To resume recording, click the Pause or Record
button again. As described above, a short section of audio just before you resume recording (according
to the Pause Buffer value in the Record Settings dialog) will be captured.

- You can drop Markers in the file during recording by clicking the Drop Marker button.
This will generate a numbered, Generic Marker (see About Markers). If you want to drop Markers and
name them, click the Drop Label button instead.

- If you want to abort the recording, click the Discard button.
This terminates recording and discards the recorded file.

2. When you are done, click Stop.
You can also have recording stop automatically by using one of the Auto-stop options. Either way, the
recording appears in a new window behind the dialog.

4. If you want to perform more recordings after the first, simply click the Record button and record again.
If you have selected the Create Final File option, and the Auto number option is deactivated, you have
to specify another file name to avoid overwriting the previously recorded file.

5. When you have finished, click the Close button (in the lower right corner) to close the dialog.

Recording - Checking LevelsRecording - Checking Levels
In the lower part of the Record dialog, you will find a Meter display. This is useful for checking the input
level, as well as the frequency spectrum of the input signal.
- The Meters in the Record dialog are "miniature" versions of the Meters View in the Audio Montage

windows. For detailed descriptions of the functionality and features, see The Meters View.
1. For the Meters to register the signal, you need to activate the Monitor checkbox.

This can be done automatically, if the option "Activate monitoring when opening record window" is
activated in the Record Settings dialog.
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2. To display the Level meter, select "Level" from the pop-up menu below the Meter display.
- The Peak Level meters display the peak levels of each channel, graphically and numerically.

The meter segments and numerical peak values are displayed in different colors for different level ranges
(see The Meters View : Level tab).

- The VU (Volume Unit) meters measure the average loudness (RMS) of each channel.
These meters have a built-in inertia, evening out loudness variations over a user-defined time span.
There are also "bracket" values, providing an indication of the changes in recent minimum and
maximum RMS values. These functions are described in the context sensitive help for the Meters View.

3. Set the audio input level with the Mixer controls (or the audio card’s applications), so that the Peak
Level meters go as high as possible without ever reaching 0dB.

4. If you want to reset the level meters, click the Reset button.
This instantly resets all meters and numerical indicators, including the Maximum Peak and RMS values
to the right of the meters.

- The pop-up menu next to the Reset button allows you to select one of the five Meter Presets.
The Presets have different settings for meter ranges, colors, etc. You can edit the settings in the current
Preset by selecting "Edit current meter..." from the pop-up menu. The options are described in the
context sensitive help for the dialog.

- If the Phase Meter option is activated on the pop-up menu next to the Reset button, a Phase Meter is
displayed to the right of the level meter (see the context sensitive help for the Meters View).

- It is also possible to display the Spectrum meter, by selecting "Spectrum" from the pop-up menu below
the Meter display.
The Spectrum meter shows a continuous graphical representation of the frequency spectrum, in the
shape of a "bar diagram".

Recording -Using the mixerRecording -Using the mixer
For the mixer to appear, you must have specifically selected the card in the General section of the
Preferences dialog. If the Input and Output are set to "Microsoft sound Mapper" a mixer can not be
created.
Even if you have selected the card, this operation is not foolproof, since it relies on communication
between WaveLab and the card’s driver. If the driver does not reply correctly to WaveLab’s inquiries (to be
explicit – if the driver contains "bugs" – which we have unfortunately noted that some drivers do), a mixer
can not be created. The program will then alert you. If this is the case, please instead use the application
included with the card to access the settings.
Exactly what controls will appear in mixer depends on the card, but here are some possibilities:
- Master Gain (output - stereo faders)
- Synth In (input - stereo faders plus on/off check box)
- CD (input - stereo faders plus on/off check box)
- Line (input - stereo faders plus on/off check box)
- Mic (input - mono faders plus on/off check box)
Stereo controls are normally "ganged" (if you adjust one, they both move) but you can adjust them
separately by holding down [Control].
In addition to the above, the card might have custom controls for monitoring etc, which can not be
accessed from the WaveLab mixer. Again, please use the application(s) included with the card.

Make a selectionMake a selection

Selecting - at zero crossingsSelecting - at zero crossings
If you cut out a portion of a wave and paste it in somewhere else, chances are there will be a discontinuity
where the two waves are joined. This discontinuity will result in a transient in the wave when it is played
back, which is perceived as a "click" or "bump" in the sound. To avoid this you need to make the splice at a
zero crossing. See the printed documentation for more background information.
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WaveLab can automatically search for zero crossings, and extend the selection "outwards" (make it bigger
at both ends) so that it begins and ends at a zero crossing.
1. Pull down the Options menu and activate "Snap to zero crossing".
2. Select Preferences from the Options menu.
3. Click on the Editing tab.
4. Fill out the Snap to Zero crossing options

See the context sensitive help for details about the dialog.

Selecting - by draggingSelecting - by dragging
1. Position the mouse pointer where you want the selection start or end.
2. If the wave is in stereo, move the mouse up and down and check the pointer shape, it will show you

whether you will select in the left channel, right channel or both channels.
3. Press the mouse button and drag left or right.

If you drag all the way to the left or right side of the window, it scrolls automatically. The speed of the
scroll depends on how far the cursor is from the window edge.

4. Release the mouse button.

Selecting - using [Shift]Selecting - using [Shift]
1. Click once somewhere in the wave to set the wave cursor.

If the wave is in stereo, and you wish to select in only one channel, click in the upper part (left channel)
or lower part (right channel) of that channel.

2. If needed, scroll the view, then hold down [Shift] and click somewhere else.
If you wish to select in only one channel, you must click in the same channel again.
The area between the two points is selected.

Shifting the selection between channelsShifting the selection between channels
If you have made a selection you can press [Tab] to toggle between having the same selection in either
channel or both.

Selecting the entire waveSelecting the entire wave
There are several ways to do this:
• Double click somewhere in the waveform.

This only works if you don’t have any markers in the wave.
• If you have markers, (or if you’re not sure), hold down [Alt] and double click somewhere in the

waveform.
The entire wave gets selected, regardless of markers.

• Use Select All on the Select sub-menu on the Edit menu.
• Press [Control]-[A].

Selecting between markersSelecting between markers
• To select all audio between two adjacent markers, double click between them.
• To select all audio between any two markers, double click just to the right of the leftmost one, hold

down [Shift] and double click just to the left of the rightmost one.

Selecting - using menus and keyboardSelecting - using menus and keyboard
Select to beginning/end
To select from the current wave cursor to the beginning or end of the waveform, use the Select sub-menu
on the Edit menu, or the keyboard short-cuts (as indicated on the menu).
• For info on keyboard commands, see Adjusting selection - using the Keyboard.

Adjust the selectionAdjust the selection

Adjusting selection - by draggingAdjusting selection - by dragging
1. Move the mouse pointer to the beginning or end of the selection.

It turns into a double arrow.
2. Press the mouse button and drag left/right.
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Adjusting selection - by using [Shift]Adjusting selection - by using [Shift]
• Hold down [Shift] and click outside (extend) or inside (shrink) the current selection.

If you click inside the first half of the selection, this will change the start point, if you click inside the
later half, this will change the end point.

Adjusting selection - using the KeyboardAdjusting selection - using the Keyboard
If you hold down [Shift] and press the left and right arrow keys, the end of the selection is moved one pixel
(screen dot) to the left/right. If you also hold down [Control] it is instead moved twenty pixels.
Which end of the selection you adjust is determined by which end of the selection the cursor is closest to.
Exactly how much one pixel represents depends on the zoom factor. If the zoom factor for example is
"x1:64", the cursor keys alone move 64 samples, and together with [Control] they move 1280 samples.

Make a level selectionMake a level selection

Level Selections - using the mouseLevel Selections - using the mouse
For some of WaveLab’s level processing functions, it is useful to make a selection not only in time, but in
level.
The method below might require the [Shift] key to be pressed. This depends on whether the option "Level
Selection requires [Shift]" is activated or not in the Editing part of the Preferences dialog.
1. Make a regular "time" selection.
2. If required, hold down [Shift].
3. Move the mouse to the top or bottom of the selection box.

The pointer changes into a vertical double arrow.
4. Press the mouse button and drag up/down.

The current level selection is shown on the status bar.
If you later extend the selection time-wise, the level selection still remains the same.

Level Selections - using Extend To PeaksLevel Selections - using Extend To Peaks
To automatically set the level selection to the highest peak in the current selection, proceed as follows.
1. Make a time selection.
2. Select "Extend to peaks" from the Select sub-menu on the Edit menu.

Copy and move audioCopy and move audio

Wave Editing - Drag-copyingWave Editing - Drag-copying
The following operation allows you to make a copy of a section of audio, within the same file or from one
file to another.
1. Make a selection.
2. Point at the selection, press the mouse button and hold it down.
3. Drag to a position outside the selection (in the same file) or drag onto another wave window.

When you have the cursor over a valid area, the pointer will turn into a single or double waveform. The
status bar will show the exact position the selection will be inserted at.

4. Release the mouse button.
The selection is inserted at the indicated point. The audio that previously began at that point is moved
forward so that is now played after the inserted section.

- Make sure you don’t drop on a selection in the destination window, or you will perform a crossfade.
- If the selection is in stereo and you drop on a single channel or vice versa, the program will try to make

the most sensible choice in this situation. See the printed documentation for details.
- If the you drag between two files and they have different sample rates, the program will warn you that

the edited section will not play back at the correct pitch. See Resolving Sample Rate Conflicts.

Wave Editing - Drag-movingWave Editing - Drag-moving
The following operation allows you to move a section of audio within the same file or from one file to
another.
1. Make a selection.
2. Point at the selection, press the mouse button and hold it down.
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3. Hold down [Alt] or [Shift] and drag to a position outside the selection (in the same file) or drag onto
another wave window.
When you have the cursor over a valid area, the pointer will turn into a single or double waveform. The
status bar will show the exact position the selection will be inserted at.

4. Release the mouse button.
The material you dragged is removed from its original position and inserted where you drop it.
- To completely undo a move between two files you must first undo the Paste in the destination window

and then Undo the Cut in the source window.
- Make sure you don’t drop on a selection in the destination window, or you will perform a crossfade.
- If the selection is in stereo and you drop on a single channel or vice versa, the program will try to make

the most sensible choice in this situation. See the printed documentation for details.
- If the you drag between two files and they have different sample rates, the program will warn you that

the edited section will not play back at the correct pitch. See Resolving Sample Rate Conflicts.

Wave Editing - Dropping on markersWave Editing - Dropping on markers
For any operation involving drag and drop of audio material you can use a marker position as start point
for the section you drop. This is useful when it is important that the dropped material is inserted at a very
specific position.
1. Make sure Magnetize bounds (on the Options menu) is activated.
2. Drag the selection and position the mouse pointer close to a marker line.

The "drag line" snaps to the marker line.
3. Make sure the marker line and the drag line appear on top of each other, and release the mouse button.

Wave Editing - Dragging to a new windowWave Editing - Dragging to a new window
If you want to turn a section of a wave into a new document, proceed as follows.
1. Make a selection.
2. Drag the selection out of the window and onto an empty section of the WaveLab application window.

The cursor turns into a "new document" icon.
3. Release the mouse.

The selection appears in a new window.
Please note that "Copy to new window" on the Edit menu performs the same operation.

Wave Editing - Using Cut, Copy and PasteWave Editing - Using Cut, Copy and Paste
The following commands let you copy or move audio from one place to another.
1. Make a selection.
2. If you want to make a copy of the audio, select Copy from the Edit menu, press [Control]-[C] or click

the Copy icon on the Control bar.
3. If you’d rather remove the audio for insertion somewhere else, select Cut from the Edit menu, press

[Control]-[C] or click the Cut icon on the Control bar.
The audio that was after the Cut section is "moved up" to "fill the gap" that would otherwise be created.

4. If you want to insert the audio, click once at some position in the same file or in another file.
The wave cursor appears at that point. Please note that you can click to place a wave cursor line in one
channel only, or both channels, if the destination is a stereo file.

5. If you'd rather replace a section of audio, select it.
In this case, the position of the cursor is of no relevance.

6. Select Paste from the Edit menu or press [Control]-[V].
The material you cut/copied is either inserted at the indicated point (no selection) or replaces the
current selection (if you have already made a selection).

Paste OverwritePaste Overwrite
This command on the Paste Special menu, on the Edit menu, will overwrite data in the destination file,
rather than moving data to make room for the inserted audio.
Exactly how much data is overwritten depends on the selection in the destination file:
- If there is no selection in the destination file, a section with the same length as the pasted data will be

overwritten.
- If there is a selection, the pasted data will replace that selection, just as when making a regular paste.



How to...How to... WavWaveLab 3eLab 3

3434

Paste Append and PrependPaste Append and Prepend
These commands on the Paste Special menu, on the Edit menu, will add the Pasted audio at the beginning
(Prepend) or end (Append) of the file, just as if you had placed the wave cursor there and selected Paste.

Using the Kicker toolsUsing the Kicker tools
The Kicker tools in the Toolbox can be used to move audio in a file in small steps.
1. Make a selection.
2. Click on the selection with one of the Kicker Tools (depending on in which direction you want to move

it).
The audio is moved one pixel (screen dot). Exactly how much this is depends on how far you are
zoomed in. If the status bar for example says x1:256, the selection will be moved 256 samples.

- The moved section "overwrites" whatever audio was at the position it is moved to. If you for example
kick to the right, silence is inserted before the moved section and the audio coming after it is replaced by
the kicked selection. This is different from moving by dragging.

- If you kick many times in a row and then Undo, all the moves are undone in one go.

Resolving Sample Rate ConflictsResolving Sample Rate Conflicts
If you copy or move audio from one window to another, and the sample rate of the two files are not the
same the program will warn you that the copied/moved sound will play back at the wrong pitch (speed) if
you proceed. While this can sometimes be used as an effect, it is most often not desired. There are two
ways to get around this:
• Convert the Sample Rate of the source file to the same rate as the destination file before doing the

editing.
You might then later go back and Undo this conversion if necessary.

• Convert the Sample Rate of the destination file to the same rate as the source file before adding the
audio to it.

Please note that you are then partly "stuck" with this new sample rate, since rate converting back and forth
too many times is not recommended, see Convert Sample Rate.

Repeat and Mix audioRepeat and Mix audio

Editing - RepeatingEditing - Repeating
To repeat a section of audio, proceed as follows:
1. Make a selection, select Cut or Copy and place a new insertion point, just as when performing a normal

Cut or Copy.
2. Select "Multiple Copies" from the Paste Special sub-menu on the Edit menu.
3. In the dialog that appears, enter the number of copies you desire (up to 1000).
4. Click OK.

Editing - Paste MixEditing - Paste Mix
This command on the Paste Special menu will blend the two sections, starting at the selection (if you have
one) or at the cursor position (if there is no selection).
All the data on the clipboard is always mixed in, regardless of the length of the selection. It doesn’t matter
whether you have a selection or not in the destination file when you Paste.

Delete and Silence audioDelete and Silence audio

Editing - DeletingEditing - Deleting
There are three ways to delete a selection of audio:
• Select Delete from the Edit menu.
• Click the Delete icon on the Control bar.
• Press [Backspace].
• Drag the selection to the Delete icon on the Control bar.
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Editing - TrimmingEditing - Trimming
To remove all the audio, "outside" the selection, proceed as follows:
1. Select the part you want to keep.
2. Select Trim from the Edit menu or press [Control]-[Backspace].

Editing - SilencingEditing - Silencing
There are three ways to replace a section of audio with silence:
• Select it and select Silence from the Edit menu.
• Select it and click the Silence icon on the Control bar.
• Select it and press [Control]-[space bar].
• Select it and drag the selection to the Silence icon on the Control bar.

Editing - Inserting SilenceEditing - Inserting Silence
To insert silence into a section (to space two sections further apart), proceed as follows:
1. Make a selection that starts where you want the Silence to start, and that has a length that is equal to

the length of the silence you want to insert.
2. Select Insert Silence from the Edit menu or press [Control]+[Ins].
To add silence beyond the end of the file (thereby lengthening the file), proceed as follows:
1. Place the cursor at the new desired end point.
2. Select Insert Silence from the Edit menu or press [Control]+[Ins].

Convert between mono and stereoConvert between mono and stereo

Editing - Converting mono to stereoEditing - Converting mono to stereo
You may convert a mono file into a stereo file that contains the same material in both channels, for
example for further processing into "real" stereo.
By dragging
1. Make a selection.
2. Drag the selection out to the WaveLab "desktop".
3. When the pointer is outside the window, hold down [Control] and release the mouse button.
By using Menus
1. Make a mono selection.
2. Select "Convert to Stereo" from the "Copy to new window" menu on the Edit menu.

The selection appears in a new stereo window.

Editing - Converting Stereo to monoEditing - Converting Stereo to mono
You may mix the two channels in a stereo file into a mono document.
This can be done in three ways. Which method you use mainly depends on whether you want to convert
the entire file or just a selection:
By dragging
1. Make a stereo selection.
2. Drag the selection out to the WaveLab "desktop".
3. When the pointer is outside the window, hold down [Control] and release the mouse button.
By Using Menus (converting a selection)
1. Make a stereo selection.
2. Select "Convert to Mono (Mix)" from the "Copy to new window" menu on the Edit menu.

The selection appears in a new window, mixed down to mono.
By Saving (converting an entire file)
1. Open the stereo file.
2. Select Save Special from the file menu and then select Convert from the sub-menu that appears.
3. Leave the Sample Rate and Resolution settings as they are, but change the Channels setting to "Mono".

You can of course change the other settings too, but this will have other effects.
4. Click OK and Save the file.
5. Open the file you just saved.
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Copy Layouts and use Wave SnapshotsCopy Layouts and use Wave Snapshots

Copying "layouts" between windowsCopying "layouts" between windows
While Snapshots are fine for defining several "layouts" for one window, they do not allow you to copy a
"layout" from one window to another. For this purpose you can copy layouts between documents. This
includes everything that is in a Snapshot, plus:
- The selection start and end points.
- The cursor position.

Here’s how to copy a "layout":
1. Make the window with the desired layout active.
2. Press [Alt]+[Control]-[C].

This copies the layout to an invisible "clipboard".
3. Make the window where you want to apply the layout active.
4. Press [Alt]+[Control]-[V].

Creating a SnapshotCreating a Snapshot
What are Snapshots for?
Snapshots store the main view’s "layout", which is essentially two things:
- How a window is scrolled (which part of the wave you see).
- The window’s zoom factor.
If you move back and forth between various positions in a file, or if you zoom in and out for detailed or
overview editing, using Snapshots will save you a lot of time.
Creating a Snapshot
1. Scroll the window to the desired position.
2. Set the zoom factor as desired.
3. If the Snapshot Palette window isn't already open, select Snapshot from the Window menu.
4 Click on the desired number in the Palette or hold down [Control] and press any of the keys [1] to [8]

on the typewriter part of the keyboard.
The Snapshot is now stored under that button. The fact that the Snapshot is used is indicated by the
waveform symbol turning blue.

Recalling a SnapshotRecalling a Snapshot
There are two ways to recall a snapshot:
• Click on the waveform next to the number.
• Press any of the keys [1] to [8] on the typewriter part of the keyboard.
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Use off-line ProcessingUse off-line Processing

Apply Processing in GeneralApply Processing in General
To apply processing to a selection, proceed as follows:
1. Make a selection.
Many times you will want to "Select All" to process the entire file. If the file is in stereo, you can apply
processing to either channel or both, by selecting one channel or both, See Selecting.
2. Select the desired type of processing from the Level and Process menus.
3. If a dialog appears, fill it out.

If the dialog uses Presets, you can load one of them to fill out the settings automatically, see Applying a
Preset.

4. When you are done with the settings in the dialog, click the Apply/Paste/Process button.
The Status Bar shows the progress of the operation. If you need to cancel, click the Stop button on the
Status bar, or press [Esc].

Swap ChannelsSwap Channels
You may move the material in the left channel to the right channel, and vice versa:
1. Make a selection across both channels.

Only the material in the selected section will be swapped.
2. Select Swap Channels from the Edit menu.

The Normalize DialogThe Normalize Dialog
This dialog is used to change the gain (volume) of a selection. The amount of gain change is always set
relative to full level. The idea behind this is to allow you to optimize the gain of low-level wave files.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Gain Change DialogThe Gain Change Dialog
This dialog is used to change the gain (volume) of the selection. It differs from Normalize in that the
change in volume is specified as an absolute value. Hence, this dialog allows you to change the gain to
more than "full level" and thereby introduce clipping.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

Invert PhaseInvert Phase
This turns the signal "upside down", which is the same as inverting the phase by 180 degrees. No settings
are needed for the operation.
1. Make a selection.

Only the material in the selected section will be affected.
2. Select Invert Phase from the Level menu.
There is no audible change when you invert the phase of a mono signal. However, if one channel in a
stereo pair is out of phase with the other, this will lead to artifacts such as a drop in the bass register and a
"blurred" stereo image.
The most common use for this function is therefore to fix a stereo recording where one of the channels
accidentally has been recorded out of phase with the other.
This function can also sometimes be used to create smoother transitions when splicing two waves together.
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Eliminate DC OffsetEliminate DC Offset
This function removes a problem that most often appears due to mismatches between various recording
equipment. No settings are needed.
Since this problem usually occurs when recording, it normally affects the entire file. Therefore, it is
recommended that this function is applied to as large a selection as possible, preferably the entire file.
About DC Offsets
A DC offset is when there is too large a DC (direct current) component in the signal. If the DC offset is
really bad, it can be visible as the signal not being visually centered around the "zero level axis". However,
the DC offset can be significant without actually being seen.
A DC offset is problematic for two reasons:
- It affects where the zero crossings appear, which in turn affects the smoothness of splices between audio

files.
- Certain processing options do not give optimal results when performed on files with a DC offset.
Checking for and removing DC Offset
1. Make a selection.
2. Select Elimintate DC Offset.

A dialog appears stating the amount of DC Offset and asking you whether you want to remove it.
3. Click OK.

If other recordings have been made with the same equipment they might have the same problem.

The Fade DialogThe Fade Dialog
The Fade In and Out  items on the Level menu actually open the same dialog, but with different options
activated.
A Fade In is a gradual increase in level and a Fade Out is of course the opposite. As you adjust the values,
a curve indicating the fade is drawn in the wave display.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Crossfade DialogThe Crossfade Dialog
A crossfade is a gradual fade between two sounds, where one is faded in and the other is faded out. This
function allows you to do just that. It also lets you create plain mixes of two sounds. As you adjust the
values, curves which indicate the fade are drawn in the wave display.
For detailed step-by-step instructions, see the printed documentation.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Dynamics DialogThe Dynamics Dialog
This dialog allows you to tailor the dynamics of the audio, to create effects like compression, expansion,
limiting and noise gating. Dynamic processing of audio is a big subject. Please refer to the printed
documentation and also please study the included Presets which implement examples of the above
mentioned functions.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

ReverseReverse
This turns the selection backwards.

The Time Stretch DialogThe Time Stretch Dialog
Time stretch is an operation that allows you to change the length of a recording without affecting its pitch.
Actually the standard term "time stretch" is a bit misleading since you can of course also make the material
shorter.
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This function is most often used to make a section of audio fit in with some other material. Therefore this
dialog is set up exactly for that. You select the material to be stretched and use the options in the dialog to
find a stretch factor (the "Ratio"). This is done by specifying the desired length, or the desired tempo,
according to what the requirements of the situation. You can also specify the Ratio directly as a percentage
value of the original length.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Pitch Correction DialogThe Pitch Correction Dialog
Pitch Correction is a function which allows you to change pitch of a sound, with or without affecting its
length.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Harmonization DialogThe Harmonization Dialog
This is a variation on the Pitch Correction which allows you to create not only one shifted voice, but up to
sixteen!
See the printed documentation for step-by-step instructions on how to set up this dialog.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Hi-fi Chorus DialogThe Hi-fi Chorus Dialog
This chorus works slightly different from many others. Often chorusing is achieved by delaying a copy of
the signal, varying the amount of delay continuously and mixing the delayed signal back in with the
original.
While this is adequate for many purposes, WaveLab takes a more natural approach to creating chorus.
Since a chorus effect is basically about making a recording sound like it was performed by many "identical
musicians", WaveLab takes just that approach. It multiplies the recording up to 100 times (using the same
high quality pitch shifting engine as in the pitch correction and harmonization), and detunes and delays
each "voice" slightly and - if so desired - pans the voices across the stereo image.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.

The Equalization DialogThe Equalization Dialog
This is an equalizer, with two shelving filters (high and low) and a parametric band with adjustable Q
(width). The purpose of an EQ (filter) is to adjust the timbre of a sound, to for example reduce the amount
of bass or increase the amount of treble contents.
The graph indicates the total filter curve produced by the three sections together.
For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.
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The Sample Rate Conversion DialogThe Sample Rate Conversion Dialog
This function allows you to change the sample rate of a recording. This is very convenient if you have a file
that you wish to use in a certain audio system and find that the file was recorded at a sample rate this
system doesn’t support.
Sample Rate conversion is always applied to the entire file. Any selection you have made is not used in any
way for this operation.
Please note the following:
- Sample rate conversion from a low frequency and up does not improve sound quality. The high

frequencies that were lost due to a low recording frequency can not be restored by a conversion.
- When you convert the Sample Rate down to a lower frequency, high frequency material will be lost

(this is part of the mathematics behind digital audio). Therefore, do not convert down and then up
again, since this will degrade the sound quality (unless that's exactly what you want to do!). Instead, use
the Undo and Redo functions.

- Do not sample rate convert from 44.1 to 48kHz in an effort to improve sound quality. This won’t give
you any improvement in sound and many audio cards do not support playback of 48kHz at all.

- When converting from 44.1 to 11kHz, it might make sense to activate Top quality, to avoid "aliasing"
artifacts that might otherwise occur.

For more information about each item in the dialog, use the context sensitive help (the question mark
symbol) in the actual dialog.
See also Using non-modal dialogs.
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Use the Analysis toolsUse the Analysis tools

The Global Analysis dialogThe Global Analysis dialog

Opening Up the Global Analysis dialogOpening Up the Global Analysis dialog
The analysis always works on a selection within a file!
1. Make a selection in the wave file which you want to process.

This selection can be of any length and in one or both channels. If you want to analyze the entire file,
simply hit [Ctrl]-[A].

2. Select Global Analysis from the Analysis menu.

Setting up and performing the Global AnalysisSetting up and performing the Global Analysis
Deciding what Types of Analysis to Perform
As described above, there are several types of analysis which can be performed. Each of them takes some
time, so you may want to make sure that only the ones you require will be performed.
It doesn't hurt to activate more options than you need, but it will slow down the process. The pitch analysis
in particular uses up a lot of processing time, simply because it is very complicated in its nature.
If the section you are analyzing is very short, it doesn't matter much whether all options are activated.
- Click on the Peak tab and decide whether you want peak analysis or not by activating the "Peak"

switch.
- Click on the Loudness tab and decide whether you want "RMS Power" analysis performed.
- Click on the Pitch tab and decide whether you want the program to find the "Average Pitch".
- On the Errors tab, decide whether you want the program to search for "Glitches" and/or "Clipping".
Setting Parameters and Performing the Analysis
1. Set up the Parameters.

On most of the tabs, you will find settings for exactly how the analysis should be performed. See the
context sensitive help for a detailed description of Parameter settings.

2. If desired, move the wave cursor to a new position.
The Peak and Loudness tabs report values specifically related to the position of the wave cursor, so if
this is of interest, you should make sure the wave cursor is at the position for which you want a readout.

3. Click Analyze.

Checking and Browsing the resultsChecking and Browsing the results
Checking the results on the Pitch and Extra tabs is simple, since there is only one value returned for the
whole section of analyzed audio. Just click on the tab and read off the values in the dialog (for details about
the values, see later in this chapter).
For the other tabs, slightly more advanced options are available, as these analysis methods provide their
results as a number of positions in the file - positions that indicate peaks, glitches etc. These are called "hot
points".
You can browse (jump) between these points in a very practical way. Proceed as follows:
1. Click on the tab that represents the values which interest you.

For example, lets say you click the Loudness tab.
2. Check the display for maximum/minimum values in the whole section which was analyzed.

For the Loudness tab, these values represent the Maximum and Minimum amplitudes in the Left and
Right channels respectively (for a stereo file).

3. Decide which of these values you want to browse.
For example, let's say you want to browse the Minimum amplitudes in the Right Channel.

4. Click on the button that currently displays this value.
In our example, you would click the button in the lower right corner.

5. Check the "Number of hot Points" value at the bottom of the dialog. It displays how many positions in
the file that the analysis found.
In our example it shows how many positions with low amplitude in the right channel, which meet the
criteria specified by the parameters in the dialog.
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6. Use the scroll bar below the "Number of Hot Points" value to browse between the positions found.
The wave cursor jumps between the points found by the analysis, and the display scrolls if needed.

7. When you want to browse another property, click on the corresponding tab (if required) and then on the
value button which represents it.
For example, to check the amplitude of the left channel instead, simply click that button. To check peak
values, click on the Peak tab and then click one of the value buttons on that tab.
The result of the analysis is saved until you close the dialog or click Analyze again.

Creating MarkersCreating Markers
If you like, you can set out markers at the "hot points":
1. Select a property and channel for which you want to add markers.

You will set out markers for the same property as you are currently browsing, so this selection is done
with the value buttons, as described above.

Since you are always browsing one channel at a time in a stereo file, you can also only set out markers for
the hot points in that channel.
2. Click the "Create Markers..." button.

Temporary markers are added at all "hot points".
The markers are named using the following principle:
"Hot point number" ("Channel") ("Position")
For example, a marker at the third "hot point" in the left channel, exactly two seconds in from the
beginning of the file would be labelled:
l (L) (2s)

FocusingFocusing
You can also focus the display on a certain "hot point":
1. Use the "Number of hot points" scroll bar to move the position indicator to the position which interests

you.
2. Click the Focus button.

Now two things happen:
- The wave display zooms in on the selected point.
- The Global Analysis dialog is "folded in" so that only its title bar is visible.

The Peaks tabThe Peaks tab
This is used to find peak values in the audio, that is, single samples with very high values.
Parameters
The parameters are fairly simple:
- "Maximum number..." allows you to put restrictions on how many points will be reported. The highest

ones will be selected. For example, setting this to "1" will make the program report the absolutely
highest peak only (or one of the peaks with the highest value - if there are several with the same value).

- "Minimum time..." lets you set things up so that the points don't occur too close. Settings this to "1 s"
will ensure there is always at least a second between reported points.

Result
The Result fields show you the following values:

Field:Field: Explanation:Explanation:

Maximum The highest peak in the analyzed section.
At Cursor The level of the sample at the wave cursor position, at the time for the analysis.

The Loudness tabThe Loudness tab
This finds loud and quiet sections in a more "intelligent" manner than the Peaks tab. The theory behind this
is that there might be a single sample with a high or low value somewhere, but this may not necessarily
mean that the whole section is perceived as loud/weak.
To find sections that the ear perceives as significant in volume, you must look at a longer section of audio.
To do this you measure a consecutive section of samples and then average their value. WaveLab does just
this, using a mathematical method called RMS (Root Mean Square) which is well known for its accuracy.
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Parameters
The parameters on the Loudness tab are slightly more complicated than for Peak analysis:
- "Resolution" is the length of audio measured and averaged. If this value is lowered, very short passages

of loud/quiet audio will be detected. When it is raised, the sound will have to be loud/quiet for a longer
period to result in a hot point.

- "Threshold..." is used for recordings where there are pauses. Since averaging is used, a pause could
possibly "fool" the algorithm into thinking a section isn't as loud as it actually is. Therefore you can set
up a value, and all audio below that value will be considered silence and will not be take into account.

- "Maximum number..." and "Minimum time..." are the same as for the Peak tab, see above.
Result
The Result fields show you the following values:

Field:Field: Explanation:Explanation:

Maximum/Minimum The level of the loudest and quietest points in the analyzed section.
Average The overall loudness of the whole analyzed section.
Around Cursor The loudness at the wave cursor position at the time for the analysis.

The Pitch tabThe Pitch tab
The Pitch tab shows the values from WaveLab's extremely accurate pitch detection algorithm. The result
from this tab can be used for example to help with pitch shifting, to get one sound in tune with another.
Note that this is an average value for the whole section. The algorithm assumes the analyzed section has a
reasonably stable pitch. Also note that the method only works on monophonic material (not on chords or
harmonies) and that the material must be relatively well isolated from other sounds.
There are no parameters to set. The display simply shows the pitch for each channel, both in Hertz (Hz)
and as semitones and cents (hundredths of a semitone).
Since the display shows an overall value for the entire analyzed section, the "hot point" controls in the
lower section of the dialog are not used on this tab.

The Extra tabThe Extra tab
This tab shows you two things:
- The average DC Offset in the analyzed section.
- The Apparent Bit Resolution.

See the context sensitive help for more details.

The Errors tabThe Errors tab
This tab actually reports two totally separate things:
Glitches. These are disruptions in the audio. Glitches may occur after problematic digital transfers, after
careless editing etc. They manifest themselves as "clicks" or "pops" in the audio.
Clipping. A digital system has a finite number of levels that it can represent properly. When a sound has
been recorded at too high a level or when digital processing has raised the level past what the system can
handle, hard clipping occurs. This will be heard as a very harsh type of distortion.
Overall Parameters
- "Maximum number..." and "Minimum time..." are the same as for the Peak tab, see above.
Glitch Parameters
- "Threshold" is a value for setting how drastic a change in level has to be, before it is reported as a glitch.

The higher this value, the less sensitive the detection.
- "Sensitivity" is a length value. It represents the length of time that the waveform must exceed the

Threshold to be reported as a glitch. The higher this value, the less sensitive the detection.
Clipping parameters
- The program checks for a number of consecutive samples at full value, to determine whether clipping

has occurred. "Threshold..." is a setting for exactly how many such consecutive samples that must occur
for the program to report clipping.

Results
This reports how many occurrences of glitches and clipping that have been found.
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File ComparerFile Comparer
This utility allows you to compare two files for differences and create a file that contains the difference
between the two, a "delta file". This is useful for example to:
- See the effect of using an equalizer by comparing the file before and after. The delta file will show what

was added.
- Check the noise added by a processor, again by comparing.
- Compare two digitally recorded files to check for dropouts.
Proceed as follows:
1. Make sure that the two audio files which you want to compare are open.
2. Select File Comparer from the Analysis menu.
3. Fill out the dialog box and click OK.
The exact details about the options in this dialog can be found in the on-line help, but here's a run down of
the major possibilities:
- The program can create a delta file, that is, a file that only contains the differences between the two

files. This allows you to hear the difference between two files, for example to check what was lost when
you applied data compression to a file.

- The program can enter markers at positions where differences are found. For this to make sense, there
must only be small differences between the files.

Audio Test Signal GeneratorAudio Test Signal Generator
This utility allows you to synthesize audio documents from scratch. The resulting documents can then be
used for a number of purposes:
- For testing the specifications of audio equipment.
- For measurements of various kinds, including calibrating tape recorders.
- For testing signal processing methods.
- For educational purposes.
The Signal generator is based on a waveform generator which can generate a large number of basic
waveforms such as sine, saw and pulse waves and various types of noise.
The Signal Generator has a multitude of settings for character (Source tab), frequency (Pitch tab) and
amplitude (Level tab).
As if that wasn't enough, you can combine up to 64 such signal generators into "layers" and even make
separate settings for the left and right channel for each.
Once all settings have been made, the program calculates an audio file according to the specifications.
Proceed as follows:
1. Open the Audio Test Signal Generator dialog.
2. Decide on the number of layers required, by setting the "Number of layers" parameter at the bottom of

the dialog.
You can always change this value at a later stage if required.

3. Select one of the layers, using the "Edit layer" parameter.
4. Decide if you want to make changes for both or one of the channels in this layer, by using the "Edit

channel(s)" pop-up.
5. Make the required settings on the Source, Pitch and Level tabs.

The details are described in the context sensitive help. Please note that the length of the file is
determined by settings on the Level tab.

6. Repeat steps 3 to 5 as required.
7. When everything is done, set up a file format and Global level in the middle section of the lower half of

the dialog.
8. Click Generate.

The file is generated and opens up in a new window.
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Frequency AnalysisFrequency Analysis

Frequency Graph - Displaying the GraphFrequency Graph - Displaying the Graph
1. Select the part of the file you want to analyze.

If you select a stereo recording, a mix of the two channels will be analyzed.
The length of the selection affects the accuracy of the analysis. For short selections the result will be
very detailed. For longer selections (over a minute or so) it will not give equally detailed results, since
the harmonic content might vary "between the measure points", which is then not shown in the display.
You might for example make a separate analysis of the attack (beginning) of a sound, since the most
drastic variations usually occur there.

2. Select Frequency Graph from the Options menu and click on the Frequency tab.
Actually, adjusting these settings is not required, but please note that these particular settings can not be
changed when the graph is already open.

3. If you only want to see a plot for a part of the frequency range, adjust the "From" and "To" values.
The range must always span at least three octaves.

4. Decide whether you want the frequency axis in the graph to be Linear or Logarithmic.
Logarithmic is often the most natural choice, since an equal distance on the frequency axis then
represents an octave (doubling of the frequency). In fact this is a special WaveLab feature not
commonly available in other programs.
For more details on the dialog, see the context sensitive help.

5. Select Frequency Graph from the View menu.
The wave is analyzed and the graph opens, in an new window.

The frequency graph shows you how the different frequency components vary over time. A high
"mountain" means that this frequency is very prominent at that particular time.

Frequency Graph - Adjusting the GraphFrequency Graph - Adjusting the Graph
There are a number of settings you can make that affect the way the graph is displayed.
1. Select Frequency Graph from the Options menu, or click directly on the Graph.
2. Click on the Style tab.
3. Decide if you want the graph to be in color, gray scale or black and white.
4. Decide if you want to use a change in color to represent the amplitude (the height of each mountain

determines its color) or if you want it to represent frequency (the frequency spectrum is drawn in colors
ranging from red to purple.

5. Choose a background color (black or white).
6. To view the effect of your changes, click Redraw.
7. Click the Perspective tab.
8. Decide from which point of view you want to look at the graph.

The drawing indicates the direction of the time and frequency axis from each point of view.
9. Decide if you want a linear or exponential amplitude display.

The Wave window’s level rulers use a linear display, so this is a natural choice to start with.
10. Again, if you so desire, click Redraw.
For more details on the dialog, see the context sensitive help.
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Use Real-time processingUse Real-time processing

IntroductionIntroduction
Master Section
The Master Section is the "heart" of the RealTime Engine. One of the main applications for this section is
for preparing recordings for final mastering (CD, video, multimedia etc). But the RealTime Engine is not
limited to this area only. It allows you to creatively process recordings, whether they are complete mixes or
individual tracks in a multi channel recording.
Blocks
The master section comprises the following blocks:
- Effect slots.
- Dithering processor.
- Output level block.
- Apply section.
Deciding whether to use the Master section
Since WaveLab is useful without the Master section, you may opt to "unload" it from the program,
especially if your CPU is too slow. This is done by unchecking the "Use Master Section" item on the
Options menu.
When the master Section is deactivated, the following section of the program are unavailable:
- The Master Section window, including effects and dithering.
- The Live Input.
- The Monitor window.
Opening the Master Section window
The Master section window is opened as any other, from the Windows menu or from the Windows
controller. You can also open it by pressing [Ctrl]+[F9].
When you open this window, effect panels might also appear.
Closing the Master Section
By closing the Master Section window, you also close all the effect control panels that are open at that
time.
Closing the Master Section window does not mean the Master section functionality is removed from the
program. In other words, all the effect processing and other settings are still applied, even though the
window is closed. To completely disable the Master section, instead deselect "Use Master Section" on the
Options menu.

Output level sectionOutput level section
The Output level block
This section is used to monitor and control levels from the output of the program. The following items are
available:
Meters
These show the level of the signal delivered to the computer’s audio output.
If the meters enter the red area, hard clipping has occurred. This means the total headroom of the system
has been exceeded and the sound will be distorted. To reduce the level, use the faders (see below).
Please note that is possible to assign the meters and Clip indicators to the output of a single effect. See
Metering Effects.
Peak Hold values
These fields complement the meters by indicating and "memorizing" the highest signal level ("peaks") for
each channel. The values are retained until you click the Reset button.
Clip indicators
These are tools for detecting for signal clipping at the Master Section’s outputs. Once lit, the Clip indicators
stay lit until you click the Reset button, just like the Peak Hold values.
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Faders
These are the master faders for the entire signal chain. These are mainly used to adjust the level to avoid
clipping or distortion introduced by effects that amplify the signal. Normally, the faders are "ganged", that
is, dragging one adjusts the other by the same amount.
- To adjust by a course amount, drag either fader handle to the desired position. Alternatively, click on

the position on the fader’s outer frame that corresponds to the desired level value.
- To fine adjust, click on the middle or upper half of the fader handle (increase) or the lower dark half

(decrease).
- If you want to adjust one channel independently of the other, hold down [Cntrl] and adjust in any of the

ways described above.
- To set both faders to the 0dB indication, hold down the [Shift] key while clicking either on a fader or its

housing.
About offset fader positions
When working with faders that have been set independently of each other, please note the following two
points:
- The fader graphics move exponentially.

This means that when you move one fader, the other does not follow in a linear fashion on the screen.
However, the audio result is what you expect.

- Fader offsets are not preserved at the end of the range of movement.
If you drag one handle, and the other reaches the end of the available range before the one you drag, its
relative position will be disrupted.

Fader level reading
These show the exact fader level setting for the channel in question.
Reset meters
Click on this button to reset:
- The Clip indicators.
- The Peak Hold values.
- The Dropout indicator.
About button
Click here if you are interested in who programmed the Master Section. Click on the About window to
close it.

Effect SectionEffect Section
WaveLab’s Master Section provides six effect slots. You can load one effect Plug-In into each of these
slots.
Below is an illustration of the internal signal path. As you can note, the signal passes from "top to bottom"
through the effects and then via the dithering option.
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What Effects are available?
A number of effects are included with the program.
In addition to this, a number of plug-in effects can be purchased separately, both from Steinberg and other
vendors. Contact your WaveLab dealer for the latest list. The manuals that come with the plug-in module
describe how to install them so that they are available for use in WaveLab.
To obtain help on using an effect, open its control panel and press [F1].
Adding and Removing Effects
- Click on the arrow next to the effect slot name, to display a list of all installed effects. Select one by

clicking on its name.
- Select "None" to remove the effect from the slot.
You can assign the same effect to several slots, making it possible to use it several times, with different
settings.
Metering the Output of an Effect (Mon button)
When Mon is activated for an effect slot, the outputs of that effect are assigned to the Clip indicators and
meters. This can be used to visually check the output of an effect for inappropriate signal levels.
To route metering back to the master section, click the Mon button again.
Opening a Control Panel for the Effect (FX button)
When you first assign an effect to a slot, its Control Panel appears automatically and the FX button will
light up to indicate that the panel is open.
- To close the panel, use its close box or click the FX button. To re-open it, click the FX button again.
- When you close the Master section, all control panels are automatically closed.
Soloing an effect (Solo button)
Click the Solo button if you wish to listen to an effect in isolation. Any other effect you may have assigned
to another slot will temporarily be bypassed. You can only solo one effect at a time.
Activating/Deactivating an effect (ON button)
- Click the ON button to activate/deactivate an effect. The indicator shows the status.
Deactivating an effect temporarily removes it from the signal chain, thus freeing up processing power for
other calculations.
Turning off all Processors
The Global Off button allows you to bypass all processors temporarily, so that you can hear how things
sound without any processing at all. What this switch actually does is to set each individual processor to
Bypass mode.
Please note that the dithering and output level setting are active, even in Global Off mode.

Dropout indicatorDropout indicator
This indicator will light up whenever WaveLab fails to properly play back as little as a single sample of the
currently selected wave.
Why and when does a dropout occur?
A dropout is most likely to occur when your computer does not have the processing power to properly
handle all the effects that you have inserted.
The Dropout indicator also comes on when you assign or remove an effect from a slot. As long as you are
not mastering, this situation is nothing to worry about.
As mentioned above, this indicator lights up if as little as a single sample is not correct. Often this type of
precision is not required, but the sensitivity of this indicator is yet another proof that great care has been
taken to provide you with a truly professional tool.
What can I do about it?
To avoid dropouts, try the following:
- Use fewer effects.

You might be running out of processing power.
- Consider Applying the effects rather than running them in real time. This saves a file to which the effect

has been permanently applied. Then master from the processed file without any effects plugged in.
Dropouts never occur when "Applying" effects in this way.

- Do not process any files in the background while mastering digitally to for example a DAT.
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- If neither of the above helps the situation, please check the Audio Card Preference settings, you might
need to adjust the audio buffers.

If a dropout occurs during the mastering process (and if your master must be flawless for it to be useful) we
strongly recommend that you re-master. Stop playback, click on the Dropout message or the Reset button
to turn the indicator off again, and try again.

DitheringDithering
What is dithering?
Dithering is a method for reducing quantization errors in digital recordings. To the ear, such errors are
perceived as "graininess" during low level passages in a recording. When "truncating bits", as a result of
moving from for example 20 to 16 bit resolution, such quantization errors are added to an otherwise perfect
recording.
By adding a special kind of noise at an extremely low level, the quantization errors are minimized. Indeed,
the added noise can be perceived as a very low-level quiescent hiss added to the recording. However, this is
hardly noticeable and much preferred to the distortion that otherwise occurs.
When should I apply Dithering?
- When preparing 20 bit files for mastering to CD (converting to 16 bits).
- When preparing 16 bit recordings for multimedia (converting to 8 bits).
- When processing with effects in the master section, even though there is no intention to change the bit

resolution of the file.
Digital effects of any kind can sometimes introduce quantization errors.

How do I dither?
The general process for dithering is this:
1. Set up the Master Section window as desired.

This might include using effects of various types.
2. Process in real time or Apply the changes.

Dithering is applied as part of the processing. If you for example are playing back a 20 bit file via a 16
bit card, the bit reduced signal will be dithered.

3. If you "Applied" the settings, now save the file in a format with a lower bit resolution.
The Dithering options
Unfortunately, there are no hard and fast rules for the following options, what to select depends on the type
of material. We recommend that you experiment and let your ears be the final judge.
To set the parameters, click the white arrows repeatedly until the desired value appears.
- Dither method (off, Type 1, Type 2)

- Off: No dithering is applied.
- Type 1: Try this option first, it is the most "all-round" type of method.
- Type 2: This method emphasizes higher frequencies more than Type 1.

- Dither Bits (8, 16, 20 or 24)
This is used to specify the intended bit resolution for the final audio, after dithering, regardless of
whether you "Apply" the settings or use real-time processing. It is very important to set this correctly,
especially when reducing the bit resolution.

- Noise Shape (off, type 1, 2 or 3)
This parameter alters the character of the noise added when dithering. Again, there are no hard and fast
rules, but you may notice that the higher the number you select here, the more the noise is moved out of
the ear’s most sensitive range, the mid-range.

The Apply functionThe Apply function
As stated earlier, all processing in the Master Section and the effect modules is carried out in real time,
which means that you could master your projects without permanently changing the waves being
processed.
You can, however, also "Apply" the settings to the wave file being processed so that they become a part of
it.
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When do I use Apply and when do I use real time?
One important difference between applying effects and using them in real time, is that with the Apply
function, any combination of effects can be used even though your computer doesn’t have the processing
power to apply them in real time.
This means that applying can be a way of performing heavy processing on a less powerful computer.
Another thing to note is that if you are worried about dropouts, applying effects will remove this problem
completely.
What is Applied?
When you Apply the settings, the following processing is applied to the file:
- The master fader settings.
- The Effects.
- The Dithering options.
Selecting where the effect is applied
The Apply function operates on either the file in the active window, or on the wave being played. This can
be used to process one file in real time as it is being played back, while applying settings to a number of
other files.
Calling up the Apply dialog and filling out the options
1. Click the Apply button to call up the dialog.

For a description of the options, use the context sensitive help in the dialog itself.
2. Once everything is set up correctly, click OK to initiate the processing. Or, if you change your mind,

click Cancel.
Working with multiple files
Once you have applied settings to one wave, as described above, you can continue with processing the
next. The processing of the first wave will continue in the background. This way you can apply processing
to as many waves as desired. Please also note that each wave can have it’s own priority  setting.
Every time you start a background process, a copy of the current plug-in configuration is created and
associated with this background process. This means that you can remove and add plug-ins without
affecting the current background process(es). In other words, editing plug-ins, removing them, inserting
new ones, changing the dither options, the volume, etc., does not affect the background processing.
Background processes can be suspended, canceled or boosted via the Monitor window.

Handling Plug-in processorsHandling Plug-in processors

What Processor (plug-ins) can be used?What Processor (plug-ins) can be used?
There are primarily four sources for effects:
- Effects included with WaveLab, designed specifically for the program.
- Effects included with WaveLab, designed to also work with Cubase VST and other Steinberg programs.
- Third-party or Steinberg plug-ins that you purchase separately and that are specifically designed for

Steinberg programs ("VST-compatible plug-ins"). Contact your WaveLab dealer for the latest list.
- Plug-ins that adhere to the Microsoft DirectX (formerly ActiveMovie) standard.
Some processors not specifically designed for WaveLab may not have a dry/wet signal balance parameter.
In these cases, using the plug-in in WaveLab may not produce the desired effect. You might wind up with
an all-wet signal or a mix between wet and dry that can’t be adjusted.

Installing Plug-in ProcessorsInstalling Plug-in Processors
Installing the included plug-ins
A large number of plug-ins were installed with the program. To use these you do not need to do anything,
they are already available.
Installing additional VST-compatible plug-ins
When you purchase a plug-in processor designed to work specifically with WaveLab, instructions for
installing it will be included.
Installing DirectX plug-ins
A large number of plug-in processors in the DirectX format are available. There is even some free- and
shareware available on the Internet which are free or shareware.
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Normally if the DirectX plug-in has been installed properly, it will automatically be "visible" in WaveLab.
If it isn’t, you need to "update the Windows registry" so that it is. Proceed as follows:
1. Launch the Windows Explorer.
2. Locate the actual plug-in file on your hard disk.

These are "dll" files, which means they normally have the extension ".dll". Sometimes other extensions
are used as well.

3. Drag and drop the file icon, either onto the WaveLab program icon, or somewhere in the WaveLab
application window.
A dialog box will ask you whether you want to register the plug-in or not.

Handling Plug-in Control PanelsHandling Plug-in Control Panels
Any number of effect panels can be open at the same time by clicking the corresponding "FX" button in the
Master section.
The windows can be positioned anywhere on the screen.
Bypass, Mute and Clip in Standard panels
- To bypass both an effect module and the slot to which it is assigned, click the On button in the Master

section, so that its indicator goes out.
- To bypass an effect while keeping the slot active, click the Bypass button in the effect's control panel.
- When you click the Mute button in a control panel, you actually mute the slot’s signal output. That

means that you will no longer hear your wave or live signal because it won’t even reach the next stage
(either another slot or the master faders).

- The Clip indicator will light up whenever the signal level is too high. Unless you notice any audible
signal deterioration, this is nothing to worry about since WaveLab’ internal dynamic is 192dB. In other
words, it is perfectly possible to have a signal over 0 dB. The Clip indicators of the Master Section,
however, should never light up.

- It is possible to bypass the entire Master Section (including the effects) by placing the cursor in the Main
View, holding down the [Space bar] and pressing the left mouse button. Playback of the original (i.e.
with no processing whatsoever) will then continue until you release the left mouse button.

Setting effect parameters in standard panels
All the standard effects' control panels provide the following procedures for selecting parameters and
setting values:
- "Para" buttons are used to select which of the available parameters to change. Click the left Para button

to select the previous parameter (if available), or the right button to select the next parameter.
The selected (and therefore adjustable) parameter is indicated by a rectangle. If there are more
parameters than the window can display, the parameter window will scroll to the left or right whenever
you select a parameter that is currently not shown.

- Click the Dec/Inc buttons to change the value of the selected parameter by one step. The red indicator
to the left of the buttons will light up every time you click.

- The Data Entry dial is also used for changing parameter values. To change the value, click on the dial
and drag upwards to increase and downwards to decrease.
In addition, different combinations of mouse buttons allow you to control how the value changes.
- Normal data entry - Use the left mouse button.
- Coarse data entry - Use the right mouse button.
- Fine data entry - Use both the left and right mouse buttons.

Custom Panels
The look of some effects may deviate from the standard control panel described above. In fact, an effect can
have any control panel that the plug-in designer desires. An example of this is the EQ module included
with WaveLab.
For information about the panels for additional plug-ins, see the documentation for each plug-in.

Working with Plug-in PresetsWorking with Plug-in Presets
With WaveLab comes a number of "factory presets" for the included processors, that you can you select
and use as is, or as a starting point for your own settings. Additional plug-in processors may provide their
own "factory presets".
WaveLab specific plug-ins
Applying and saving Presets for WaveLab specific processors works exactly as with any other Preset. See
the "Presets" section on page 76 for details.
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VST-compatible plug-ins
VST plug-ins have their own Preset handling. When you click the Preset menu in this type of plug-in, a
menu with the following options appears:
- Load/Save Bank.

This allows you to load and save complete sets of Presets. The file format is compatible with Cubase
VST.

- Load/Save Preset
As above, but for one Preset at a time. Also compatible with Cubase VST.

- Edit name of current program
This allows you define a name for the Preset, which might be displayed in the panel (depending on the
plug-in).

- Preset List
This allows you to select one of the currently loaded Presets.

DirectX plug-ins
Here, the same functionality as for WaveLab plug-ins is provided. In addition, you can import "native"
presets created for the plug-in.

Organizing Plug-in ProcessorsOrganizing Plug-in Processors
You may find that you need to organize your processors into sensible groups. Why? Well, a host of plug-
ins are included with the program, and additional ones can be added. If you have Cubase VST installed on
the computer, even more appear in WaveLab. And sometimes when you install a package of Active Movie
plug-ins, the menus become cluttered with effects which have no relevance to WaveLab (or even to audio).
Organizing the way your plug-ins appear on menus in the program is done in the Plug-ins Manager, which
is opened from the Options menu.
About the plug-in list
The Plug-in Manager window.
Program Sections
There are plug-ins for two sections of the program, the Loop Tuners and the Master Section. This is
indicated by two folders in the list, at the "root level".
These two types of plug-ins are fundamentally different.
- The Loop Tuners are for working with samplers.
- The Master Section plug-ins are Processors, or effects, that can be added to the Master Section slots or

utilized from within the Batch Processor, see the context sensitive help for details.
Groups
In the Master Section section of the list, you will find sub-folders, representing Groups of plug-ins (Loop
tuners can't be organized into Groups).
By organizing your plug-ins into folders, you arrange the way they appear on menus in the program. How
you organize your effects is of course up to you, but initially, they are categorized according to their
technical "type", regular plug-ins in one folder, VST plug-ins in another, Active Movie plug-ins in yet
another, etc, see the context sensitive help for more details.
The Columns
- The Plug-in column displays the names of all the available plug-ins.
- The Use columns determines whether a plug-in is active or not, see below.
- The Key column displays the Key Sequence defined for a plug-in.
- The Module columns tells you something about the origin and type of the plug-in.
Activating and Deactivating Plug-ins and Groups
By clicking in the Use column, you can activate/deactivate individual plug-ins or an entire Group of plug-
ins (see below for more info on Groups).
If you have plug-ins installed in your computer that you don't want to use in WaveLab, you can use this
functionality to disable them completely (they will still be applicable in other programs which can use
them). This reduces "menu clutter".
An example of this would be Active Movie plug-ins. Many of these do not apply to audio at all and have
no relevance to WaveLab whatsoever. By disabling these, you will make it easier to find those plug-ins that
you really want to use in WaveLab.



WaveLab 3WaveLab 3 How to...How to...

5353

Working With Groups
The master Section plug-ins can be organized into Groups. This is done by adding sub-folders to the
Master Section folder and then dragging Plug-in icons into these folders.
When you then select from plug-in menus or display lists of plug-ins, the organization you have created
here will be reflected in the menu/list.
Creating and Deleting Groups
- To create a Group, click the New Group button, enter a name and press [Return].

The Group will initially appear at the end of the list, but when you start using it, the list will be resorted
so that the Groups are displayed in alphabetical order.

- To Delete a Group, select it and click Delete Group.
If the Group contains any plug-ins, they will not be deleted. Instead, they will appear in the Master
Section section, outside all other Groups.

Moving a Plug-in to a Group
Moving plug-ins between Groups is done by dragging and dropping, just as when dragging files in the
Windows Explorer.
Undoing and Returning to the Default Settings
- If you lose Track of your changes and wish to return to the state that the list was in when you first

opened the dialog, click Undo Changes.
- If you want to restore everything to the default "factory settings", click Set default.
Defining a Key Sequence for a Plug-in
You can define a Key Sequence for a plug-in, just as for Master Section Presets.
- If the Plug-in is a Crossfade Looper, the Key sequence will simply open its window.
- If the Plug-in is a Master Section processor, then it will be added to the Master Section list (if not

already there) and it's panel will be opened.

Monitor WindowMonitor Window

Background Process ViewBackground Process View
This view lets you monitor the progress of the background process(es) that are currently taking place. By
right clicking on the view, you open a menu that provides several options: you can change the priority
boost of any process, suspend it (to assign more power to the other processes), cancel it, etc.
Use the context sensitive help ([F1]) for explanations of the items on the menu.

Status DisplayStatus Display
The lower part of the Monitor window, the Status display, provides a reflection of the processing power
currently being used by background processing.
- The yellow lines refer to the power used for providing input to the Master Section, either reading waves

from disk or Live Input. Please note that the values are an approximation. What is shown is the
minimum value WaveLab could measure. This performance is influenced by the quality of your audio
card driver (for Live-input) and by your hard disk (SCSI is often better than IDE or E-IDE at
transferring data).

- The purple lines indicate the processing power that is required for all effects currently running in the
Master section. The shorter the line, the less the load on the CPU. This is a very precise measurement.
Usually, these lines should not exceed 70-75% to ensure no dropouts occur during playback. Since
processing/playback is a high-priority task, the entire user interface slows down when a demanding
process is taking place. To start/stop playback during heavy CPU loads, use the keyboard shortcuts
rather than clicking on the Transport Bar with the mouse.
To save processing power, you can opt to play/process only one of the channels in a stereo file. Use the
"Play Left/Right channel" options on Options menu. Playing/processing only one channel (in real
time) reduces the CPU load for this operation by 50%.

- The blue lines reflect the processing power required by the output device. This is an approximation.
WaveLab will show the minimum value which it could measure. The output performance is influenced
by the quality of your audio card driver.
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Customizing the Status display
You can customize the way the processing information is displayed. If you want to see more of what is
going on, resize the window.
Other options are available if you position the cursor anywhere in the black part of the window and press
the right mouse button. Use the context sensitive help ([F1]) for explanations of the items on the menu.

Live InputLive Input
Live Input means that the Master Section is used for real time processing of signals coming in to the sound
card’s input(s). This signal can be of any type that your sound card will accept, for example an audio feed
from a mixer, a tape recorder or a microphone.
This option either requires an audio card with full duplex, or two cards, one for recording and one for
playback!
Activating and setting up Live Input

• To activate the Live Input mode, click on the microphone in the Windows bar.
• To set up the attributes for the Live Input, click with the right mouse button in the Live Input window.
• To activate Live Input, click Play.
• To resume regular playback of opened waves, click on any wave window.
• To again switch back to live input, stop playback and click on the Live Input window.
It is not possible to start playback of a wave while the Live Input window is active. You must activate a
wave window before clicking the Play button.
Live Input, delays and buffering
It is unavoidable that a certain delay is introduced between live audio input and output. If you process
audio from for example a DAT, this delay is normally no problem. You can then concentrate on making
settings that minimize the risk for dropouts. However, if you process a live instrument, you might need to
make this delay as small as possible.
This balance between short delay times on one hand, and minimizing the risk for dropouts on the other, is
done by adjusting the buffering on the Audio Card tab in the Preferences dialog (see the context sensitive
help in the dialog for details). With proper settings, the delay can often be reduced to 100 or 200
milliseconds.
Two factors will determine how much you can reduce the buffers:
- The audio-card.

The faster the card, the smaller the buffers need to be.
- The CPU power.

The more plug-ins you have, and the slower the computer you use, the larger the buffers must be.
Usually, if it works for you, it is better to have a few large buffers, rather than many small ones.
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Perform Batch processingPerform Batch processing

Opening the Batch ProcessorOpening the Batch Processor
Use Master section must be active on the Options menu for Batch processing to be available!
There are two basic ways of opening the Batch Processor:
- From the File menu.

This gives you a "clean slate" to start with.
- From the Apply dialog.

This takes the current settings in the Master window and converts them into a Process List (a
Sequence).

For the Batch Processor button to be enabled in the Apply dialog, "No tail", Roll out" and "Skip Mute
sections" must all be disabled!

The Input Tab – Assembling a list of filesThe Input Tab – Assembling a list of files

Creating BatchesCreating Batches
You can not only process one Batch of files, but many. Each Batch contains a number of files, and all the
files in a Batch will be processed identically. However, each Batch can use a totally different set of
processors.
- To create a Batch, click the New Batch button at the top of the list.
- To Remove a Batch, select it and click the Remove button (the red cross).

All the files in the Batch will be removed from the list as well.

Renaming and setting Attributes for a BatchRenaming and setting Attributes for a Batch
To rename a Batch, proceed as follows:
1. Select the Batch in the list and click on the name icon (the "A").

Alternatively you can hold down [Alt] and double click directly on the Batch.
2. Enter the desired name in the dialog.

The name will have an effect on the order of Batches in the list, which in turn affects processing.
Entering a number instead of a name has a special meaning, as described in the next section.

3. If desired, specify an output path for the Batch.
This is an advanced option that in many cases will not be necessary. You only need to specify a path
here if you will want to process a number of Batches at the same time, and want some of the Batches to
store their output files in a different directory.

Setting the Order of BatchesSetting the Order of Batches
Batches will be processed in the order they appear in the list. If you want a certain Batch to be processed
first, put it at the top of the list. There are several ways to set the order of Batches:
- You can move a Batch up and down by using the arrow buttons.
- You can drag and drop a Batch to change the order.
- You can specify a number instead of a name in the Name dialog described above.

This will change the name of the Batch to the default name "Batch X", where X is the number you
typed. All the other Batches with default names will be renumbered accordingly.

Adding And Removing Files from a BatchAdding And Removing Files from a Batch
- Regardless of which of the methods below that you choose, you should first select the Batch to which

you want to add the files, by clicking on it.
This will ensure that the files are added to the right Batch. If you forget this, you can always drag files to
the right Batch later.

Adding Open Documents
- To add an already open document to the list, simply select it from the document pop-up.

Open documents are represented by blue and white miniature window icons.
You can not process files that haven't been saved at all yet! Please save the file before processing it.
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Adding one or More Files via a dialog
1. Click the Add File button.
2. In the file dialog that appears, locate and select the desired files and click Open.

Files are represented by yellow icons. Please remember that you can use [Shift] and [Control] in the file
dialogs to select as many files as you wish, from the same folder.

Adding Files via Drag and Drop
You can also add files from the Windows Explorer or My Computer windows. Simply drag the file icon
and drop it on the Batch.
Adding All Files in a Folder
To add all files in a folder (and possibly in all its sub-folders), proceed as follows:
1. Click the Add Folder button.
2. In the list that appears, select the desired folder and click Open.
3. In the next dialog, decide what file types should be included, via specifying an extension (you can use

"*" to add all file types).
You can also specify whether or not you want to include files in folders located inside the selected
folder (sub-folders).

About "Allow duplicate file names"
When this option on the Extra pop-up menu is activated, the same file can be added to several batches, and
hence be processed several times. The only restriction is that each "instance" of the file must be set to create
a file with a name and/or location that is different from the other "instances" of the same file.
Removing Files
- If you want to remove one or more files from the list, select it/them and click the Remove button (the

red cross).
Please note that holding [Shift] and [Control] while clicking can be used to select multiple files.

- If you wish to clear the list completely, to start "from scratch", pull down the Extra menu and select
"Clear list".

Various File Considerations
If you are processing a file which is already open, please note the following things:
- If the new file will have the same name and is to be saved in the same location, the file will not be saved

(since it is already open). This is the same as using Apply with the "Process in place" option activated.
In this case, Undo is available for the processing.

- If the number of channels changes in the file (mono becomes stereo or vice versa) then a new document
is created, which is opened in an untitled window.

- If the new file is saved under a new name or in a new location, then a new file on disk is created, there's
no need for saving. A nice side effect of this is that the Batch processor can be used for saving very large
files to disk in the background, so that you can keep working on other files "in the foreground".

Setting the order of files in the listSetting the order of files in the list
Moving files between Batches
Since all files in a Batch are processed with the same set of effects, it is very important to make sure each
file is in the correct place. If one ore more files have for some reason wound up in the wrong batch, you can
move it/them:
1. Select the file(s) that are in the wrong batch.
2. Drag and drop it/them onto the Batch that you want to move them to.
Changing file order within a Batch
The order of files within a Batch is of no particular importance (they will all be processed in the same way),
but when you set up a Batch with many files, it might make things easier if you can organize things the
way you want it:
- You can move a file up and down within the Batch by using the arrow buttons.
- You can drag and drop files within a Batch to change the order.
- You can re-sort the entire file list by selecting one of the sort options on the "Extra" menu.

You can also re-sort the list by clicking on the file headings.
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Checking File StatusChecking File Status
To the left of the file you will find an icon providing information about the status of the file:
IconIcon MeaningMeaning

Green Circle The file is ready to be processed. You can not start processing unless at least one
file has this status.

Purple dot The file is currently being processed. The Batch window can't be closed if any
files have this status, the only way to stop a Batch is then from the Monitor
window.

Half filled green circle The file has been analyzed by an "Ultra-pass" processor but has not been
processed and written to disk yet.

Green Dot The Batch has been processed without problems. To be able to process the file
again, you need to reset it's status, see below.

Red Cross An error occurred. You will most likely have been warned via an alert box. If an
error occurs, processing is cancelled.

Resetting File Status
- To reset the status of a file to the "green circle" status described above, click on the symbol to the left of

the file.
- To reset the status of all files, select "Reset Status of all Files" from the Extra pop-up menu.
Other File Functions and Options
- The "Show full path" and "Show name only" options on the Extra menu allow you to determine what

file information you want to see in the list.
- To play a file, select it and click the Play button (speaker icon).

Click the Stop button on the Transport to stop playback.
- To open a file in a wave window, select it an click the "Open window" button (to the right of the Play

button) or drag it and drop it on an empty section of the WaveLab program window.
- If the file list contains files in raw format, you can specify the format for them, by selecting "Raw file

format" from the Extra pop-up. If this is done, you don't have to specify the format manually each time
a file in Raw format is about to be processed.
For this to make sense, all "raw" files must be in the same format.

Saving and Opening File ListsSaving and Opening File Lists
- To save the file list as a simple text file, containing the absolute paths (locations) of all files in the list,

select "Save file list" from the Extra menu.
- When you open a file list that you have saved (or one created in some other way), the files in the list are

added to the currently selected Batch.

Validating the ListValidating the List
- There might be occasions when you cannot be certain whether the file list really matches the contents of

the hard disk. For example, a file might have been deleted from the disk since you last updated the list.
- When you select "Validate list" from the Extra menu, the program will scan the list and check that all

files really exist in the locations the list specifies. If not, those files will be removed from the list.

Setting up the Processing tasks to be performedSetting up the Processing tasks to be performed

Opening the Processor ListOpening the Processor List
There are three ways to open the Processor List:
- Select a Batch in the list and click the Processor List button.
- Select a Batch in the list and press [Return].
- Double click on a Batch.

Adding a Processor to the listAdding a Processor to the list
1. If the Processing option has Presets that you want to use, click on its folder "+" symbol to open it.
2. Select either the desired Preset or the Plug-in icon.

Selecting the Plug-in icon itself, adds the processor with default settings.
VST plug-ins do not have Presets in this list, you have to make settings in the actual panel.
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3. Either click on the "+" button or drag the selected symbol to the left pane of the window and drop it.
- If you use the "+" button or drop below the existing list, the processor will be added at the end of the

list.
- If you drag and drop on another symbol, it will be added just before that processor in the List.
If you create an "impossible" combination of effects, for example feed a mono output into a processor that
only accepts stereo input, you will get an error message when you try to process.

Removing Processors from the ListRemoving Processors from the List
- To remove a processor, select it in the left list and click the Remove button.

Changing the order of the ProcessingChanging the order of the Processing
If you have added the correct processors, but realize they are in the wrong order, you may change this.
There are two ways:
1. Select a processor in the list.
2. To move it one step up/down, click the up/down arrow buttons.

Making Settings for a ProcessorMaking Settings for a Processor
If you want to adjust the settings for a certain processor, proceed as follows:
1. Double click on the processor in the sequence list, or select the processor in the list and click the Edit

button (the fader).
The panel for the processor appears.

2. Adjust the settings (or select another Preset) and click OK.
Some off-line processors (shown with "blue", "yellow" or "green" icons) may not have Presets. In this case,
you have to adjust the settings on the panel. Furthermore, some "old" plug-ins may not be adjustable in this
way. If this is a problem, add the offending plug-ins in the Master section instead, make the desired
settings, click Apply and create a Batch from the dialog that appears.
Closing the Processor Window
- Once you have finished with all the Settings, click OK to confirm the settings and close the dialog or

Cancel to close it without saving any changes.

The Output Tab – Settings for Created FilesThe Output Tab – Settings for Created Files

Setting Up a simple Destination FolderSetting Up a simple Destination Folder
There are two ways to simply specify a folder for all created files:
- Type in a path (file location) on the Destination folder line.
- Click the folder icon just beside the destination folder line, browse your way to a folder and select it.

Using Path VariablesUsing Path Variables
If you need more advanced options, for example if you need to store different Batches in different folders,
you need to use the path variables, available on the pop-up to the right of the folder icon.
Variables are text string enclosed in brackets (for example "<"Group Path>") that appear on the
Destination folder line. You can type these variables yourself, but usually it makes much more sense to
select them from the pop-up.
When you run the Batch, the variables are replaced by folder names. Exact details follow later in this text.
The specified folders are created automatically if they don't exist.
You can use more than one variable on the line, to create very advanced automatic file paths. Then the
order of the variables on the line is very important since each added item will represent a sub-folder inside
the previous folder.
When you add variables to the Destination path, they will appear just after the insertion point, just as when
you type text. Hence, adding a variable is done as follows:
1. Click at the position on the Destination folder line where you want the variable added.

A blinking insertion point cursor appears.
2. Select the desired variable from the pop-up menu.

For the available variables, see context sensitive help.
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Whether or not you are using variables, if you explicitly specify a drive name, this will always be used,
regardless of where the source is located and what type of variables are used.
For example, if you have a source file in "c:\MyFolder\" and specify "e:\<SourcePath>\", the new file
will be stored in "e:\MyFolder\".

Using File name Prefixes and SuffixesUsing File name Prefixes and Suffixes
For the file names created, you can use the fields "File name prefix" and "File name suffix" to add text to
the beginning and/or the end of the original name.
- You can type in any text, which will then be added at the beginning/end of the file name.

If for example you leave the prefix field empty and type "(processed)" in the suffix field, "MyFile" will
become "MyFile (processed)".

- You can add the "variable" "Batch name" anywhere in the text by selecting it from the small pop-up to
the right of the pre/suffix lines.
This will add the name of the batch into the file name, at that location.

- You can add the variable "File number from...", in the same way.
This will add a number to the file name. All the files will be numbered consecutively, and a dialog will
allow you to specify the first number in the series.

Creating Zip ArchivesCreating Zip Archives
You can automatically create a Zip archive of the created files. A Zip archive is a file which contains other
files, in a compressed format. The compression is non-lossy, which means that when you "un-zip" the files
you get exactly what you had when you created the archive, the information is not changed in any way.
Zip files are often used for archiving purposes and when sending files to other people, for example via the
Internet.
Proceed as follows:
1. Activate "Archive Output Files".
2. Decide on a Path and file name for the zip file.

This is done either by typing the complete path or by clicking the folder button.
3. If you want the Zip archie to contain information about how the files are stored in sub-folders, activate

"Save path information".
4. If you want to delete the output files after the files have been added to the Zip archive, activate "Move

(erase) output files".
If this is deactivated, you will get the output files in their regular format plus a zip archive containing
the same files.

Creating Backups and Automatically Deleting Source FilesCreating Backups and Automatically Deleting Source Files
- If you want the program to create backups of any files that would otherwise be overwritten as a result of

the procedure, activate the "Create Backups" options.
When this is activated, the program will make a copy of the file before processing. It will also change
the first letter in the extension of the copy to "~". For example "myfile.wav", will be backed up as
"myfile.~av".
This only applies if you have used the variable "Source Path", as described above, to specify that the file
should be overwritten with the same name.

If you are not absolutely sure of what you are doing, we strongly recommend that you leave this option
activated, to avoid accidentally overwriting files.
- If you want the program to delete the original (unprocessed) files after processing activate "Delete files

after process".
This is a very dangerous option! If the processing didn't turn out as expected, you can't redo it, because you
won't have any files left to re-process!

Selecting an Output FormatSelecting an Output Format
- If you want the new files to be in the same format as the original ones, simply select "As source".
- If you want some other file format, select it from the menu.

For details about various file formats, see the context sensitive Help.
- If you have selected Wave as your file format, you can also compress the files, using the same options

as for the Save Special Compress feature. Simply activate Compress and click on the large button
below.



How to...How to... WavWaveLab 3eLab 3

6060

Please note that when you select this option from the Batch processor, all possible file formats are
available, not only the ones that apply to the current file format. This happens because the program does
not yet "know" which types of files you are about to process. Since options are displayed that may not
apply to the file type you process, make your selection with care.

SchedulingScheduling
The Schedule tab is used for various options related to the performance of the Batch processing: For details
see the context sensitive Help in the dialog.

Running and Stopping the Batch(es)Running and Stopping the Batch(es)
- Once all settings are made, all you have to do to start the Batch is to click Run.

The files are processed, much as when you click Apply in the Master section.
- You can Stop processing by right clicking in the Monitor window.

Using Presets for Batch ProcessingUsing Presets for Batch Processing
Please note that there are two different types of Presets involved in this dialog:
Batch Processing presets
Use these for storing and recalling settings that apply to all Batches.
They include:
- All settings made on the Input tab, except the actual file list.
- All settings made on the Output tab.
- All settings made on the Schedule tab.
They do not include:
- The list of files to be processed.
- The list of processors assembled in the Processor list dialog.
Processor List Presets
These include the currently assembled list of processors, in the Processor list dialog. Use these to save
useful combinations of processors, including their settings.
File Lists
While strictly not a type of Preset, the Open and Save File list features can be used to save and recall the
information about what files were processed in a Batch.
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Use MarkersUse Markers

About MarkersAbout Markers
The following marker types are available:

Marker Type:Marker Type: PurPurpose:pose:

Generic This is mainly used for locating certain important positions and for editing
(for example selecting all audio between two positions).

Temporary As Generic, but not saved with the file.
CD Start, End & Boundary These denote where CD Tracks start and end. A CD Track Boundary is used

when a CD Track starts just where another ends.
CD Sub-Index These are used to create "index" points in CD Tracks.
Loop Start and End These are used to define loop points. This is useful for editing purposes, and

also when creating loops before transferring a sound to a sampler.
Mute Start and End This can be used to temporarily silence a certain section. In addition, muted

sections are skipped on playback, see page 137.
Playback Starter This is used to program a playback start point. See page 135.

About Marker Pairs
Three of the marker types come in pairs: CD, Loop and Mute.
Since you can’t have a CD track that Starts but never ends, a Loop End point without a Start etc, special
rules exist for creating, deleting and moving these types of markers.
- CD Track markers must always be "balanced".

For example, if you delete a Track Start, the corresponding end marker will also be deleted, or other
markers will be changed.

- Loop and Mute markers only have any functionality when they are balanced.
You can enter just a Loop Start marker, but it’s purpose will be defeated by the lack of a corresponding
Loop End.

In the following text, whenever an operation has a special implication on marker pairs, this will be noted.
About Importing and Saving Loop Markers
There are a few points to be aware of when importing files with loops into WaveLab. This is because the
loops can be defined in two places: Wave and AIFF file formats have the ability to contain loop points, and
WaveLab stores loop points as markers separately for each file, in ".MRK" files. So, there’s a potential risk
for conflict:
- When you import a file that has never been used in WaveLab before, and which contains loops, the

loops are "imported" and displayed as loop markers (in addition, the sample note and detune
information described on page 372 is imported, if present).

- When you then save the file in AIFF or Wave format, the loop points are stored, both as part of the
actual file (so that other applications can read them) and in the ".MRK" file (for WaveLab). To make
sure loop info is saved properly in the actual file, use Save As rather than Save.

- When you open a file that has been used in WaveLab before, loop indications that were originally in
the file, before you used it in WaveLab, are ignored. Only the Loop info in the ".MRK" file is used.

The Marker Toolbar
There is a special Toolbar for markers. This can be brought up from the View menu, just like all other
Toolbars, or by pressing [Ctrl]-[M].
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Creating a Marker on the fly or from Stop modeCreating a Marker on the fly or from Stop mode
Dropping Markers on the fly
To add a marker on the fly, proceed as follows:
1. Play back the file.
2. When the cursor reaches the position where you want a marker:
- Press [Insert].
- Click the Drop marker button on the Marker Toolbar.
- Select Drop Marker from the time ruler speed menu.

You can give the marker a proper name later.
Dropping Generic or Temporary markers
Normally the markers dropped this way are Generic. However, in the Units tab in the Preferences dialog
you will find an option for dropping temporary markers.
Creating a Marker from "stop mode"
1. Set the wave cursor to where you want the marker to appear.
2. Do one of the following:
- Click on the New Marker button on the marker Toolbar.
- Click with the right mouse button on the time ruler and select New Marker from the menu that appears.
- Press [Control]+[Insert] as a shortcut for the "New Marker" operation described above.
3. Select a marker type.
4. Fill out the other options in the dialog and click OK.

See the context sensitive help for details.
If you add a CD Start marker like this, a corresponding end marker will be added automatically, and vice
versa.

Dropping Markers While RecordingDropping Markers While Recording
You can drop markers during a recording. For example, if you are auditioning some material while
transferring it from DAT tape to WaveLab, you can add markers at important positions, as they are
coming up.

Creating Marker pairs From the Marker ToolbarCreating Marker pairs From the Marker Toolbar
To create a Loop or a Mute Region (see later in this chapter for descriptions of these terms) or a complete
CD Track, you can use the Marker Toolbar:
1. Make a selection that spans the area you want to enclose by a marker pair.
2. Click on the corresponding Marker pair symbol on the Marker Toolbar.

Markers are added at the start and end of the selection.

Generating Markers AutomaticallyGenerating Markers Automatically
The program allows you to automatically generate markers at certain significant positions in a file or
selection. For example this could be used to pinpoint phrase starts in recorded dialog, beats in a drum
recording etc.
This is based on peaks and silence in the material. WaveLab analyses the file and adds markers at positions
that match the criteria. If a pair type marker has been specified (CD Track Start/End, Loop Start/End etc),
alternate start and end markers are added, specifying "regions" in the material.
1. If you only want to add markers to a certain part of a file, select that part.
2. Open the New Marker dialog.
3. Select the type of markers you want to add, by clicking in the list to the left.
4. Click the Automatic generation button.
5. Set up the dialog according to the material and the desired marker "density".

Use the context sensitive help for details about the dialog. Also note that you can create and use Presets
for this.

6. If you want to add markers to the selection only, make sure "Only process selected audio material" is
activated.
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7. If you want to automatically turn all found regions into CD Tracks sections, activate "Create CD track
list from created regions".
For this option to be available you must have selected CD type markers in the previous dialog.

8. Click OK.
The program tells you how many markers will be added. This gives you and idea of the validity of your
settings. If the number doesn't make sense, click Cancel and try again, otherwise click OK.
Some manual tweaking of the added markers will most likely be necessary. Often it makes sense to let
the program add more markers than is required so that you later can manually delete the superfluous
ones.
If the marker creation didn't turn out as expected at all, use the "Delete Multiple markers" feature
(described on page 305) and try again with different parameter settings.

Displaying/Hiding MarkersDisplaying/Hiding Markers
• To hide/display the marker triangles from the ruler, click with the right mouse button in the ruler and

select Hide/Show markers.
• To hide the marker lines in the waveform, click with the right mouse button in the ruler and select

Elements. From the menu that appears, set things up so that neither Solid Markers, nor Dotted Markers
are activated.

Checking the name of a MarkerChecking the name of a Marker
1. Make sure Show Tips is activated in the Environment section of the Preferences dialog.
2. Move the mouse pointer over the marker triangle, and wait for a moment.

The name of that marker will appear.

Moving a MarkerMoving a Marker
• To move a marker, press the mouse button over the triangle "Head" and drag to the new position.
• Snap to zero crossing applies.
- If "Magnetize bounds" on the Options menu is activated, the marker "snaps" to the edges of the

selection, the cursor's position and the beginning and end of the wave.

Editing, Converting and Naming MarkersEditing, Converting and Naming Markers
The New Marker window can also be used to change existing marker’s properties. There are several ways
to open this window with settings for a certain marker:
- Right click on the marker in the time ruler and choose "Edit Marker" from the menu that appears.
- Hold down [Alternate] and double click on the marker.
- Open the Marker list, select a marker, click with the right mouse button on a marker and select Edit or

press [Return].
Operations in the dialog
- To transform a Marker into any other type, simply select that type in the list to the left.
- To rename a Marker, uncheck "Automatic naming" and type in your own name.
- To make sure that a CD Track End or boundary marker appear on an exact CD frame position, activate

the corresponding option.
- To lock the position of a marker so that it can’t be moved, activate the Lock Position option.
- If the marker is a Loop End marker you can change the number of repeats for the Loop by unchecking

Infinite and specifying your own number of Loops.
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Deleting MarkersDeleting Markers
When you delete one marker in a marker pair, the other marker will also be deleted.
Deleting one Marker from the Wave window
1. To delete a marker in the wave window, click with the right mouse button on the head of marker you

want to delete/rename.
2. Select Delete.

Alternatively you can drag the marker out of the window.
Deleting in the Marker List
1. Double click in the ruler.

The marker window appears.
2. Click with the right mouse button on the marker you want to delete/rename.
3. Select Delete.
Deleting all Markers of a Certain Type
1. Click with the right mouse button on the time ruler.
2. Select Delete Multiple Markers.
3. Activate the Marker types that you want to delete.
4. Click OK.

Operations Involving MarkersOperations Involving Markers
Setting the Wave Cursor to a Marker position
To move the wave cursor to a certain marker, do one of the following:
- Double click on the marker triangle.

This is probably the most convenient option if the Marker is currently visible in the window. This even
works during playback!

- Double click in the ruler, select one of the markers in the list that appears, and click Close.
This is probably the most convenient option if the Marker is outside the current view.

- Activate "Magnetize bounds" on the Options menu. Click on the ruler close to the Marker, or drag the
cursor to a position close to the Marker.

Browsing markers
You can move the wave cursor from marker to marker by:
- Clicking the arrow button on the Marker Toolbar, or...
- By using the keys [4] and [5] on the numeric key pad.
Starting Playback from a Marker
There are several ways to make playback start from a certain marker:
- Locate to a marker, as described above, and activate playback from there.
- Double click on a Marker in the Marker list.
- Select one of the marker related options on the Transport (see page 135 for details).
Selecting between Markers
- To select all audio between two adjacent markers, double click between them.

To extend the selection to consecutive markers, continue dragging to the left/right.
- To select all audio between any two markers, double click just to the right of the leftmost one, hold

down [Shift] and double click just to the left of the rightmost one.
Dropping on Markers (Magnetize bounds)
For any operation involving drag and drop of audio material you can use a marker position as start point
for the section you drop. This is useful when it is very important that the dropped material is inserted at a
very specific position.
1. Make sure Magnetize bounds (on the Options menu) is activated.
2. Drag the selection, and position the mouse pointer close to a marker line.

The "drag line" snaps to the marker line.
3. Make sure the marker line and the drag line appear on top of each other, then release the mouse button.
Creating CD Tracks
All operations related to CD markers are described in the topic Working with CD Markers.
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Looping
Loop Markers are primarily intended for setting up loops in material that you transfer to samplers (see the
topic about the Crossfade Looper) but you can use Loop Markers in various additional ways:
- Set up a Loop and repeat it indefinitely during playback, while editing material inside the Loop.
- Set up a loop with a specified number of repetitions, to check out how a repetition effect will sound.
- Note that you can nest Loops, that is you can have Loops inside Loops.
Skipping Regions
The Start and End Mute markers denote regions that should be skipped.
- To Skip a Mute region on playback, select "Skip Muted regions" on the Transport.

This can be very useful in conjunction with looping. Loop a section and adjust the Mute markers during
playback until the desired section is skipped.
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Work with Audio MontagesWork with Audio Montages

IntroductionIntroduction

About the Audio MontageAbout the Audio Montage
The Audio Montage is a multi-track non-destructive editing environment, which allows you to arrange,
edit, play back and record audio Clips on multiple Tracks. Featuring Clip-based effects, volume and pan
automation, wide-ranging fade and crossfade functions, real-time metering, direct creation of CDs and
synchronization to MIDI Time Code, the Audio Montage is a great tool for music CD creation, mastering,
multimedia work, radio spot production, etc.
- WaveLab’s Audio Montage is not a "multi-track tape machine emulator". Rather you should think of it

as an audio editing system, or a "workbench" for assembling multi-track audio pieces.

Basic TerminologyBasic Terminology
The Montage can contain an unlimited number of stereo or mono Tracks. These provide a way for the user
to structure the work graphically, but should not be viewed as "virtual tape tracks".
On a Track, you can place any number of Clips. These are "containers" for the audio, and include a
number of settings and functions such as Clip Effects (up to ten per Clip), volume and pan curves, fades,
etc.
Each Clip contains a reference to a source audio file on your hard disk, as well as start and end positions in
the file (allowing Clips to play back smaller sections of their source audio files. Several Clips can reference
the same file.

The Audio Montage WindowThe Audio Montage Window

About Panes and ViewsAbout Panes and Views
The Audio Montage window is divided into two "Panes". The Lower Pane always shows the Tracks and
the Clips, while the Upper Pane shows one of 11 Views, as listed below.
- You can resize the Upper and Lower Panes by dragging the divider between the Panes.
- You can choose to view the Upper Pane or the Track View only, by selecting "Show tabs only" or

"Show Tracks only" from the main View menu.
To revert to the standard view (showing both Panes), pull down the View menu again and de-select the
selected option.

- You select Views for the Upper Pane by clicking the tabs at the top of the Montage window, or by using
key commands (see below).
Apart from the actual displays, the different Views may have different menus and icon bars.
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The following Views are available (clicking a View Name in the column will take you to the relevant help
section):
ViewView KeyKey DescriptionDescription
Edit E Contains an Overview display, for quick zooming and navigating through the

Montage. This is also where you find various options for editing, fading, selecting, etc.
Zoom Z Displays a very detailed view of the focused Clip’s fade-in area, for fine editing and

phase matching of adjacent Clips.
Clips C This View contains a list of all Clips in the Montage, allowing numerical editing and

adjustment.
Groups O Use this View for Grouping Clips that you want to select as one entity.
Files L Contains various tools for audio file management, including direct import of Clips and

audio files into the Montage.
Markers M This View allows you to add and manage Markers in the Montage. This includes CD

Markers, for writing CDs directly from the Audio Montage.
CD D This is where you prepare for writing a CD directly from the Audio Montage.
Meters R Displays detailed level, phase and spectrum meters.
History Y This is a list representation of the Undo History, allowing you to Undo/Redo several

operations in one go.
Snapshots P Allows you to capture magnification and view settings as Snapshots, to be able to

quickly select different views.
Notes A standard notepad.

- If the Montage Window is too narrow to show all tabs, two arrow buttons are displayed in the upper
right corner of the window.
Use these to "move" the row of Tabs so that you can see and click on the one you want.

About Naming in the Help
Most of the Views contain one or several menus. To make it clear which menu the help text refers to in
each case, we use the following syntax:
X View : Y Menu
For example, "Edit View : Options Menu" means the Options Menu in the Edit View.

The Info LineThe Info Line
The Info Line is the dark area below the Track View. It indicates what will happen when you click the
mouse buttons (with or without modifier keys), depending on where you currently aim the pointer (much
like Tool Tips for buttons). This is especially useful since editing in the Audio Montage is based on Mouse
Zones - you click in different areas of the Clips to perform different actions.
The Info Line will also display positions and lengths when you are moving, copying or resizing Clips.
Showing and Hiding the Info Line
1. Select the Edit View by clicking the Edit tab.
2. Pull down the Edit View : Options menu.
3. Activate or deactivate the option "Show Info Line".
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Info Line Symbols
The following symbols are used in the Info Line (the symbols for [Shift], [Ctrl] and [Alt] may differ
depending on the language selected for WaveLab):

Symbol:Symbol: Description:Description:

Indicates that you can right click to display a Context menu. The name of the
Context menu is displayed after the M symbol.

Indicates what happens if you single click.

Indicates what happens if you double click.

This means that you can [Ctrl]-click for an additional function. Press [Ctrl] for
more information.

This means that you can [Shift]-click for an additional function. Press [Shift] for
more information.

This means that you can [Alt]-click for an additional function. Press [Alt] for
more information.

C/S/A combinations Indicates that you can use combined modifier keys. For example, "CS" means that
you can [Ctrl]-[Shift]-click for an additional function. Hold down the indicated
modifier keys for more information.

Indicates what happens if you click and drag up or down.

Indicates what happens if you click and drag left or right.

Indicates what happens if you click and drag the item (in any direction) within the
Montage.

Indicates what happens if you click and drag the item out of the Montage.

This is shown as an alert indicator, when you are moving or resizing Clips or
changing envelope values, etc.

The RulerThe Ruler
At the top of the Track View in the Audio Montage window, there is a Ruler, similar to that in the Wave
windows.
- To change the Ruler format, right-click in the Ruler and make a selection from the pop-up menu that

appears.
Depending on the selected format, you can make detailed display settings by selecting "Time format..."
from this pop-up menu.

- It is also possible to offset the Ruler, so that "zero" is somewhere other than at the actual start of the
Montage (this is done by selecting "Time offset...").

- When you move and edit Clips, you can choose to snap to the ruler positions.
This is described in the topic Magnetic Bounds.

The Time Grid
If you like, a "grid" can be displayed in the Track View, consisting of vertical lines at every labeled position
in the Ruler. To show or hide the grid, right-click in the Ruler and activate or deactivate the Show Grid
option on the pop-up menu.
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Assembling the MontageAssembling the Montage

Creating a new MontageCreating a new Montage
1. Pull down the File menu and open the New submenu.
2. Select the "Audio Montage..." item.

The Audio Attributes dialog appears.
3. Specify the preferred sample rate.

The audio files that you want to use in the Montage must have this sample rate. The Channels and Bit
Resolution sections are greyed out, since the Audio Montage supports both stereo and mono audio, as
well as multiple bit resolutions.
If you plan to burn a CD from the Audio Montage, you need to select 44.1 kHz sample rate.

4. Click OK.
A new Audio Montage window appears, containing one stereo Track.

- If you have saved a Montage Template, the new Audio Montage will automatically take on all
properties of the template. In that case, the Audio Attibutes dialog will not automatically be displayed
(since the new Montage will use the sample rate saved in the template). To change the sample rate, you
will need to select "Edit Audio Attributes" from the File menu.

Handling TracksHandling Tracks
Creating and Managing Tracks is done in the area to the left of the Tracks in the Track View (from now on
called the Track Control area). In the middle of this area is a button with the number of the Track. Clicking
this button brings up the Track Menu, which contains most of the Track functions.
Adding Tracks
1. Click on the Track Number button for a Track next to where you want to add a new Track.

The Track Menu appears.
2. Select one of the Insert functions at the top of the menu.

You can choose whether you want to insert the new Track above or below the current Track, and
whether the new Track should be mono or stereo.

Moving Tracks
To move a Track up or down in the Track View, proceed as follows:
1. Click on the Track Number button for the Track that you want to move.

The Track Menu appears.
2. Select Move Track Up or Move Track Down.
Deleting Tracks
To remove unwanted Tracks, proceed as follows:
1. Click on the Track Number button for the Track that you want to delete.

The Track Menu appears.
2. Select Delete Track.

If there are Clips on the selected Track, you will be asked whether you really want to delete the Track.
Click OK to proceed.

Deleting a Track with Clips will also delete the Clips! However, the audio files to which the Clips refer will
not be affected. Also remember that you can recover accidentally deleted Clips by using the Undo function.
Splitting Tracks
You can split a stereo Track into two mono Tracks:
1. Click on the Track Number button for the Track that you want to split.

The Track Menu appears.
2. Select Virtual Split as two Mono Tracks.

The Track is split. If the Track is empty, this will simply be the same as deleting the Track and inserting
two new mono Tracks. However, if there are Clips on the Track, the two stereo sides will now be
separate Clips, allowing you to move, edit or process them independently.
Note that this is a "virtual" split - no audio files are affected or created.

Folding Tracks
To save screen space, you can fold Tracks that you don’t need to have visible. This is done by clicking the
arrow button at the top left corner of the Track Control area.
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Cloning Tracks
The Clone Track function on the Track Menu creates a duplicate of a Track and all its Clips, and inserts it
below the original Track.

Adding Clips to the MontageAdding Clips to the Montage
You create Clips by copying audio selections from Wave windows, audio files directly from your hard disk,
or selections from other Montages into the Audio Montage. There are several ways to do this:
- By dragging a selection from a Wave window (or a selection range from a Montage) and dropping it on

a Track in the Montage.
If you want to drag the whole audio file from the Wave window to the Audio Montage, you don’t need
to make a selection first. Instead you can click on the purple Document button at the upper right corner
of the Wave window and drag it to the Montage.

- By copying a selection from a Wave window (using Copy on the Edit menu, or [Ctrl]-[C]) and pasting it
into the Montage (using Paste on the Edit menu, or [Ctrl]-[V]).
Make sure you click at the desired insert position on the desired Montage Track before you paste.

- By dragging files from the Files View onto the desired Track in the Montage.
When the "System" tab is clicked in the Files View, the Montage Upper Pane serves as a file browser,
listing the available audio files (or Clip files) on your hard disks. You navigate in this View much like
you do in the Windows Explorer.

- By importing a file directly from disk.
This is similar to the previous option, in that the resulting Clip will make reference to a whole file, not
only a selection. There are two ways to import files: either right click on the desired Track and select
"Insert file..." from the pop-up menu that appears, or select "Add files at cursor..." on the Files View :
File menu. In both cases, a file dialog appears, allowing you to locate the audio file. Note that the audio
file will be inserted at the Montage Cursor position!
If you import several audio files at the same time, a corresponding number of new Clips are added,
ordered alphabetically after the file names and spaced according to the Default Pre-gap time (set on the
Edit View : Options menu).

- By Copying Clips from another Montage.
If you have more than one Montage open, you can copy Clips from one Montage to another. This can
be done either by using drag and drop or by using Copy and Paste. You can also use this method to
copy Clips within the same Montage.
When dragging or selecting Clips, you need to click at the appropriate Mouse Zone.

Note:
- You cannot add a mono Clip to a stereo Track or vice versa. Also, you need to make sure that the

Clip’s audio file is of the same sample rate as the Audio Montage, or the Clip will play back with the
wrong pitch.

- If you are adding a single Clip (regardless of which of the above methods you use), a pop-up menu will
appear, allowing you to select one of the Insert Options.

- If you are adding several Clips at the same time, the options "Track Auto-Grouping" and "Global Auto-
Grouping" affect the result in the following way:
If any of the Auto-Grouping options are activated in the Edit View, Clips to the right of the insertion
point will be moved to the right to "make room" for the inserted Clips. With "Track Auto-Grouping",
only Clips on the same Track will be moved; with "Global Auto-Grouping", Clips on all Tracks are
affected.

- If you add Clip from a selection of an audio file, the original Wave window does not have to remain
open. Should you need to edit the original (source) audio file, you can access it from the Clip context
menu (the "Edit" function on the Source sub-menu).

- When you insert Clips, the following options are taken into account:
Create default fades in new Clips.
Snap to waveform when crossfading.
Create optimized crossfade when snapping to other Clip.
Snap to fade-in/out when snapping to other Clip.
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Zooming and NavigatingZooming and Navigating

ZoomingZooming
There are several ways to change the magnification of the Montage Track View:
Using the Horizontal and Vertical Zoom Controls
The Zoom "levers" in the upper and lower right corners of the Montage window work just like in the Wave
Windows. There is one thing to note:
- Changing the Vertical Zoom does not affect the height of the Tracks.

Rather, it affects the vertical magnification of the waveforms within each Clip.
Zooming in the Ruler
As in the Wave windows, you can adjust the horizontal zoom by clicking in the Ruler and dragging the
pointer up or down with the mouse button pressed. Drag up to zoom out and drag down to zoom in.
- If you hold down [Shift] while zooming this way, the Montage Cursor position isn’t affected.
Changing the Height of Tracks
The height of the Tracks (and thereby the number of Tracks displayed in the Montage window) is governed
by the Track Magnification controls in the lower right corner of the Montage window.
- Click on the large Magnifying Glass icon to "zoom in" - increase the height of the Tracks.

This is the same as displaying one Track less. When only one Track is displayed, this icon will be
greyed out.

- Click on the small Magnifying Glass icon to "zoom out" - decrease the height of the Tracks.
This is the same as displaying one Track more. When all Tracks are visible, this icon will be greyed out.
Consequentially, if the Montage only contains one Track, both Magnifying Glass icons will be greyed
out.

- You can also Zoom in on a single Track, making it fill the window.
This is done by clicking the numbered button to the left of the Track to bring up the Track Menu, and
selecting "Zoom".

Zooming with the Rubber Band Tool
1. Click the Magnifying Glass icon in the top left corner of the Track View.

The pointer takes on the shape of a "four-way arrow" with a magnifying glass.
2. Click and drag a rectangle in the Track View, to indicate the section you want to zoom in on.

When you release the mouse button, the Track View is magnified, so that the section in the rectangle
fills out the display. Note that the magnified View will include any Tracks fully or partially enclosed by
the rectangle.

3. Deactivate the Rubber Band tool by clicking the icon again, or by right-clicking anywhere in the Track
View.

- It is also possible to temporarily select the Rubber Band tool, by holding down [Control] and aiming in
an empty area of the Track View (or in a Mouse Zone used for Range Selection).

Zooming in on a single Clip
If you want to study a Clip in detail, you can zoom in on it so that it fills up the Track display:
1. Point at the Clip.

Make sure you don’t aim at an Envelope curve.
2. Click with the right mouse button.

The Clip Context Menu appears. This contains various Clip-based functions and settings.
3. Select "Zoom", and from the sub-menu that appears, select "Whole Clip".

The Track View zooms in on the Clip.

Zooming and Navigating in the Edit OverviewZooming and Navigating in the Edit Overview
When the Edit View is selected (by clicking the Edit tab at the top of the window), the Upper Pane shows
an Overview of the Montage, with Clips displayed as boxes. You can use this Overview to zoom in or out,
and for navigating to other sections of the Montage. This is done by moving and resizing the black Track
View Rectangle in the Overview. This rectangle indicates the section of the Montage currently displayed in
the Track View.
- You can zoom in or out, vertically or horizontally, by resizing the Track View Rectangle.
- Resizing is done by dragging the edges of the Rectangle.
- You can also resize the Rectangle horizontally by holding down [Shift] and clicking. This will instantly

move the closest edge of the Rectangle to the position where you clicked.
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- You can drag the Track View Rectangle to view other sections of the Montage.
- Clicking on one of the Clip boxes outside the Track View Rectangle will make the Track View zoom in

horizontally on that Clip.
The number of Tracks shown will not change.

- Double clicking on one of the Clip boxes in the Overview will make the Track View zoom in
horizontally and vertically on that Clip.

- Right clicking anywhere in the Overview will make the Track View zoom out, so that the whole Audio
Montage is visible.
The Key Command for this is [J].

- To identify a Clip in the Overview, position the pointer over its box.
The name of the Clip is displayed.

Moving the Montage CursorMoving the Montage Cursor
To move the Montage Cursor, you can either click at the desired position, use the Transport Bar or use the
computer keyboard.
- You can click in the Ruler or in an empty section of the Montage.

It is also possible to set the Montage Cursor position by clicking within a Clip, but you have to make
sure you click in the Mouse Zone used for selecting ranges.

- The buttons on the Transport Bar work as in the Wave windows.
The Fast Forward and Rewind buttons scroll the Playback Position forwards or backwards, while the
Start and End buttons move the Playback Position to the start or end of the Montage.

- The left and right arrow buttons on the computer keyboard can be used to move the Montage Cursor in
fine steps.
If you hold down [Control] and press the left or right arrow button, the Montage Cursor will jump to
the nearest Clip edge (start or end position of a Clip). It is also possible to move the Cursor by using the
Page Up, Page Down, Home and End keys.

Using SnapshotsUsing Snapshots
To make it easy to quickly move between different views and zoom levels, you can capture view settings as
Snapshots, and apply these at any time. This is done in the Snapshots View (selected by clicking the
Snapshots tab at the top of the Montage window).
A Snapshot contains the following settings:
- The horizontal and vertical magnification.
- The section (horizontal and vertical) of the Montage currently shown in the Track View.
- The Montage Cursor position.
- The current Selection Range (if any).
Capturing the Current View
1. Set up the view as desired.
2. Click the black camera icon, or select "Capture current settings" from the Snapshots View : Functions

menu.
A new Snapshot is added to the list.

Updating Snapshots
You can update an existing Snapshot to contain the current settings, in the following way:
1. Set up the view as desired.
2. Select the Snapshot you want to update, by clicking on it in the list.
3. Click the blue camera icon, or select "Update selected snapshot with current settings" from the

Snapshots View : Functions menu.
Editing Snapshots in the List
You manage the Snapshot list and edit the settings using the standard Wavelab list editing techniques:
- Hide and show columns using the columns pop-up menu (accessed by clicking the arrow button to the

left of the list columns).
- Reorder or resize columns by dragging in the headings.
- Sort the Snapshots by clicking in a column heading.
- Rename a Snapshot by double clicking on its name and typing.
- Edit other values by using regular value editing techniques.
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The columns have the following functionality:
ColumnColumn DescriptionDescription
Name The name of the Snapshot.
View When this checkbox is activated, the stored View (Zoom factor and visible area) is included

when you apply the Snapshot.
Cursor When this checkbox is activated, the stored Montage Cursor position is included when you

apply the Snapshot.
Position The stored position of the Montage Cursor.
Selection When this checkbox is activated, the stored Selection range is included when you apply the

Snapshot.
From The start position of the Selection range.
To The end position of the Selection range.
Length The length of the Selection range.

Applying a Snapshot
1. Make sure the desired checkboxes are activated for the Snapshot.

As described in the table above, these govern whether the View, Montage Cursor position and/or
Selection range are to be affected when you apply the Snapshot.

2. Click the numbered button to the left of the Snapshot in the list, or select the Snapshot and select
"Apply selected Snapshot" from the Snapshots View : Functions menu.

Deleting Snapshots
To delete a Snapshot, select it and click the trash can icon, or select "Delete selected Snapshot" from the
Snapshots View : Functions menu.

Undoing View and Position changesUndoing View and Position changes
There is a separate "Undo History" for Zoom, View and Position changes in the Audio Montage. This
allows you to Undo one or several changes, in the following way:
- To Undo the latest change to the View, click the green left arrow at the top left corner of the Track View

(or press [<] on the computer keyboard).
You can repeat this as long as there is any change to Undo (as long as the green left arrow is lit). This
Undo History includes changes to Zoom, View, and Montage Cursor position.

- To Redo an Undone View change, click the yellow right arrow at the top left corner of the Track View
(or press [Shift]-[<] on the computer keyboard).

Maximizing the width of the Audio MontageMaximizing the width of the Audio Montage
If you click the double arrow icon at the top left corner of the Track View, the Audio Montage window is
enlarged horizontally to fill the whole screen.

Playback and RecordingPlayback and Recording

Montage Playback - BasicsMontage Playback - Basics
Playback in the Audio Montage works in much the same way as in the Wave windows, i.e. you use the
Transport Bar or the corresponding key commands. There are some extra things to note:
- The audio is normally routed through the Master Section.

This allows you to add global effects to the Audio Montage or use the Apply function to create a
mixdown audio file, or an intermediary CD program (see The Apply Function).
You can also choose to route the audio from a Track to the nearest Track above, for use with effects
that allow modulating audio inputs (such as side-chain compressors, duckers, etc.).
The routing is is done using the "Route to" options on the Track menu.

- The Loop settings on the Transport bar apply as in the Wave windows.
If the "Loop Selection" mode is selected, playback will loop within the boundaries of the current
selection range. This selection range may be on any Track - you can even make a "selection" on an
empty Track. This vertical position of the selection range is of no relevance for Loop playback, only the
left and right selection boundaries matter.
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Mute and SoloMute and Solo
You can Mute or Solo Tracks in the Montage by using the corresponding buttons in the Track Control
area:
- The Mute button is the round one. It is green for unmuted Tracks and grey (unlit) for muted Tracks.
- The Solo button is the diamond-shaped one. It is blue (lit) when a Track is soloed.

The Solo buttons are exclusive, that is, Solo can only be activated for one Track at a time. However,
you can manually unmute other Tracks when Solo is activated, if you want to listen to a combination of
Tracks.

Muting Individual Clips
You can mute an individual Clip by right-clicking on it to bring up the Clip context menu, and selecting
"Mute" from the menu. Muted Clips are shown with another color (by default "greyed out").
- To unmute the Clip, bring up the Clip context menu again and uncheck the "Mute" item.
- To mute or unmute all selected Clips, pull down the Edit View : Select menu and select "Mute/Unmute

all selected Clips".
- It is also possible to Mute a selection range within a Clip, using the Volume Envelope. See Muting a

Selected Range of the Clip.

Playing back individual Clips and SelectionsPlaying back individual Clips and Selections
When editing and rearranging the Audio Montage, it can be useful to be able to audition the individual
Clips and selections. This is done using the three "Play" items on the Clip context menu:
- "Play Clip" plays back the Clip you clicked on.
- "Play Clip Selection" plays back the current selection range only (this is only available if you have made

a selection range in the Clip).
- "Play (with Pre-roll)" plays back the Clip you clicked on, starting slightly before the Clip. The Pre-roll

time is set with the "Playback pre-roll time" parameter on the CD-R tab in the Preferences dialog.

Playing all Tracks within the current Selection RangePlaying all Tracks within the current Selection Range
If you have made a selection range, you can play back the Montage within this range only. This is a quick
way to listen to a short section of the Montage:
1. Drag with the mouse to create the selection range, either in a Clip or in an empty section of a Track.
2. Right click in the Ruler to bring up the Ruler  pop-up menu.
3. Select "Play selection" from the pop-up menu, or press [F6].

All unmuted audio within the selection range is played back.
When you use this playback method, the Loop settings on the Transport Bar are disregarded. To play back
the selection in a loop, press [Shift]-[F6].

Using the Shuttle FunctionUsing the Shuttle Function
The Shuttle function can be viewed as playing back with a continuous control for tape speed and direction.
This works in the same way in the Audio Montage as in the Wave Windows:
1. Activate the Jog/Shuttle button on the Transport Bar (or press [F10]).

A vertical line is displayed in the middle of the Audio Montage window and the pointer takes on the
shape of a speaker.

2. Click and hold the mouse button to the left or right of the vertical line.
Clicking to the left of the line will play back the audio backwards. The playback speed is determined by
the distance from the line to the pointer, so that the further away from the line you move the pointer,
the faster the playback.

- The playback speed is indicated in the Info Line.
- "1.00" is normal playback speed. Negative values indicate reverse playback.
3. Release the mouse button to stop playback.
4. Remember to deactivate the Jog/Shuttle button on the Transport Bar when finished (by clicking the

button, pressing [F10] or using Stop).
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Using the Jog FunctionUsing the Jog Function
The Jog function can be viewed as dragging the audio past a "playback point", much like dragging a reel-to-
reel tape past the playback head. This is done in a different way than in the Wave window:
1. Click the Jog/Shuttle button on the Transport Bar or press [F10].

A vertical line appears in the middle of the Wave window. This is the "playback point". Furthermore,
the area above the Ruler turns purple.

2. Point in the purple area above the Ruler.
3. Click and drag to the left or right to drag the audio past the playback point.

The audio is played back, forwards (if you drag the audio to the left) or backwards (if you drag to the
right), at the speed with which you drag.

4. Remember to deactivate the Jog/Shuttle button on the Transport Bar when finished (by clicking the
button, pressing [F10] or using Stop).

Playing back from the RulerPlaying back from the Ruler
You can use the Ruler to quickly locate to a position and start playback from there:
- Double clicking in the Ruler starts playback from that position.

Playback continues until you press Stop (or until the end of the Montage).
- If you double click in the Ruler and keep the mouse button pressed, playback will start from that

position and stop when you release the mouse button.
After stopping, the Montage Cursor will return to the position where you clicked. This is a handy way
to quickly locate and audition positions in the Montage.

- If you single click in the Ruler during playback, playback will immediately jump to that position.
This even allows you to "jump" between different document windows.

The MetersThe Meters
When the Meters View is selected, the Upper Pane in the Montage window displays meters for measuring
the level, spectrum or phase of the playback signal  (measured at the output of the Master Section).
For details, click the yellow question mark icon in  the Meters View.

Recording in the MontageRecording in the Montage
Although the Audio Montage isn’t a "multi-track tape recorder emulation", it is possible to record audio
and have it appear directly as a Clip in the Audio Montage. There are several ways to initiate recording
from the Montage:
By using the Track Menu
1. Move the Montage Cursor to the position where you want the recorded Clip to appear.
2. Pull down the Track menu for the desired Track and select Record at cursor.

The Record dialog appears. The option "Add to focused Track of current Montage" is automatically
activated, and stereo or mono is automatically selected depending on the selected Track.

3. Proceed as when recording into a Wave window (see Basic Recording Procedures).
When you finish recording, a Clip is created at the cursor position.

By using the Track Menu during Playback
For this to be useful, you probably want to hear the existing Tracks play back during recording. This
requires that your audio card supports Full Duplex operation (meaning that the card must allow
simultaneous recording and playback). Consult the audio card’s documenation if you are uncertain.
1. Start playback.
2. Pull down the Track menu for the desired Track and select Record at cursor.

The Record dialog appears as in the previous example.
3. Make settings as when recording into a Wave window (see Basic Recording Procedures).

For existing Tracks to play back during recording, the option "Stop playback when metering or
recording" must be deactivated in the Record Settings dialog (see the context sensitive help). If it is
activated, you will be asked whether you want WaveLab to turn it off for you before starting recording.

4. Activate recording.
The Clip will be inserted at the position where the Montage Cursor was the moment you activated
recording. If you first go into Pause mode and then activate recording, you will get a "pre-roll" time
according to the Pause Buffer in the Record Settings dialog (see the context sensitive help), allowing
you to capture the audio just before you start recording.
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By using the Record Button
1. Select a Track by clicking on its Track Control Area.
2. If you like, activate playback.
3. Click the Record button on the Transport Bar or press [*] on the numeric keypad.

The Record dialog appears.
4. Make sure the checkbox "Add to focused Track of current Montage" is activated.
5. Proceed as when recording into a Wave window.

When you finish recording, a Clip is created at the Cursor position, or if playback was activated, at the
position where the Montage Cursor was the moment you activated recording.

Things to Note:
- Make sure you select a stereo Track if you want to do a stereo recording and vice versa.
- If "Create Temporary File" is selected when you record, the Clip will refer to an untitled, unsaved

"invisible" file.
If you try to save a Montage with references to temporary files, WaveLab will ask you to save these files
(since the program needs to know the file names, for proper reference).

About Monitoring the Recorded Signal
WaveLab in itself does not handle monitoring (routing the input signal back to the output) during
recording. If you want to hear the signal you are recording, there are two ways to achieve this:
- Use an external mixer.

Normally you would connect your audio input sources (including the audio card’s outputs) to the
mixer’s inputs, connect the mixer’s main outs to the monitoring equipment and use an auxiliary send or
buss to send the desired channels to the audio card’s inputs, for recording in WaveLab. This is
necessary to avoid including background Tracks in the recorded signal.

- Use the audio card’s mixer application.
Many audio cards allow you to route the input signal back to the outputs. Consult the documentation of
the audio card for details.

Rearranging ClipsRearranging Clips

About the Mouse ZonesAbout the Mouse Zones
Basic rearranging of Clips in the Audio Montage is done by clicking and dragging with the mouse.
However, the results of dragging with the mouse depend on where in the Clip you click. The different areas
in a Clip are called Mouse Zones.
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By default, the Mouse Zones have the following basic functionalities:

Mouse ZoneMouse Zone FunctionFunction
Top Clip area Copy Clip by dragging and Splitting the Clip by double clicking.
Upper Clip area Make a selection range.
Lower Clip area and
Bottom Clip area Select Clips and move Clips by dragging.
Upper Clip edges and
Lower Clip edges Resize Clips by dragging the edges (keeping the audio source "static").

As you see, some Mouse Zones have the same default functionality. You can change this if you like, using
the Mouse Zones submenus on the Edit View : Options menu:
- When you move the pointer over a Mouse Zone, the Info Line indicates the corresponding action(s),

and also indicates whether you can perform additional functions by holding down modifier keys.

Magnetic BoundsMagnetic Bounds
When you move and edit Clips, it is often useful to have them snap to other Clips as well as to significant
positions in the Montage. To facilitate this, you can specify that certain positions should be "magnetic".
This is done on the Magnetic Bounds submenu on the Edit View : Options menu. The following items and
positions can be magnetized:
OptionOption DescriptionDescription
Start of Montage The start of the Audio Montage.
Clips’ cue-point A position within a Clip that you set using the Clip context menu (see Using Cue

Points).
Clips’ head The start of a Clip.
Clips’ tail The end of a Clip.
Time units The time units displayed in the Ruler (the same as the positions of the grid lines when

the Time Grid is activated). The coarseness of these units is determined by horizontal
magnification. For more information about the Ruler and the grid, see The Ruler.

Montage Markers Markers in the Audio Montage window.
Source Markers Markers in the original audio files that the Clips refer to.
Selection Edges The start and end of a selected range in the Audio Montage.
Cursor The Montage Cursor position.

Activating Snap
Having set up the desired Magnetic Bounds options, you activate the Snap function by clicking the "Enable
Snapping" icon in the Edit View (or by pressing [N] on the computer keyboard). Now, when you move or
resize a Clip and its edges (or its cue-point) get close to one of the Magnetic positions, two things happen:
- The Clip snaps to the Magnetic position.
- A label is displayed, indicating what the Clip snaps to.
To deactivate Snap, click the icon again or press [N].

Selecting ClipsSelecting Clips
To select a Clip (for copying, deletion, etc), click in the Mouse Zone to which "Select/Move Clip" is
assigned (by default the Bottom Clip area).
- Selected Clips are normally displayed in a different color. You can edit this color, as described in the

topic Defining Custom Colors.
- You can select multiple Clips by [Ctrl]-clicking.

This works in the same way as selecting multiple objects in other Windows programs.
- Holding down [Shift] and clicking allows you to select a range of consecutive Clips (on the same

Track).
Again, this is similar to how you select ranges of objects in other Windows programs. Don’t confuse
this with making a "selection range" as described below.

- If you hold down [Ctrl] and [Shift], you can click and drag a selection rectangle to select several Clips
on several Tracks.
All Clips touched or enclosed by the rectangle are selected.
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Using the Select Menu
On the Edit View : Select menu, there are several items for selecting Clips. For details, use the context
sensitive help for the menu (by moving the pointer over a menu item and pressing [F1]).
About Selected and Focused Clips
The program makes a difference between selected and focused Clips:
- A selected Clip is a Clip you have selected using the any of the procedures described above.

Several Clips can be selected at the same time.
- The focused Clip is the Clip you selected (or clicked on, or edited) last.

Only one Clip can be focused at a time. By default, the Focused Clip is distinguished by a highlighted
name label.

Selection RangesSelection Ranges
A selection range is a selected area on a Track. The selection range may be entirely or partially within a
Clip, or in an empty section of the Track. There are several uses for selection ranges:
- You can edit Clips using selection ranges. This involves cutting or erasing the selection, or trimming the

Clip to contain only the selection (see Resizing Clips).
- You can create a new Clip by dragging the selection range to another Track.
- You can open a Wave window with the range selected in the source audio file, by dragging the selection

range to the WaveLab desktop.
- You can play back the selection range only, either the whole Montage or just the Clip with the selection

range (see Playing all Tracks within the current Selection Range and Playing back individual Clips and
Selections).

- You can have the playback loop within the selection, by activating the Loop and selecting the "Loop
Selection" mode on the Transport Bar.

To create a selection range, click and drag with the mouse (in an empty area or over Clips) as when
selecting audio in the Wave windows. Note though, that if you create a selection range within a Clip,  you
must make sure that the pointer is in the Mouse Zone to which you have assigned the "Select Range"
function (by default the Upper Clip area).
- When you drag the mouse to create the selection range, the start and end position and the length of the

range are displayed in the Info Line.
- If you double click in the selection range Mouse Zone, a selection range is automatically created,

spanning the entire Clip or the area between the closest Markers (if there are any).
In the latter case, triple clicking will expand the selection range to the entire Clip. Furthermore, if you
double click and keep the mouse button pressed, you can drag the mouse to expand the selection range
in "blocks" (Clips or Marker areas).

- You can resize a selection range by [Shift]-clicking or dragging its edges, as in the Wave windows.
- To remove (deactivate) a selection range, click elsewhere in the Montage.

Moving ClipsMoving Clips
To move a Clip, proceed as follows:
1. If you want to move more than one Clip, you need to select these Clips first.
2. Position the pointer over the Clip, in the Mouse Zone to which you have assigned the "Select/Move

clip" function (by default the Lower Clip Area).
The pointer takes on the shape of a "four-way arrow".

3. Click and drag the Clip(s) in any direction.
- When you are moving the Clip(s), the Info Line displays the current start position of the Clip you are

dragging.
- The Clip(s) will snap to any activated Magnetic Bounds.
- If you move Clips sideways, the Auto-Grouping settings are taken into account, as described below.

If you move the Clip over another Track, Auto-Grouping is temporarily disabled until you release the
mouse button.

- If you click on a Clip, keep the mouse button pressed and then press [Shift], movement is restricted to
vertical.
This is useful if you want to move a Clip to another Track without accidentally changing its horizontal
position.

- You cannot move mono Clips to Stereo Tracks or vice versa.
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Moving with Auto-Grouping
There are two options on the Edit View : Options menu that affect the result when you move Clips
horizontally: Track Auto-Grouping and Global Auto-Grouping.
- If Track Auto-Grouping is activated when you move a Clip sideways, all Clips to the right of it on the

destination Track will be moved by the same amount.
- If Global Auto-Grouping is activated when you move a Clip sideways, all Clips to the right of it in the

whole Audio Montage will be moved accordingly.
Moving and Snapping to another Clip
If you line up Clips so that one Clip ends exactly where the next one starts (possibly using Magnetic
Bounds), the waveforms at the intersection point will probably not "match". Instead, there could be an
abrupt "jump" in level, which can give rise to audio artefacts such as pops and clicks.
To remedy this, activate the option "Create optimized crossfade when snapping to other Clip" on the Edit
View : Fade menu. When this is activated and you move a Clip so that its start snaps to the end of another
Clip, the following happens:
1. WaveLab scans the waveforms of the Clips within a short range, and attempts to find the position

where the waveforms of the two Clips best match.
This is the same automatic phase matching as in the Zoom view. You can specify how far into the Clips
the program should scan, by selecting a Search range on the Zoom View : Options menu.

2. The position of the Clip you moved is adjusted slightly, to achieve the best possible match between the
waveforms.
This creates a short crossfade.

Note that this function only applies when moving "from right to left", i.e. snapping the start of the moved
Clip to the end of the Clip to the left.
About Overlapping Clips
You can move Clips so that they overlap each other on the same Track should you so wish. Please note:
- The Tracks in the Audio Montage are polyphonic, which means that each Track can play back several

overlapping Clips at the same time.
- Overlapping Clips will be transparent, allowing you to see the underlying Clips and their waveforms.
- To select an overlapped (underlying) Clip, double click in the Mouse Zone to which "Select/Move

Clip" is assigned (by default the Bottom Clip area).
- There are Automatic Crossfading options that automatically adjust the Volume Envelope curves when

you overlap Clips. See Creating Crossfades

Duplicating ClipsDuplicating Clips
To make a copy of a Clip, proceed as follows:
1. If you want to copy more than one Clip, you need to select these Clips first.
2. Position the pointer over the Clip, in the Mouse Zone to which you have assigned the "Drag/Copy clip"

function (by default the Top Clip area).
3. Click and drag the Clip(s) in any direction.

While you are dragging the Clip(s), a dotted line indicates where the first of the copied Clips will end
up. The position is also indicated on the Info Line.

4. Release the mouse button.
If you dragged a single Clip, the Insert Options pop-up menu appears. Select one of the options to insert
the duplicate of the Clip. If you dragged more than one Clip, the duplicates are inserted, taking the
Auto-Grouping settings into account, as described below.

- The Clip(s) will snap to any activated Magnetic Bounds.
- You cannot copy mono Clips to Stereo Tracks or vice versa.
- You can also duplicate a whole Track, including all its Clips, by selecting Clone Track from the Track

Menu.
Duplicating with Auto-Grouping
If you are copying more than one Clip at the same time, the Auto-Grouping options on the  Edit View :
Options menu affect the result:
- If Track Auto-Grouping is activated when you duplicate Clips, all Clips on the destination Track, to the

right of the new copy, will be moved to the right, to "make room" for the new Clips.
- If Global Auto-Grouping is activated when you duplicate Clips sideways, all Clips to the right of the

new copy in the whole Audio Montage will be moved to the right in the same way.
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Repeating ClipsRepeating Clips
If you want to make more than one copy of a Clip, and line the copies up on the same Track, this is easiest
done with the Repeat Clip function:
1. If you don’t know the exact number of copies (clones) needed, but know roughly where you want the

last Clip in the row to be positioned, move the Montage Cursor there.
2. Right-click on the Clip to bring up the Clip context menu.
3. Select Repeat Clip...

The Repeat Clip dialog appears.
4. Either select the "Count" option and specify an exact number of clones, or select the "Repeat until

cursor" option.
5. Select one of the Placement options.

These determine how the repeated Clips should be spaced. For details, use the context sensitive help in
the dialog.

6. Click OK.
The copies are created. If you chose the "Repeat until cursor" option, the last Clip will start to the left of
the Montage Cursor.

Dragging Selections to create new ClipsDragging Selections to create new Clips
If you have made a selection range in a Clip, you can copy this to a new Clip, in the following way:
1. Create the selection range.

If the selection range covers more than one Clip, only the section belonging to the focused Clip will be
copied!

2. Position the pointer over the selection, in the Mouse Zone to which you have assigned the "Select
Range" function (by default the Upper Clip area).

3. Drag the selection to the desired position.
When you are dragging, the position of the pointer is displayed on the Info Line. Magnetic Bounds
apply, as when duplicating Clips.

4. Release the mouse button.
The Insert Options pop-up menu appears. Select one of the options to insert the new Clip.

- Envelopes and effects will not be included when you copy selection ranges.

Resizing ClipsResizing Clips
In this context, "resizing" usually means moving the start and end points of a Clip, so that more or less of
the original audio file is "revealed". However, in the Audio Montage there are two ways of doing this: with
the audio source "static" or "tied". These two methods are explained below.
As with other Clip operations, the Info Line indicates which function will be used.
Resize Clips (Static Audio Source)
This is the traditional way of resizing Clips, you simply move the start or end point to the left or to the
right:
1. Point at the left or right edge of the Clip.

By default, it doesn’t matter whether you click in the Upper or Lower half of the edge, but it is possible
to select either half for the alternate resize method, as described below.

2. Click and drag to the right or left.
The start and end positions and length of the Clip are displayed on the Info Line while you are
dragging.

- You cannot drag the edge of a Clip past the start or end point of the audio file it refers to.
- The Clip edges will snap to any activated Magnetic Bounds.
- When you drag the right edge of a Clip this way, the Auto-Grouping settings on the Edit View :

Options menu are taken into account.
As when copying Clips, this means that if Track Auto-Grouping is activated, all the following Clips on
the Track will be moved when you resize the Clip (so that the distance between the Clip’s right edge
and the next Clip on the Track remains the same.
If Global Auto-Grouping is activated, the same is true, but for Clips on all Tracks in the Audio
Montage.
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Resize Clips (Tied Audio Source)
When you resize a Clip using this method, the audio source is "tied" to the edge you are moving. This
means that the audio is "scrolled" at the other edge of the Clip.
1. Point at the left or right edge of the Clip, and press [Ctrl].
2. Click and drag to the right or left.

The start and end positions and length of the Clip are displayed on the Info Line while you are
dragging.

For example, let's say you move the right edge of the Clip to the right. As a result, the start point of the Clip
will refer to an earlier position in the audio file.
- Magnetic Bounds and the Auto-Grouping options apply as when resizing with static audio source.
- It is also possible to assign either the Upper of Lower half of the Clip edge to this alternate resize

method.
This is done on the Edit View : Options menu, by selecting "Resize Clip (tied audio source)" for the
Upper or Lower Clip edges on the Mouse Zones submenu. In this case, you don’t need to press [Ctrl] in
step one above, but you must take care to aim at the desired Mouse Zone (Upper or Lower) when you
resize the Clip.

Resizing by Trimming
If you need to remove unnecessary material at the beginning and end of a Clip, this can be quickly done by
Trimming:
1. Make a selection range within the Clip, encompassing the audio material you want to keep in the Clip.
2. Right click to open the Clip Context menu.
3. Select Trim to selection.

The Clip is resized to contain only the selected audio.

Sliding the Audio in a ClipSliding the Audio in a Clip
If you want to adjust the position in the audio file to which the Clip refers, you can do this by "sliding" the
audio within the Clip, without resizing it:
1. Position the pointer over the Clip, in the Mouse Zone to which you have assigned the "Select/Move

Clip" function (by default the Lower or Bottom Clip area).
2. Press [Ctrl] and [Alt].

The pointer takes on the shape of a double arrow.
3. Drag left or right to slide the audio source.
- It is also possible to assign a separate Mouse Zone to this function.

This is done on the Edit View : Options menu, by selecting "Slide audio source" for the desired Zone on
the Mouse Zones submenu. In this case, you don’t need to press [Ctrl]-[Alt] in step two above. Be
careful not to slide the audio by accident, though.

Moving a Clip with the Audio Source fixedMoving a Clip with the Audio Source fixed
This is the opposite of sliding the audio: this function moves the Clip in the Montage, but the audio source
remains fixed in position:
1. Position the pointer over the Clip, in the Mouse Zone to which you have assigned the "Select/Move

Clip" function (by default the Lower or Bottom Clip area).
2. Press [Shift] and [Alt].

The pointer takes on the shape of a box with arrows.
3. Drag left or right to move the Clip, "revealing" other sections of the "underlying" audio source.
- It is also possible to assign a separate Mouse Zone to this function.

This is done on the Edit View : Options menu, by selecting "Move Clip - source remains fixed" for the
desired Zone on the Mouse Zones submenu. In this case, you don’t need to press [Shift]-[Alt] in step
two above.

Splitting a ClipSplitting a Clip
You can split a Clip in two, using the following method:
1. Set the Montage Cursor to the position at which you want to split the Clip.
2. Position the pointer over the Clip, in a Mouse Zone for which you have activated the "Split at cursor

with a double click" function (by default the Top Clip area).
The cursor takes on the shape of a pair of Scissors.
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3. Double click.
The Clip is split in two. The two Clips will have the same name and settings. Envelopes and Fades are
converted, so that the two Clips play back as before.

- If the options "Create default fades in new Clips" is activated on the Edit View : Fade menu, a crossfade
is automatically created between the resulting left and right Clip.

- You can also split a Clip by setting the Montage Cursor and selecting "Split at Cursor" from the Clip
context menu, or by pressing [S] on the computer keyboard (in which case the focused Clip is split).

Cutting and Erasing sections of a ClipCutting and Erasing sections of a Clip
You can Cut or Erase a selection range within a Clip, by using the functions Cut selection or Erase
selection on the Clip context menu, or by selecting Delete or Erase selected range from the main Edit
menu.
Cutting
If you select Cut selection (or Delete on the main Edit menu), the selected range is removed, and the right
section of the Clip is moved to the left, to fill out the gap.
- If any of the Automatic Crossfading modes, or the option "Create default fades in new Clips" are active

on the Edit View : Fade menu, a default crossfade is created between the resulting two Clips, ensuring a
click-free, clean transition.
Furthermore, if "Snap to waveform when crossfading" or "Create optimized crossfade when snapping to
other Clip" are active on the Edit View : Fade menu, then the position of the right Clip will be adjusted
for the best possible phase match between the Clips (see Moving Clips).

- The Auto-Grouping settings on the Edit View : Options menu are taken into account.
This means that the following Clips (on the same Track or on all Tracks, depending on the selected
option) may be moved to the left  so that the gap between the Clips remains the same.

Erasing
Selecting Erase selection removes the selected range, resulting in two Clips with a gap between them.
- If "Create default fades in new clips" is activated on the Edit View : Fade menu, a default fade-in is

created for the right Clip, and a default fade-out for the left Clip.

Deleting ClipsDeleting Clips
There are two principal ways to delete a Clip:
- Right-click on the Clip to bring up the Clip context menu, and select "Delete clip".
- Select it, and press [Backspace].

Instead of using [Backspace], you can press the [Delete] key or select "Delete" from the main Edit
menu.

You must make sure there is no selection range before deleting - otherwise the range will be deleted instead
of the Clip. To ensure there is no selection range, press [Esc].

Locking ClipsLocking Clips
Sometimes it’s useful to lock a Clip, to prevent you from accidentally moving, editing or deleting it. This is
done in the following way:
1. Right-click on the Clip to bring up the Clip context menu.

Make sure you don’t click on the Envelope curve, as this will bring up the Envelope context menu
instead (see Editing Envelopes).

2. Select "Lock".
The Clip is now locked. This is indicated by the mouse pointer taking on the shape of a lock symbol,
whenever you move it over the Clip. The default color for locked Clips is green, but you can change this
if you like (see Defining Custom Colors).

- If you click on a locked clip, an alert will appear, telling you that the Clip is locked, and asking whether
you want to remove the lock.

Unlocking a Locked Clip
There are three ways to unlock a locked Clip:
- Click on the Clip, and click "Yes" when asked whether you want to remove the lock.
- Uncheck the checkbox in the Lock column in the Clip List View.
- Deactivate the Lock item on the Clip context menu.
To lock or unlock several Clips in one go, select the Clips and select "Lock/Unlock all selected Clips" from
the Edit View : Select menu.
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To be able to select locked Clips, you need to use a selection rectangle (by holding down [Ctrl] and [Shift]
and dragging with the mouse).

Using Cue PointsUsing Cue Points
A cue point is a defined position marker that belongs to a Clip. It may be positioned within or outside the
Clip. Cue points are displayed as dotted vertical lines.
When you move a Clip, its cue point will be magnetic to any edges, markers or positions activated on the
Magnetic bounds menu. There are several uses for this:
- Set the cue point at a "relevant" position in the audio and use it to align the Clip with other Clips, etc.
- Set the cue point before the start of a Clip, allowing you to position Clips in a row with pre-defined

spaces (by magnetizing the cue point to the end of the previous Clip).
- Set the cue-point at the fade-in or fade-out point of a Clip, making it easy to maintain defined fade

lengths when crossfading (see Creating Crossfades).
To set the cue point for a Clip, proceed as follows:

1. If you want to set the cue point at an arbitrary position, move the Montage Cursor to that position.
This may be within the Clip or outside it.

2. Right-click on the Clip to bring up the Clip context menu.
3. Select one of the functions on the Cue point submenu:
4. 
OptionOption DescriptionDescription
Set at cursor Sets the cue point at the current Montage Cursor position.
Follows fade-in end point Sets the cue point at the Clip’s fade-in junction point (the left purple

handle in the Volume envelope). The cue point will follow the handle if
you move it. See Creating Fades.

Follows fade-out start point As the previous option, but for the fade-out start point.
Set at default pre-gap position Sets the cue point before the start of the Clip, at a distance governed by

the default pre-gap position (set on the Edit View : Options menu).

- Each Clip can only have one cue point. This means that if you repeat the procedure above and select
another option on the submenu, the cue point will be moved to a new position.

NudgingNudging
The Audio Montage window has a special function for making fine adjustments, or "nudging". The Nudge
function is not restricted to the position of Clips; it can be applied to a number of objects and properties in
the Track View.
Basic Procedure
1. If necessary, select the object(s) you want to Nudge.

For example, if you want to adjust the position of a Clip, or any property such as left/right edge, fade-
in/fade-out length, etc, you need to select the Clip.

2. Pull down the Edit View : Options menu and bring up the Nudge submenu.
3. Select the element or property you want to nudge, from the lower part of the submenu.
4. Click the Nudge icons to Nudge the selected element, or use the computer keys [F11] (Nudge –) or

[F12] (Nudge +).
Each time you click the icon or press the corresponding key, the element will be Nudged by a defined
amount (see below).

- By holding down modifier keys when you click the icon or press the key, you can Nudge the element by
smaller or larger amounts.

The modifier keys have the following functionality:
[Shift] Large impulse (10 x the default amount).
[Ctrl] Small impulse (1/10 of the default amount).
[Ctrl]+[Shift] Micro impulse (1/100 of the default amount).

- Generally, the Magnetic Bounds are not used when Nudging.
That is, the Nudged elements will not snap to any other position, but can be moved freely. The only
exception is "Snap to waveform when crossfading" for Nudged Clips, as described below.
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Setting the Default Nudge Impulse
To define the default Nudge impulse (the amount with which elements are adjusted when you Nudge
them), proceed as follows:
1. Pull down the Edit View : Options menu and bring up the Nudge submenu.
2. Select "Define impulse...".

The Impulse Value dialog appears.
3. Specify the default impulse time in the Time field.

This is used for nudging the position of objects or edges.
4. Specify the default impulse level in the Level field.
This is used for nudging volume.
5. Click OK to close the dialog.
- Note that the Large, Small and Micro impulses are relative to the default value, as described above.
- The default impulse settings are not used when Nudging Syncro offset (SMPTE). See Nudging Sync

Offset.
The Nudgable Elements
The following elements and properties can be nudged:

OptionOption DescriptionDescription
Clip position. This moves all selected Clips. If the option "Snap to waveform when

crossfading" is activated on the Edit View : Fade menu, and the focused Clip
is moved to the left so that it overlaps another Clip, the Nudged Clip will be
time-adjusted slightly to match the waveform in the left Clip.

Clip’s left or right edge. This is the same as resizing the Clip, in the "Static Audio Source" mode.
Clip’s fade-in or fade-out. Moves the fade-in/fade-out junction point (see Creating Fades). If the

envelope is a stereo envelope, both sides will be adjusted.
Clip’s crossfade. For this to work, you have to select the second Clip (the one to the right) in a

crossfade pair. Nudging will make the crossfade zone narrower or wider, by
moving the junction points of both Clips in the crossfade. For details about
crossfades, see Creating Crossfades.

Cursor. Moves the Montage cursor.
Selected range left/right. Moves the left or right edge of a selection range.
Current marker. Moves the currently selected Montage Marker. To select a marker, click on it

in the area above the Ruler.
Pan of focused Clip. Adjusts the Pan of the focused Clip, so that Nudge+ pans to the left and

Nudge– to the right. The Nudge amount is fixed at 1/100 of the full pan
range. This means that the Default Impulse setting is not used.

Pan of all selected Clips. As above, but affects all selected Clips.
Volume of focused Clip. Adjusts the volume of the focused Clip, in steps according to the Level

setting in the Impulse value dialog.
Volume of all selected Clips. As above, but affects all selected Clips.
Synchro offset (SMPTE). This is used when synchronizing WaveLab to external equipment. See

Nudging Sync Offset.

Using Auto-Select
If the Auto-Select option on the Nudge submenu is activated, WaveLab attempts to automatically select
what should be Nudged, depending on your last action in the Track View. If your last action was to select
or move a Clip, the "Clip position" option is automatically selected on the Nudge submenu, if you adjusted
the volume, the "Volume of focused Clip" option will be selected, etc. In most cases, this allows you to use
the Nudge feature without having to manually select Nudge elements on the submenu.
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The Zoom ViewThe Zoom View

IntroductionIntroduction
When the Zoom View is selected (by clicking the Zoom tab), the Upper Pane displays a close-up view of
the beginning of the selected Clip. The main purpose of this is to help you splice two consecutive Clips
together (in which case the Zoom View will display the end of the left Clip and the start of the right Clip, as
in the picture below). This splicing is done by applying short crossfades.
To make things clear, there are two main "types" of crossfades:
- The "artistic" crossfades, for example when you want to crossfade two songs to make a nice transition.

Usually, these types of crossfades are quite long, and can easily be created from the Track view.
- The "patch" crossfades, for example when you want to replace a section of audio, and want this to be

done as transparently as possible, without any audible discontinuity in the resulting audio.
In these cases, it is necessary to make the crossfades as short as possible. These types of crossfades are
best created in the Zoom View.

The Zoom View helps you create very short crossfades, automatically matching the phase of the two Clips,
hence minimizing harmonic cancellations. This method, though more CPU demanding, is far superior to
the common method of just finding zero crossing points.

Splicing Clips togetherSplicing Clips together
To splice two Clips together in the Zoom View, proceed as follows:
1. In the Track View, move the two Clips together end-to-start.
2. Make sure the Clip to the right is focused.
3. Click the Zoom tab to display the Zoom View.

This shows a close-up of the two Clips.
- Note that the Zoom View is centered around the start point of the right Clip! This means that if you

move the right Clip in the Track View, the left Clip will appear to be moving in the Zoom View.
4. Set the zoom factor using the icons above the display, or the corresponding options on the Zoom View :

Options menu.
In the finest mode (1:1), each pixel on screen corresponds to one sample. In the 1:8 mode, there are
eight samples per pixel.

- If you activate the Automatic Level Zooming option on the Zoom View : Options menu, the
waveforms are automatically zoomed vertically to fill out the Overview.

5. If necessary, you can move or resize the right Clip in the Zoom View.
Resizing is done exactly as in the Track View, with the audio source "static" or "tied" (see Resizing
Clips). Moving is done by clicking and dragging anywhere within the Clip (the Mouse Zones within the
Clip are not used in the Zoom View).

6. Select a Search Range from the Zoom View : Options menu.
This determines how far into the Clips the program will scan when searching for the best possible phase
match. Higher values result in greater accuracy, but also longer processing times, since this is a very
CPU intensive process.

- If the sounds contain a lot of bass, you should avoid the shortest Search range setting (5-10 ms).
7. Select Move to left (match waveform) from the Zoom View : Options menu (or click the icon with the

left arrow, next to the menu).
Wavelab will now scan the audio to the left of the splice point and move the right Clip to the position
which provides the best possible phase match, to avoid harmonic cancellation. When the right Clip is
moved over the left Clip, a short crossfade is automatically created. For more information about
crossfades, see Creating Crossfades.

- Selecting the function Move to right (match waveform) from the Zoom View : Options menu (or
clicking the icon with the right arrow) does the same thing, but moves the right Clip to the right instead.
This is useful if the two Clips are already overlapping.

Editing in the Clip List ViewEditing in the Clip List View

IntroductionIntroduction
When the Clips View is selected (by clicking the Clips tab at the top of the Audio Montage window), all
currently used Clips are displayed in a list in the Upper Pane. Each Clip in the Track View has a
corresponding entry in the Clip List.
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The list allows you to edit the Clips in various ways. In fact, virtually all Clip editing functions available in
the Track View are also available in the Clip List. As usual, you can either type in the values or use sliders,
allowing for exact and precise editing.

The List View columnsThe List View columns
In the Clip List, you can edit the following parameters:
ColumnColumn DescriptionDescription
Row Header (nr) Clicking on the numbered button to the left of a Clip in the list automatically selects the

Clip in the Track View and scrolls the Track View to display the Clip.
Speaker Icon Click on the Speaker Icon to audition a Clip (including muted Clips). This column

cannot be removed, resized or edited.
Name Double click on a name to type in a new name.
Track Clicking on a Track number opens a pop-up menu where you can select a new Track

for the Clip (Stereo Clips cannot be moved to mono Tracks and vice versa).
Pregap Length of silence before Clip, or the overlap time between Clips (see further description

below).
Start The Clip Start time (in the format selected on the Ruler).
End The Clip End time.
Length The length of the Clip.
Clip-lock status If a box is ticked in this Column, the related Clip is time-locked in the Track View, and

no editing can be performed on the Clip.
Gain This allows you to boost or cut the Clip gain by +/- 24 dB. Note that this "extra" gain

adjustment is done at the end of the Clip chain, after the envelope, effects and pan.
This is the setting adjusted by the Meta Normalizer .

Mute status If a box is ticked in this Column, the related Clip is muted (see Mute and Solo).
Comment In this Column you can type in comments for the Clip.

About the Pregap Column options
There are three options on the Clips View : Options menu that determine what is displayed in the Pregap
column:
- Show global pre-gaps.

If this is activated, the Pregap Column displays the length of the gap (if any) between the start of a Clip
and the end of the previous Clip, on any Track. In other words, it shows the gap between the two Clips,
regardless of whether they are on the same or different Tracks.

- Show pre-gaps by track.
As above, but shows the gap between Clips on the same Track only.

- Show overlap times (in red).
If this is activated, and a Clip overlaps the previous Clip, the Pregap Column will display the length of
the overlapping section, in red. Note that the "global" and "by track" options above apply to overlap
times as well.

Customizing the ViewCustomizing the View
You can customize the Clip List in several ways:
- There are Clip Lists with identical contents in the Files and Groups Views as well. However, each list

can be customized independently.
Hiding/Showing Columns
The Clip List View can be divided in up to ten columns, with each column displaying different data
relating to the Clips in the List. To hide/show columns, proceed as follows:
1. Click on the Clips Tab to select the Clips View.
2. Make sure the divider between the Upper and Lower Panes is pulled down, so you can see the Clip List

properly.
3. Click on the arrow button located in the upper left part of the Clip List.

The Columns pop-up menu appears, displaying all the available Column types. Currently visible
Column types are indicated with a tick mark.

4. To hide a Column, simply click on the tick mark beside the Column type you wish to hide.
The Column disappears from the Clip List, and the pop-up closes.
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5. To show a hidden Column type, open the Columns pop-up menu and click in the space to the left of the
Column type you wish to show.
The pop-up closes, and the column is now shown in the Clip List.

Moving Columns
It is possible to rearrange the order of the Columns. Proceed as follows:
1. Click and hold on a Column Heading in the Clip List.
2. While holding down the left mouse button, drag the column either to the left or right.

A vertical line is shown in the Clip List to indicate where the Column will be inserted.
3. When you reach the point to where you want to move the Column, simply release the mouse button.

The Column is moved to the new location.
Resizing Columns
You can freely adjust the width of Columns by using the following method:
1. Position the mouse pointer on the edge of the Column Heading you wish to resize, so that the arrow

pointer changes into a divider.
2. Click and drag the divider to increase/decrease the width of the Column and release the mouse button.

The Column is resized.
- If you select "Optimize Column Width" from the Columns pop-up menu, the sizes of all columns are

optimized with regard to their contents.
Normally, you don’t have to do this, since WaveLab automatically optimizes the column widths each
time the View is opened or resized.

Only Show Selected Clips
When this item is activated on the Clips View : Options menu, only those Clips that are selected in the
Track View are listed. Deselecting a Clip in the Track View will automatically hide it in the Clip List.
Sorting the Clips in the List
The Clips in the list can be sorted in a number of ways; alphabetically, by length or by Start position etc.
This is done in the standard Windows fashion, by clicking on the desired column heading. Clicking again
on the same heading will reverse the sort order.
The following Clip List sort conditions apply:
Clicking on Heading...Clicking on Heading... Sorts by...Sorts by...
Name Name (alphabetically).
Track Track Number.
Pregap Length of silence before Clip, or overlap time.
Start Start position.
End End position.
Length Clip length.
Clip-lock status Locked Clips are put at the top of the list.
Gain Gain setting.
Mute status Muted Clips are put at the top of the list.
Comment Clip Comment (alphabetically).

Re-ordering Clips in the Montage by Drag and Drop
It is possible to change the order of Clips in the Montage by dragging them up or down in the Clip list:
1. Activate the option "Allow reordering by drag and drop" on the Clips View : Options menu.
2. Click on the Clip name or the numbered button to the left of the Clip you want to drag, and keep the

mouse button pressed.
3. Drag the Clip up or down in the list and drop it at the desired position.

The Clips are reordered.
- When a Clip is reordered this way, a Pregap (by default 2 seconds) is added before it.

You can change the default time by selecting "Edit default pre-gap" on the Edit View : Options menu.

Exporting the Clip List as textExporting the Clip List as text
If you select "Export Clip List as text" from the Clips View : Options menu, the Clip list is opened as a text
file in Windows Notepad. The text list contains all the column items found in the Clip list except the Clip-
lock and Mute status. Additionally, it also contains information about the Clips’ source audio files.
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Managing Clips and Source FilesManaging Clips and Source Files

Editing Source FilesEditing Source Files
Editing the Montage may require that you process or edit the actual audio files referenced by the Clips.
This is done in the following way:
1. Right-click on the Clip to bring up the Clip context menu.
2. Select Edit from the Source submenu.

A Wave window opens, showing the referenced audio file with a selection corresponding to the Clip.
3. Edit the file as desired, save it and return to the Audio Montage.
You can also use the following methods to edit the source file:
- Drag the Clip onto the WaveLab desktop.
- Double click in the Mouse Zone used for dragging/copying Clips (by default the Top Clip area).
- Drag a selection range onto the WaveLab desktop. In this case, the selection in the Wave window will

correspond to the selection range, rather than the Clip.
Please note the following:
- Any editing you perform this way will affect all Clips that use the audio file (possibly including Clips in

other Audio Montages).
If this is not what you want, you should consider using the "Clone and Substitute" function (see below)
before editing.

- You can Undo/Redo all changes in Wave windows, and these changes will be reflected immediately in
all open Montages.

- If you reduce the length of the source audio file, so that it ends before the Clip end point, the end of the
corresponding Clip(s) will be displayed in another color (inverse video), to alert you.
You should remedy this, either by Undoing the change in the source file, by assigning another audio file
to the Clip or by resizing the Clip.

- If you use "Save as" to save the source audio file under another name, the Montage will now refer to
that new file instead.
This is true for all open Montages that refer to the file.

Cloning and Substituting Source FilesCloning and Substituting Source Files
If you want to be able to edit the source file of a Clip, without the risk of corrupting any other Clips, you
should use the function "Clone and Substitute" on the Source submenu on the Clip context menu. This
creates a copy of the audio source file, and makes the Clip reference to this new file. As a result you can
edit the source file without affecting other Clips or the original audio file.
- The cloned audio file will have the same name as the original, but with the postfix "_#X", where X is a

number.
For example, if the original file is called Piano.wav, the first clone you make will be called
Piano_#1.wav. If you repeat the procedure with another Clip referencing to Piano.wav, that clone will
be called Piano_#2.wav, and so on.

- The cloned audio file will be stored in the Implicit folder.

Substituting the Source Audio FileSubstituting the Source Audio File
If you select the function "Subsitute with existing wave" from the Source pop-up menu on the Clip context
menu, a file dialog appears, allowing you to make the Clip point to another audio file.
- All Clip settings will be retained.
- The substituting audio file must be long enough for the Clip to "fit".

This means that the audio file must be at least as long as the Clip’s end position.
- You cannot substitute a stereo file with a mono file or vice versa.

Working with Volume EnvelopesWorking with Volume Envelopes

How the Envelope is displayedHow the Envelope is displayed
By default all Clips display a Volume Envelope curve. Actually, you should view the Volume Envelope as
three separate Envelopes: the Fade-in part, the "sustain part" and the Fade-out part. The purple points to
the left and right on the curve are the Fade-in and Fade-out junction points, that separate the Fade parts
from the sustain part.
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The Fade-in and Fade-out parts of the Envelope are described in the topic Creating Fades. The following
text describe the "sustain part" of the Envelope, except where stated.
Map waveforms to volume
If "Map waveforms to volume" is activated on the Edit View : Options menu, the Clips' waveforms will be
scaled vertically, according to the envelope curves.
Hiding/Showing Volume Envelope curves
All Clips display Volume Envelopes by default. There are two ways you can hide the Envelope curve for a
Clip.
Method 1:Method 1:
1. Right-click anywhere on the Clip (except the Envelope curve) to open the Clip context menu.
2. Open the "Show Envelope" submenu, and deactivate the option "Fade/Level".
The Volume Envelope is hidden, but still active.
To show the Volume Envelope, activate the option again.
Method 2:Method 2:
1. Right-click on the sustain part of the Envelope curve to open the Envelope context menu.
2. Select "Hide" from the menu.
The Volume Envelope is hidden, but still active.
To show the Envelope curve again, proceed as in Method 1.
Only show one envelope at a time
As Pan settings and Effect send levels also can be automated using Envelope curves, it is possible to have
quite a few different Envelope curves in a Clip.This might make it difficult to quickly find the curve you
wish to view or edit. To remedy this, you can activate the option "Only show one envelope at a time" on
the Clip context menu's Show Envelope sub-menu, and have only one selected envelope type shown.
- For this to work properly, you need to first make sure only one envelope is visible (activated on the

"Show Envelope" submenu), and then activate "Only show one envelope at a time".
If you now select another envelope type, the new envelope will replace the previous, only allowing one
envelope to be shown.

Mono/Stereo Envelopes
It is possible to display two Volume Envelope curves for stereo Clips, by selecting "Convert to Stereo
Envelope" from the Envelope context menu. This allows you to set fades and volumes independently for
each channel.
To convert back to a mono envelope, select "Convert to Mono Envelope" from the same menu.

Editing EnvelopesEditing Envelopes
This section describes how to edit Envelope curves. The procedures are the same for all kinds of Envelopes
(including Fades).
Adding Envelope points
There are two ways you can add a point:
- By double-clicking on the Envelope curve.
- By right-clicking the Envelope curve to open the Envelope context menu and selecting "New point"

from the menu.
You may add as many points as you like.
Selecting Envelope points
To select an Envelope point, click on it. Selected points are displayed in red.
You can also select several Envelope points. The following rules apply:
- [Ctrl]-click on a point to select it without de-selecting any already selected points.
- [Shift]-click on a point to select all points between a previously selected point and the current point.
- Pressing [Alt], clicking and dragging allows you to select points using a selection rectangle.

All points inside the rectangle become selected.
To deselect a point, [Ctrl]-click on it. To deselect all selected points, select "Deselect all points" from the
Envelope context menu.
Dragging Volume Envelope points and curve segments
- To move a point, click on it and then drag it in any direction.

The junction points (the points separating the Fade parts and the sustain part) will only move
horizontally this way. To move a junction point vertically, press [Ctrl] and drag.
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- To move several selected points, click any selected point and drag it in any direction.
All selected points will be moved.

- Clicking on a curve segment (i.e. the part of an Envelope curve between two selected points) allows all
currently selected points to be moved vertically.

- Clicking on a curve segment (i.e. the part of an Envelope curve between two selected points) and then
pressing [Shift], allows all selected points to be moved horizontally.

-  [Ctrl]-clicking on the Envelope curve and dragging it up or down will select (and move) the two nearest
points to the right and left respectively.

- You are constrained to vertical movement using this method. This method is useful as a shortcut for
quickly adjusting the level of a curve segment.

- [Shift]-clicking on the Envelope curve and dragging it left or right will select (and move) the two nearest
points to the right and left respectively.
You are constrained to horizontal movement using this method. This method is useful when working
with Duck according to other Track since it allows you to quickly adjust the position of duck regions.

- Clicking and dragging the Envelope curve up or down selects (and moves) all points, allowing you to
quickly adjust the overall gain for the Clip.
You are constrained to vertical movement using this method. Note that points set to the minimum
value are not affected (see Muting a selected range of the Clip).

- Holding down [Alt] and dragging the Envelope curve up or down adjusts the corresponding Envelopes
in all selected Clips.
This is a quick way to adjust the level or Pan of several Clips at the same time (and also to adjust both
sides of a stereo envelope simultaneously).

Envelope smoothing
If this item is ticked on the Envelope context menu, the resulting Envelope curve angles will be rounded
instead of angular. This produces smoother, more natural Envelope curves. It can be used while drawing
the Envelope curve, or applied to an existing curve.
Deleting Volume Envelope points
There are three ways you can delete points:
- By double-clicking on a point.
- By aiming at the point and selecting "Delete point" from the Envelope context menu.
- By selecting points and selecting "Delete selected point(s)" from the Envelope context menu.
The junction points between the sustain and fade parts of the Envelope cannot be deleted.

Resetting EnvelopesResetting Envelopes
There are various ways to reset the Envelope:
- To reset a point to 0dB, right-click on the point and select "Reset point" from the Envelope context

menu.
- To reset the whole Envelope curve to default, right-click the Envelope curve and select "Reset all" from

the context menu.
This removes all points from the curve and sets the Fade times to zero.

- To reset the sustain part of the Volume Envelope only, select "Reset sustain to 0dB" on the Envelope
context menu.
All Volume Envelope points will be removed, but any defined fades will be left untouched. This applies
to Volume Envelopes only.

Copying EnvelopesCopying Envelopes
It is possible to copy an Envelope curve and paste it onto another Clip. Proceed as follows:
1. Open the Envelope context menu from the curve you wish to copy, and select "Clipboard" on the

menu.
A submenu appears.

2. Select "Copy Envelope" on the submenu.
The curve is copied to the clipboard and the context menu closes.

3. Open the Envelope context menu from the Clip to which you want to apply the curve and select "Paste
Envelope" from the Clipboard submenu.
The Envelope curve is applied to the Clip.
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Muting a selected range of the ClipMuting a selected range of the Clip
It is possible to mute parts of a Clip using the Volume Envelope. Proceed as follows:
1 Make a selection range to define the part of the Clip you want to mute.
2 Right click the Clip to open the Clip context clip menu, and select "Mute selection (envelope)".

The program adds points and draws a curve to mute the selected range (by lowering the volume to -
144dB, with 20ms fall and rise times).

- By design, points set to the minimum value (-144 dB) are not affected when you drag the whole
Envelope curve up or down.
This allows you to adjust the overall level of the envelope without affecting muted regions.

Muting whole Clips and Tracks is described in the topic Mute and Solo.

Using Envelope PresetsUsing Envelope Presets
It is possible to create Envelope presets which you can later recall and apply to other Clips.
Note that there are separate Presets for the sustain part (Envelope Presets) and the Fade parts.
Furthermore, Volume Envelope Presets can only be applied to Volume Envelopes. Non-volume Envelope
Presets (such as Pan and Effect Presets) can be applied to any other non-volume Envelope, but not to
Volume Envelopes.
Creating Envelope Presets
1. Open the Envelope context menu from the Clip containing the Envelope curve you wish to save as a

Preset.
2. Select "Envelope presets" from the menu.

A submenu opens.
3. Select "Edit" from the submenu.

The Envelope presets dialog opens.
4. Type in a name for the Envelope preset and click "Add" in the dialog.

The curve is now stored as a Preset.
Applying Envelope presets
1. Open the Envelope context menu from the Clip to which you want to apply an Envelope preset.
2. Select "Envelope presets" from the menu.

A submenu opens.
3. Select the preset from the list on the submenu.

The Envelope curve is applied.

Locking EnvelopesLocking Envelopes
It can be useful to lock an Envelope, so that you don't accidentally edit it. There are two ways to do this:
Envelope edit-lock
If this item is ticked on the Envelope context menu, the Volume Envelope curve points are hidden and
cannot be edited with the mouse.You can however drag the whole curve up or down.
Global Envelope lock
If the Global Envelope lock icon (in the Edit View) is activated, all Envelopes are locked and cannot be
edited with the mouse. The Envelopes and their points will still be displayed, but cannot be selected or
edited (the mouse pointer doesn’t change shape when moved over the curve).
You can toggle Global Envelope lock on/off by pressing [V] on the computer keyboard.

Duck according to other TrackDuck according to other Track
This feature allows you to create ducking effects between Clips on two adjacent Tracks. Normally, ducking
is when the signal level on one track or channel is automatically lowered by the presence of another signal
on another track or channel (if this is what you want, you should use the Ducker plug-in). With "Duck
according to other Track" it isn’t the presence of another signal that causes ducking to take place, but the
presence of another Clip on an adjacent Track.
The most obvious application of this feature is when mixing background music with a voice-over. When
the voice-over starts, the level of the music is automatically lowered and when the voice-over stops, the
level of the music is restored to the original level. This is done by automatically creating Volume Envelope
curves. In the following example we have chosen to use "music" on the Track to which ducking will be
applied and a "voice-over" on an adjacent Track that will cause ducking to take place.
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Proceed as follows:
- The Clips that cause ducking to take place must be located completely inside the time range of the Clip

to which ducking is applied.
- If the Clip(s) that will cause ducking to take place contains silent passages, ducking will not work

properly. These Clips have to be edited so that each phrase is a separate Clip without any silence. This
is because it is not the signal level that activates the ducking, but the Clip itself.

- When "Duck according to other Track" is performed it is applied to one Clip at a time. If the music (in
our example) should consist of several Clips that have been spliced together, only one of the music Clips
would be ducked by the voice-over. One solution is simply to repeat the function for each Clip, another
is to use the Apply function in the Master section to create a specific (single) file from the separate Clips,
and re-import this as a new Clip in the Montage.

1. Place the Clips containing the music and the voice-over on separate adjacent Tracks.
2. Make sure the voice-over Clips are located inside the time range of the music Clip.
3. Open the Envelope context menu from the Clip containing the music, and select "Duck according to

other Track...".
The Ducking options dialog box opens, containing a number of value- fields and options.

4. Click the appropriate "Track before" or "Track after" radio button in the "Clips to follow" section
(according to whether the voice-over Track is above or below the music Track in the Montage).
For details on the other options, open the dialog and use the context-sensitive help.

5. Click "OK".
The level of the music is automatically lowered by the voice-over Clips.

Fades and CrossfadesFades and Crossfades

Creating FadesCreating Fades
The volume envelope curve for each Clip contains a Fade-in and a Fade-out junction point. These can be
dragged horizontally to create a fade-in or fade-out for a Clip. You can add Envelope points to a fade just
as with Volume Envelopes.
- To create a fade, click and hold on the fade-in junction point at the beginning of a Clip and drag it to

the right.
The resulting linear (by default) fade-in curve is displayed in the Clip, and the fade is also reflected in
the waveform. If you position the mouse over the fade-in point, a label appears that displays the fade-in
time in seconds and milliseconds, and the volume in dB.

- To create a fade-out, use the same basic procedure but instead click and drag the fade-out point (at the
end of the Clip) to the left.

By default you can only move the fade junction points horizontally. To move them up or down, you need
to hold down [Ctrl] and drag.

Editing FadesEditing Fades
The operating procedure when creating and editing fades is identical to Volume Envelopes, except that the
Fade-in and Fade-out context menus only contain items related to the Fade parts (whereas the Envelope
context menu contains settings for all parts of the Envelope). Please refer to the topic Editing Envelopes for
details.
- To make editing of fades easier, there are special Zoom options on the Clip context menu, for zooming

in on the Fade-in or Fade-out area.
- Note that the Fade junction points (the points separating the Fade parts from the sustain part) have a

special property: If you move a junction point, all other points in the corresponding fade are moved
proportionally, to maintain the shape of the fade!

- If the option "Lock fade times when adjusting Clip edges" is activated on the Edit View : Fade menu,
the defined fade-in/out length will be maintained, even if you adjust the Clip edges (in other words, the
fade junction points will be moved when you resize the Clip).
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Using Default FadesUsing Default Fades
The factory default Fade-in/out curve shape is linear. If you wish you can change this setting and define a
default shape and/or length separately for both fade-ins and fade-outs.
The text below describes how to define a new default fade-in and how to apply it. The same procedure is
used for default fade-outs (use the "Default Fade-out" function on the context menu instead).
- Note that the Default Fades are saved for each Montage. If you want to use the same Default Fade for

several Montages. you should update the Montage Template file.
Defining a Default Fade-in
1. Open the Envelope context menu from the Clip that contains the fade-in shape and/or length you want

to use as default.
2. Select "Default Fade-in" on the menu.

A submenu opens.
3. Select "Define current shape as default" on the submenu.

Now every new Fade-in will have the defined default shape.
- If you also want to define a default length, use the same procedure but select "Define current fade-in

time as default fade time" from the Envelope context submenu.
You have now defined both a new default shape and length.

Applying Default Fades
To apply the default fade-in time use the following method:
1. Open the Envelope context menu from the Clip to which you want to apply the default fade-in length,

and select "Default Fade-in".
2. Select "Apply default fade time" from the submenu.

The fade-in time is now set to the defined default value.
To apply the default fade-in shape to an existing non-default fade shape, use the following method:
1. Open the Envelope context menu from the Clip you want to apply the default fade-in shape to, and

select "Default Fade-in".
2. Select "Apply default shape" from the submenu.
- When you create a new fade-in in a Clip that previously had no fade-in, the default shape is

automatically applied.
To apply both default fade-in shape and length use the following method:
1. Open the Envelope context menu from the Clip to which you want to apply the fade-in shape and time,

and select "Default Fade-in".
2. Select "Apply default shape and time" from the submenu.

The fade-in time and shape and is now set to the defined default value.
Create default fades in new Clips
If this option is activated on the Edit View : Fade menu, all new Clips that are imported or recorded in the
Montage will get the default fade-in and fade-out shape and length. This is also true for Clips that are
created by splitting a Clip.

Copying FadesCopying Fades
It is possible to copy a fade-in (or fade-out) and paste it onto another Clip. Proceed as follows:
1. Open the Envelope context menu by right-clicking on the fade you wish to copy, then select

"Clipboard" on the menu.
A submenu appears.

2. Select "Copy fade-in" (or fade-out) on the submenu.
The curve is copied to the clipboard and the context menu closes.

3. Open the Envelope context menu from the Clip to which you want to apply the fade, and select "Paste
fade-in" (or fade-out) from the Clipboard submenu.
The fade is applied to the Clip.

Using the Fade-In/Out ROM PresetsUsing the Fade-In/Out ROM Presets
If you select "Fade-in/out ROM Presets" on the corresponding context menu, a submenu opens where you
can select various preset curves and other fade-related options. The following curve types can be selected
(in these examples Fade-in curves are used - the corresponding fade-out curves would of course display the
mirror image):
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PresetPreset DescriptionDescription
Linear This is the factory default fade curve. A straight line between two points.
Sinus This produces a fade-in curve that starts out moderately fast but planes out towards the

end. This curve type will provide a constant power crossfade when selected for one of
the fades in a crossfade (see Crossfade compensation attributes).

Square-root This creates a curve that fades in quickly then planes out. This curve type will provide a
constant power crossfade when selected for one of the fades in a crossfade (see
Crossfade compensation attributes).

Sinusoid This creates an s-shaped fade, with a medium slow start and end fade.
Logarithmic This creates a curve that fades in fast in the beginning, reaching full level early in the

fade.
Exponential This creates a curve that fades in slowly in the beginning.
Exponential + This creates an even more pronounced exponential curve.

- The Fade-in/out ROM presets are only selectable on the Envelope context menu if the respective fade-
in/out length in the Clip is defined, i.e. not set to zero.

- On the same pop-up menu, you will also find options for power and amplitude compensation in
crossfades. These are described in the topic Crossfade compensation attributes.

Creating crossfadesCreating crossfades
A crossfade is a gradual fade between two Clips, where one is faded in and the other faded out. Crossfades
in the Montage are created automatically when Clip edges overlap. To create an automatic crossfade,
proceed as follows:
- For automatic crossfading to work, the Items "Enable automatic fade-in changes" and "Enable

automatic fade-out changes" must be ticked (default setting) on the Envelope context menu for the Clip
to which you want to apply the crossfade.
For a description of these menu items, open the Envelope context menu and use the context sensitive
help.

1. Click on the Edit Tab and open the Edit View : Fade menu.
2. Select the menu item "Automatic crossfading - free overlaps".
3. Move a Clip so that it overlaps the edge of another Clip.

A crossfade is automatically created in the overlap; by default two equal length linear fade curves, one
fading out and the other fading in.

- If neither Clip has a previously defined fade in the overlap, a default crossfade is created.
This consists of two equal length linear fade curves, one fading out and the other fading in.

- If one of the Clips has a defined fade curve (at the overlapping end), but the other Clip has none (fade
length set to zero), the defined fade shape will be maintained in the resulting crossfade.
The Clip without a fade automatically gets the same fade shape, but mirrored for amplitude
compesation.

- If both Clips have different defined fade curves at their adjacent edges when creating a crossfade, this
will create an asymmetrical crossfade, based on the already defined fade curves.

The above rules will also apply if you paste a Clip so that it overlaps another Clip.
Crossfading with fade constrained overlaps
On the Edit View : Fade menu you can find two items; "Automatic crossfading - fade-in constrained
overlaps" and "Automatic crossfading - fade-out constrained overlaps". These items allow you to create
crossfades and resize Clips simultaneously. The length of a defined fade-in or fade-out will constrain the
maximum length of the overlap (and hence the crossfade) to the set fade length. If you continue dragging a
clip past this point, the Clip that does not have the chosen fade type in the overlap will be resized. Proceed
as follows:
1. Select "Automatic crossfading - fade-in constrained overlaps" on the Fade menu (or by clicking on the

middle crossfade icon).
2. Create a fade-in curve in a Clip on a Track containing several Clips.
3. Drag the Clip to the left so that it overlaps another Clip, past the Right Clip edge.

A crossfade is created in the overlap.
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4. Continue dragging the Clip, so that the dragged Clip’s fade-in point overlaps the left Clip’s right edge.
The right edge of the left clip will be progressively adjusted as you drag the Clip further to the left,
making the Clip shorter. The crossfade region remains the same length.

5. Drag the clip to the right again.
The resized Clip is gradually uncovered. The original Clip length is memorized, so you can always
restore resized Clips later.

6. Separate the two Clips again so that there is no overlap, and so that they are in the same left/right
position relative to each other as before.

7. Now drag the left Clip to the right so that it overlaps the other Clip, and continue dragging to the right.
Again, the right edge of the left clip will be progressively resized as you drag the Clip further to the
right.

- Using "Automatic crossfading - fade-out constrained overlaps" works in the same way, but instead it is
the defined fade-out length that constrains the overlap, and accordingly the left edge of the right Clip is
adjusted.

- To use fade-in/out constrained overlaps, there must be a defined (i.e not set to zero) fade-in/out in the
overlap. Otherwise, "Automatic crossfading - free overlaps" is activated for that crossfade.

- Fade constrained overlaps can also be used with the options "Allow multiple automatic crossfades" and
"Allow automatic crossfading with focused track" options on the Fade menu. See  Crossfade options.

Crossfade optionsCrossfade options
The following crossfade options on the Edit View : Fade menu determine how automatic crossfades will be
created in the Montage:
- No Automatic crossfading.

If this is activated, no automatic crossfading will be performed.
- Automatic crossfading - free overlaps.

If this is activated, automatic crossfades are created when a Clip overlaps the edge of another Clip on
the same Track, and the length of the overlap determines the length of the crossfade.

- Automatic crossfading - fade-in constrained overlaps.
When this option is activated, the defined fade-in length of a Clip will constrain the maximum possible
overlap, and hence the crossfade time, to this set length. If you move the clip with the fade-in in the
overlap past the set overlap time, the other Clip will be progressively resized. Moving the other Clip into
the Clip that contains the fade-in in the overlap produces the same result.

- Automatic crossfading - fade-out constrained overlaps.
This works in the same way, but instead it is the defined fade-out length that constrains the overlap.

- Allow Automatic crossfading with focused Track.
When this option is activated, automatic crossfades will also be created when moving a Clip on any
Track so that it overlaps the edge of a Clip on the currently selected (focused) Track.

- Allow multiple automatic crossfades.
When this option is activated, automatic multiple crossfades will be created on any Track, if several
selected or grouped Clips will overlap other Clips’ edges when moved.
If the option is turned off, crossfades will only be created for the Clip you drag.

Additional crossfade options
There are three more options on the Edit View : Fade menu (with corresponding icons on the Edit View
icon bar) that affect crossfades:
- Snap to waveform when crossfading.

If this option is activated, and you create a crossfade by moving the right Clip towards the left, the
moved Clip will be time-adjusted slightly to match the waveform in the left Clip. What actually happens
when the mouse button is released, is that the "Waveform recognition" feature (on the Zoom page) is
activated. See Splicing Clips for details regarding this feature.

- Create optimized crossfade when snapping to other Clip.
If this option is activated, and you move a Clip so that its start snaps to the end of another Clip, a short
crossfade is automatically created, to optimally match the waveforms in the Clip. See Moving Clips.
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- Snap to fade-in/out when snapping to other Clip.
If this option is activated, and you move a Clip so that its start snaps to the end of another Clip, a
crossfade is automatically created, like with the previous option. In this case however, the length of the
crossfade will be the fade-in length of the right Clip.
If this is zero, the fade-out length of the left Clip is used as basis instead. If this too is zero, the function
"Create optimized crossfade when snapping to other Clip" is performed (if activated). In other words,
"Snap to fade-in/out..." has higher priority than "Create optimized crossfade...".

- If both options "Snap to fade-in/out when snapping to other Clip" and "Snap to waveform when
crossfading" are activated, the right Clip will first be pushed left to its fade-in point, and then pushed
further to create an optimized crossfade.

Crossfade compensation attributesCrossfade compensation attributes
On the Fade-in and Fade-out ROM preset menus you can find four items: "Pure shape", "Amplitude
compensation", "Medium compensation" and "Power compensation". The last three are compensation
attributes applicable to crossfades. Here follows a description of these menu items:

Menu itemMenu item ExplanationExplanation
Pure shape The pure mathematical curve shape is used. This is the default setting when any

Fade-in/out ROM preset is selected.
Amplitude compensation If this is selected for a fade-in (or fade-out) curve in a crossfade, the summed

fade-in and fade-out amplitudes will be the same all along the crossfade region.
This option is recommended for short crossfades.

Power compensation If this is selected for a fade-in (or fade-out) curve in a crossfade, the energy
(power) of the crossfade will be constant all along the crossfade region.
Crossfading between completely different types of audio material can sometimes
cause harmonics to "cancel each other out" at the crossfade splice point, causing
the volume to drop. Constant power crossfades compensate for this problem.
Using either the "Sinus" or "Square-root" fade ROM presets for a fade-in (or
fade-out) will provide a constant power crossfade without having to select this
item.

Medium compensation This option provides an intermediary between Amplitude and Power
compensation. This is recommended if the other two compensation attributes
won’t provide the desired result.

Note that selecting a compensation attribute for a single fade (not in a crossfade) will change the shape of
the curve, but the actual "compensation" will only take place when the fade becomes part of a crossfade.
The options above can be applied automatically when you create a crossfade, under the following
conditions:
- If the fade-out is a ROM preset (excluding "Sinus" or "Square-root") that uses "Pure shape", the

corresponding fade-in will get the same ROM preset, with amplitude compensation.
- If the fade-out is a ROM preset that uses a compensation attribute (i.e. not "Pure shape"), the fade-in

will get the same ROM preset, but with "Pure shape" activated, for the compensation to take effect.
- If the fade-out uses either the "Sinus" or "Square-root" ROM presets with the "Pure shape" setting, the

fade-in will get the same ROM preset also with the "Pure shape" setting, and the compensation
attributes will be greyed-out on the menu.
In reality Power compensation is used. This is because the "Sinus" and "Square-root" curves provide
constant power crossfades by themselves, for mathematical reasons.
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Editing crossfadesEditing crossfades
The factory default automatic crossfade is Linear, using the same shape and fade lengths for both the fade-
in and fade-out. Most of the time, an unaltered Linear or Sinus crossfade will produce the desired result.
You can, however, create crossfades with totally independent shapes and lengths for the fade-in and fade-
out curves. The following rules apply:
- You can edit the fade-in and fade-out curves in crossfades in exactly the same way as fades, by adding

and dragging curve points.
- To change the crossfade time (the width of the crossfade zone) "symmetrically", open the Clip context

menu for the right Clip in the crossfade pair, and select "Edit crossfade time...".
This item is only available if the Clip overlaps the Clip to the left, or if they are lined up with no gap
between. Selecting it brings up a small dialog in which you can adjust the time of the crossfade zone
numerically (or, by double clicking on the values, using sliders).

Working with Pan EnvelopesWorking with Pan Envelopes

About Pan EnvelopesAbout Pan Envelopes
You can draw Pan Envelope curves to automate the Pan setting for Clips in the same way as with Volume
Envelopes. For mono Clips, Pan governs the left/right position in the stereo spectrum. For stereo Clips,
Pan sets the left/right balance.
To create and edit Pan Envelopes, use the same procedures as when working with Volume Envelopes (the
sustain part - Pan Envelopes have no Fade parts). See Editing Envelopes.

Displaying Pan EnvelopesDisplaying Pan Envelopes
To show the Pan Envelope, proceed as follows:
1. Right-click anywhere on a Clip (except the Envelope curve) to open the Clip context menu.
2. Select "Show Envelope" on the menu.

A submenu opens.
3. Select "Pan" on the submenu.

The Pan Envelope is shown. If the option "Only show one envelope at a time" is activated, the
previously shown Envelope is hidden.

If the option "Map Waveforms to volume" is activated on the Edit View : Options menu, the waveforms
are scaled according to the Pan Envelope (as with the Volume Envelope).
The general procedure for selecting Envelope curves to show/hide is explained in the topic How the
Envelope is displayed.

Pan ModesPan Modes
For each Pan Envelope, you can select one of four Pan modes. These all relate to the fact that without
power compensation the power of the sum of the channels will drop by about 3 dB if a signal is panned
hard left or right, compared to if the same signal is panned center. Experiment with the modes to see which
fits best in a given situation.
To select a Pan Mode, proceed as follows:
1. Open the Pan Envelope context menu by right clicking the Pan Envelope curve.
2. Select "Pan mode" on the menu.
3. Select one of the following three modes from the sub-menu that appears:

ModeMode DescriptionDescription
Channel damp (0dB / mute) This mode will not compensate for power loss at all. If a signal is panned

hard left or right, the power of the sum of the channels will drop by 3dB.
Constant power (+3dB / mute) This is the default mode. Regardless of pan position, the power of the

sum of the channels will remain constant.
Channel boost (+4.5dB / mute) If this mode is selected and a signal is panned hard left or right, the power

of the sum of the channels will actually be higher than with a signal
panned center.

Channel boost (+6dB / mute) This is the same as the previous option, but with even greater power
boost.
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Transforming ClipsTransforming Clips

Transforming Clips - GeneralTransforming Clips - General
On the Clip context menu, you will find a submenu called Transform. This contains two items: "Time-
stretch to cursor" and "Pitch Shift". When you use one of these functions, a clone of the original audio file
is automatically created, containing exactly the audio range used in the Clip. The selected processing is
applied to the clone, and the Clip will reference to this file instead. The Transform functions can be viewed
as "non-destructive", since the original audio files are not affected.
- The cloned audio file will have the same name as the original, but with the postfix "_#X", where X is a

number.
- The cloned audio file will be stored in the folder specified in the Implicit folder.
- Note that since the new cloned audio file contains exactly the audio range used by the Clip, it is not

possible to lengthen the Clip by resizing it after the Transform operation.

Time Stretch to CursorTime Stretch to Cursor
This function uses WaveLab’s time stretch algorithm to adjust the length of a Clip:
1. Move the Montage Cursor to the position where you want the Clip to end.

Note that the Time Stretch algorithm will give best results when stretching/compressing by small or
moderate amounts, i.e. when the Montage Cursor is positioned not too far from the Clip’s current end.
Also, you should avoid Time Stretching already Time Stretched material - therefore, if you are not
satisfied with the result, you should Undo the operation before trying again.

2. Right-click on the Clip to bring up the Clip context menu.
3. Select "Time-stretch to Cursor" from the Transform submenu.

The Time Stretch dialog appears. This is the same dialog as when Time Stretching wave files, but the
fields for stretch factor/time/tempo are greyed out (since these are determined by the Cursor position).

4. Make settings for Quality, Audio Quantize and Rhythm Accuracy (see the context sensitive help).
5. Click OK.

The Clip is stretched (or shortened) so that it ends exactly at the Montage Cursor.

Pitch ShiftPitch Shift
This function uses WaveLab’s Pitch Correction algorithm to change the pitch of the Clip:
1. Right-click on the Clip to bring up the Clip context menu.
2. Select "Pitch Shift" from the Transform submenu.

The Pitch Correction dialog appears.
3. Specify the desired amount of Pitch Shift.

As with Time Stretch, small changes usually give better results.
4. Specify a Length Compensation value.

If you set this parameter to 100, the length of the Clip will not be affected. Setting it to a smaller value
will make the Clip longer (negative Pitch Shift values) or shorter (positive Pitch Shift values).

5. Make settings for Quality, Audio Quantize, Preserve Formants and Rhythm Accuracy.
See the context sensitive help for details.

6. Click OK.
The pitch of the Clip is changed.

Using Clip EffectsUsing Clip Effects

Clip Effects - BackgroundClip Effects - Background
The Montage supports VST effect plug-ins. The standard WaveLab and DirectX plug-ins cannot be applied
to Clips in the Montage, but VST versions of several standard WaveLab effects are provided, as well as
several of the standard Cubase VST effects. Every Clip in the Montage can be independently processed by
up to ten VST effect plug-ins. Effects are configured either as Inserts, when all sound from a Clip is
processed by the effect, or as Send effects ("Split mode") where the balance between the unprocessed sound
and the effect send level can be adjusted or controlled by Effect Envelope curves.
- Only effects for Clips that are active at the current playback position will consume any CPU power.

This effectively reduces any "unnecessary" CPU load to zero, thus allowing you to use more effects.
- Although standard WaveLab and DirectX plug-ins cannot be used on indivudual Clips, they are still

available as global effects, when playing back the Montage through the Master Section.
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- The first time you play a Montage after opening or cloning it, the program has to load all effects into
memory. If you have a lot of effects, this may result in a short silence before playback starts.

Adding Clip EffectsAdding Clip Effects
Each Clip has up to ten effect slots, each of which can contain a VST effect. To add an effect to a Clip, you
first need to have a slot:
Adding an effect slot
1. Open the Clip context menu by right-clicking the Clip.
2. Select "Add effect slot" from the menu.

A slot is created and an Effect dialog opens. This is where you select effects and make settings.
Selecting an effect for the slot
1. In the Effect dialog, click on the button marked "Effects".

A menu opens containing all installed VST plug-ins.
2. Select one of the effects from the menu.

The chosen effect’s parameters appear to the left in the dialog.
3. When you are done, click "Close" to close the dialog or leave it open if you want to make more

adjustments later.
- You can continue working with the Effect dialog open. It is also possible to have several Effect dialogs

open.
In the Track View, the Clip now displays the number [1] before the Clip name. This is to indicate that one
active effect slot is used for that Clip. Furthermore, if you look at the Clip Context menu, you will find that
the new slot (with the name of the selected effect) appears as a menu item. Selecting this menu item opens
the Effect dialog for the slot, allowing you to make effect settings, select another effect for the slot, etc.
- You can add effects during playback. However, if you add an effect with a latency larger than zero

(displayed to the right in the Effect dialog, see the context sensitive help for the dialog), you should stop
and restart playback to avoid timing discrepancies.
Also, a small number of VST plug-ins may change latency depending on parameter settings. If that is
the case, make sure to stop and restart playback after the latency is changed.

Removing Clip EffectsRemoving Clip Effects
You can’t actually manually remove created effect slots, only the slot’s effect. Here’s what you do:
1. To remove an effect from a slot, open the Clip context menu and select the effect you want to remove

from a slot.
The effect window opens.

2. Click on the "Effects" button, and select "Remove" from the pop-up menu that appears.
The effect is removed from the slot. You can now either select a new effect for the slot or simply leave
the slot unused.

- Unused slots are automatically removed the next time WaveLab is launched, and do not consume any
CPU power.

Making Effect settingsMaking Effect settings
You make settings for an effect in the Effect dialog (opened by selecting the slot from the Clip context
menu).
- The settings to the left in the dialog are effect specific, that is, they are the parameters for the selected

effect.
For details on the VST effects included with WaveLab, see the VST Plug-ins descriptions.

- The settings and functions to the right in the dialog are common settings, or settings for the effect slot.
- For descriptions of each parameter and function, open the dialog and use the context sensitive help.
Effect type: Insert or Split Mode?
Clip effects can be configured either as Insert or Send effects. This is done using the "Split mode" setting in
the Effect dialog.
- When Split mode is deactivated for an effect, it is treated as an insert effect.

This means the whole Clip signal is routed through the effect. Typical insert effects would be
compressors, auto panners or distortion units, etc.
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- When Split mode is activated for an effect, it is treated more as a send effect.
In this mode, you can adjust the send level to the effect. However, note that Split mode is different to
conventional send effects in that the effect signal is mixed directly into the audio path and not to an
effect return section. When Split mode is activated, the send level can be automated using Effect
Envelope curves.
Typical Split mode effects would be reverb, chorus or delay, etc.

- Some effects are always in Insert mode or always in Split mode.
For these effects, the Split mode setting is greyed out and cannot be changed.

Copying effect settings to another Clip
You can copy both the effect type and its settings and paste them into another Clip. Proceed as follows:
1. Select the effect you want to copy the settings from.
2. Select "Copy" from the Functions menu in the Effect dialog.
3. Right click the Clip into which you want to paste the effects settings, and either select "Add effect

slot..." or select an existing effect slot (if you want to replace the existing effect).
4. Select "Paste" from the Functions menu.

The copied effect type is added to a new slot along with the effect settings you copied.
Stereo plug-in settings can’t be pasted onto mono Clips (the same applies for mono plug-in settings and
stereo Clips).
Undoing effect changes
It is possible to Undo changes to the effect settings. However, WaveLab will only "register" the changes
(thus making them Undoable), when the Effect dialog loses focus. Therefore, if you have made an effect
setting change that you want to Undo:
1. Click on another window, so that the Effect dialog loses focus.

The new effect setting is registered by WaveLab.
2. Select Undo as usual.

Go back to the Effect dialog to continue working (if you wish).
Rearranging the order of the effect slots
The Function menu items "Move to previous position" and "Move to next position" allow you rearrange
the order of the effect slots. The effect order in a chain determines to a certain degree how the effects will
affect each other. If you have selected to use compression and reverb for example, the order decides
whether compression affects the Clip signal only (compressor used as Effect 1), or both the Clip signal and
the reverb signal (compressor used as Effect 2). The rule is that any effect that follows a previous effect slot,
will process the previous effect(s) (or a mix of input/effect in case Split mode is used). Proceed as follows:
1. Open the effect dialog for the first effect in a chain consisting of at least two active effect slots.
2. Select the Function menu item "Move to next position".

The effect dialog remains open and unchanged except that the previous Effect 1 slot now becomes
Effect slot 2 and vice versa.

3. Now selecting "Move to previous position" would return both effect slots to their original positions.
Repeating step two again would swap Effect slot 2 with slot 3 (if available) etc. Only relevant menu
items are selectable, you can’t select "Move to next position" for the last effect slot or "Move to previous
position" for the first effect slot.

Using Effect envelopesUsing Effect envelopes
It is possible to automate the effect send level for Split mode effects by using Effect Envelope curves.
Proceed as follows:
1. Open the Clip context menu for a Clip that has a Split mode effect active.
2. Select "Show envelope" from the Clip context menu.

The Clip’s Split mode effects are now selectable from the "Show envelope" submenu.
3. Select the effect to which you want to add an Effect Envelope.

The Effect envelope appears in the Clip.
Editing the Effect Envelope is done using the same methods as for Volume Envelopes (see Editing
Envelopes).
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The "Upper Track" output optionThe "Upper Track" output option
On the Track menu you will find two items: "Route to Master Section and Upper Track" and "Route to
Upper Track only". These items are related to the fact that WaveLab has the possibility to host plug-ins
that modulate audio with other audio. As an example of this, a plug-in called "Ducker" is included with the
program. This is used for lowering the volume of one signal, whenever another signal is present. A typical
application for the Ducker would be a music track with a commentary voice-over on another track;
whenever the commentary voice is heard, the volume of the music track is lowered by a certain amount.
To set up for this example, proceed as follows:
1. Make sure the "Voice-over" Clip is on the Track just below the "Music Track".
2. Pull down the Track menu for the "Voice-over" Track and select the option "Route to Master Section

and Upper Track".
This will route the sound of the "Voice-over" Track both to the Master Section and to the Track above.
In other situations, you may not want to hear the sound of the modulating Track at all, in which case
you would select "Route to Upper Track only" instead.

3. Add a new effect slot to the "Music" Clip, and select the Ducker plug-in.
4. Play back.

Whenever the "Voice-over" signal exceeds a certain level (the Ducker effect’s Threshold value), the level
of the "Music" Clip will be lowered (by an amount set with the Damping parameter).

5. Adjust the parameters of the Ducker effect until you get the effect you want.
A similar effect can be obtained using the Duck according to other Track function. The difference is that
with the Ducker, it is the actual signal level that governs the ducking, while with the "Duck according to..."
function, it is the presence of a Clip. Therefore, the Ducker is the best choice if the modulating Track (the
"Voice-over") consists of long Clips including silence, while the "Duck according to..." function is best used
when the modulating Track holds a lot of short Clips (without silence).

The Meta NormalizerThe Meta Normalizer
The Meta Normalizer, found on the Edit View : Special menu, is a special Montage version of the Batch
plug-in processor with the same name that is also included with WaveLab. The basic functionality is
similar but instead of processing batched files, it processes Clips. The processing is non destructive, i.e. it
will not affect the source audio files.
The Meta Normalizer operates in two or three passes. It first analyses the peak or RMS levels on all Clips
in the Montage. Then it processes the Clips according to the highest possible level found amongst the Clips,
so that they will all play back at equal peak or RMS levels. This is achieved by automatically adjusting the
Clips "Gain" setting in the Clip list. Note that the gain level of a Clip can either be amplified or reduced.
The two purposes of the Meta Normalizer are to equalize the loudness between all Clips (useful e.g. when
producing a CD) and to ensure that the full mixdown of the Montage will never clip. Depending on how
much the levels differ between Clips, and the desired result, there are a number of options available to
ensure that the applied processing optimizes the levels without clipping.
- The audio path in WaveLab uses 32 Bit floating point processing. You can therefore "overload" it, i.e.

use levels above 0 dB, without running the risk of causing digital signal clipping in the signal path. The
only section of the audio path that can introduce clipping is the output of the Master Section, and this
can also be taken care of by the Meta Normalizer.

For more information, open the dialog and use the context sensitive help.

The Meta Normalizer DialogThe Meta Normalizer Dialog
Selecting the Meta Normalizer from the Edit View : Special menu opens a dialog where you can set up
various options before applying the processing. The dialog is divided into two windows; "Settings" and
"Schedule", selected by clicking the corresponding tab at the top of the dialog. In the Settings dialog you
specify how the Clips will be processed, and in the Schedule dialog you set up options related to the
performance of the processing (which always happens in the background).
- For descriptions of the parameters, open the dialog and use the context sensitive help.
- When you have set-up the Meta Normalizer dialog, click the "Process" button to activate processing.

Processing happens in the background. You can go on working in WaveLab during the processing,
although not in the Montage being processed.
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Grouping ClipsGrouping Clips

Grouping ClipsGrouping Clips
In many situations, it is useful to work with several Clips as one entity. This is easily done by Grouping
them in the Groups View. Grouped Clips will be selected, moved and duplicated together.
Proceed as follows:
1. Select the Clips you want to Group.
2. Click the Groups tab to select the Groups View.
3. Select "Group selected Clips" from the Groups View : Grouping menu, or click the Group icon.
4. Enter a name for the Group in the dialog that appears and click OK.

The new Group appears in the Group list. All Clips included in the Group will also have the name of
the Group prepended to the Clip names in the Track View.

Adding Clips to an existing Group
If you already have a Group, and want to add one or several Clips to that Group, this is done in the
following way:
1. Select the Clips you want to add.
2. In the Groups View, select "Group selected Clips" from the Groups View : Grouping menu, or click the

Group icon.
3. In the dialog that appears, select the Group to which you want to add the Clips.
4. Click OK.

The Clips are added to the Group.
- If you want to use this method to create a new Group, by adding Clips one at a time, you can start by

selecting "Add empty Group" from the Groups View : Grouping menu.
This creates an empty Group in the list, to which you can later add Clips.

- It is possible to create nested Groups, by adding a Group to another Group.
This can be useful, since it allows you to deactivate the Grouping for some sub-Groups only, as
described below. For Clips in nested Groups, all Group names are displayed before the Clip name
(separated by ":")

- A Clip cannot be part of more than one Group.
If you add a Clip to a Group, it is automatically removed from any other Group it is part of.

Group OptionsGroup Options
There are a couple of options in the Groups View that affect how Groups are handled:
- You can temporarily "turn off" a Group by deactivating the checkbox to the left of a Group in the list.

When the Group is deactivated this way, you can move individual Clips in the Group, as if they were
not Grouped.

- If the option "A mouse click selects a Group" is activated on the Groups View : Options menu, selecting
a Clip in the Track View automatically selects all Clips in the same Group.
If the option is deactivated, selecting a whole Group requires that you click on the Group name in the
Groups View list. This is useful if you want to be able to modify the relative positions of Clips in the
Group, without having to remove them from the Group.

Group Options
You can select a specific color for a group to make it easy to discern it in the Track View:
1. Select the Group by clicking on its name in the Groups View list.
2. Pull down the Groups View Grouping list and open the "Color selected Group" pop-up menu.
3. Select a color from the pop-up menu.
For more information about Audio Montage colors, see Using Color - Basics.
- Any individual color selections for the Clips will override the Group Color, as will the color settings for

Muted and Locked Clips.

Removing GroupsRemoving Groups
To remove a Group, proceed as follows:
1. Select the Group by clicking on its name in the Groups View list.
2. Pull down the Groups View : Grouping menu and select "Remove selected Group".

The Group is removed (the Clips are not affected).
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Working with Montage MarkersWorking with Montage Markers

Creating Montage MarkersCreating Montage Markers
Separate Markers are provided for use in the Montage. Markers are used in the Montage in much the same
way as in the source Wave windows (see About Markers for details regarding Marker types and the basic
functionality of Markers).
To create a Marker in the Montage, select the Markers View (by clicking the Markers tab) and use one of
the following methods:
- By selecting a marker type from the Markers View : Functions menu.
- By clicking on one of the Marker icons.
- By right clicking in the area above the Ruler and selecting a marker type.

Creating markers by right clicking can be done regardless of what View is currently selected.
- By pressing the [Insert] key.

This creates a Generic marker.
You can also use any of the above methods to create markers at the current cursor position while playing
back.

Hiding and Showing MarkersHiding and Showing Markers
By using the Markers View : Filter menu you can select to show or hide certain marker types in the Marker
list view. By default, all marker types are shown.
- Note that it is also possible to view the markers of a Clip’s source audio file, by activating the option

"Show source’s ruler and markers" on the Clip context menu.

Moving Markers in the Track ViewMoving Markers in the Track View
There are two ways to adjust the position of a Marker in the Track View:
- By clicking and dragging it.

In this case, the Magnetic Bounds setting on the Edit View : Options menu applies.
- By clicking on the Marker to select it, and using the Nudge function.

Deleting MarkersDeleting Markers
There are three ways to delete markers in the Montage:
- By right clicking the marker head and selecting "Delete marker" on the menu.
- By selecting the markers and then selecting "Delete selected marker(s)" on the Markers View :

Functions menu.
- By dragging the marker up and dropping it outside the Ruler.

Editing in the Markers ViewEditing in the Markers View
Clicking on the Marker tab opens the Markers View in the upper pane of the Montage. By default, this lists
contains all markers currently in the Montage. Below the Montage tabs there is a row of marker icons, and
to the left of them are the Markers View : Functions and Filter menus. The Markers list columns are used
for editing and/or displaying the following marker data:

ColumnColumn CommentComment
Marker type This column displays the corresponding marker type icon. Clicking the icon opens a

pop-up menu where you can select a new marker type for the current marker position.
Name Displays the marker name. Double click the name field to type in a new name. This

can also be done by double clicking to the right of the marker head in the area above
the Ruler (the pointer changes shape when you move it into the "Marker name zone").

Position This column displays the markers’ time positions. Double click to edit.
Edit lock If this is ticked, the marker cannot be moved by dragging the marker head.
Clip reference By selecting one of the Functions menu items "Make current marker relative to start of

focused Clip" or "Make current marker relative to end of focused Clip" you can lock a
marker position to the left or right edge of the focused Clip. This column displays the
name of the Clip to which a marker is locked.

Offset Depending on which of the two Functions menu items described above is chosen, this
column displays the time offset beween the Clip edge and the marker position.
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About locking marker positions to Clips
As described in the table above, it is possible to lock markers to Clips by selecting one of the Functions
menu items "Make current marker relative to start of focused Clip" or "Make current marker relative to end
of focused Clip". If selected, the marker will remain in the same position relative to the Clip start (or end)
even if the Clip is moved in the Montage or is resized.
Selecting the Functions menu item "Detach current marker from its relative Clip" removes the marker’s
Clip reference and the marker position is no longer locked to the Clip.

Exporting the Marker list as textExporting the Marker list as text
If you select "Export Marker list as text" on the Marker View : Functions menu, the Marker list is opened
as a text file in Windows Notepad. The text list contains the Markers’ names, positions and types.

Mixing down the Audio MontageMixing down the Audio Montage

The Apply FunctionThe Apply Function
The Apply function in the Master Section allows you to "mix down" the whole Montage (or sections of it)
to a single audio file. This is useful both for creating a final mix, and for "pre-mixing" Clips (you may for
example have a number of Clips to which you want to apply the same effects, etc). Proceed as follows:
1. If you want to mix down the whole Montage from start to end, proceed to step 4.
2. If you want to mix down some of the Clips only, select these.
3. If instead you want to mix down a certain section of the Montage only (on several Tracks), make a

selection range.
Note that although the selection range is only "horizontal", audio on all Tracks within the range will be
included.

4. If necessary, mute or unmute Tracks or Clips.
Only unmuted audio will be included in the mixdown file!

5. Click the Apply button in the Master Section window.
The Process Preferences dialog appears.

6. Use the radio buttons in the Range section to specify what you want to include in the created file.
The Time Selection and Selected Clips options will only be available if you made a selection range or
selected Clips, respectively (in step 2 and 3 above).

7. Activate the options as desired:

Option:Option: Description:Description:
No Tail When this is activated, any audio appended by the Master Section effects (such as

echoes and reverb tails) will be cut off. Note that this doesn’t affect the Tail setting
for Clip effects (see the context sensitive help for the Effect dialog).

Copy Markers When this is activated, any Markers in the Montage are copied to the created file.
This is only available when the Whole Montage option is selected.

Create CD Program Allows you to create an intermediary CD program, as described in the topic
Burning the CD. This is only available when the Whole Montage option is selected.

8. Select whether you want to create a specific file or not.
If you activate the Create specific file option, you need to specify a name and location for the file, and
select a bit resolution. If you don’t activate the option, a temporary file is created, with the bit resolution
specified in the global Preferences dialog (File tab).

- The Apply function can only create Wave (.WAV) files.
9. Click the Schedule tab to make settings for Priority, Start and Completion actions.

The options are described in the context sensitive help for the dialog.
10. Click OK to create the file.
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Undo, Redo and HistoryUndo, Redo and History

BackgroundBackground
The Audio Montage has a separate Undo/Redo list, independent from the Undo/Redo of Wave windows.
If you have several Montages, each window has its own Undo history.
Undoing and Redoing commands in the Audio Montage is done as in the Wave windows (by using the
Edit menu, or by pressing [Ctrl]-[Z] or [F3] for Undo, and [Shift]-[Ctrl]-[Z] or [F4] for Redo). However, the
Audio Montage has a special History View, which displays the Undo history as a list and makes it possible
to Undo several commands in one go.
In the History View (accessed by clicking the History tab), all operations you have made are listed.
Furthermore, if you recently have Undone any operations, these will be listed as well, allowing you to
Redo them (as long as you don’t perform any other operation, in which case the Undone operations will
disappear from the list). The list works in the following way:
- Items at the top of the list, displayed in yellow are Undone items.

A yellow arrow to the left indicates the last Undone action.
- The items below  are performed actions, which you can Undo.

A green arrow to the left indicates the last performed action.
- Selecting Undo from the Edit menu (or clicking the green arrow on the Icon bar) will Undo the last

performed action. It will now be displayed in yellow, and the green and yellow arrows to the left of the
list will be moved down one step.

- If there are yellow items in the list, you can select Redo  from the Edit menu (or click the yellow arrow
on the Icon bar). This will Redo the last Undone action, and the green and yellow arrows to the left of
the list  will be moved up one step.

It is possible to hide columns in the History View, by using the Columns pop-up menu. This is accessed by
clicking the arrow button above the number icons to the left in the View.
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FunctionsFunctions
On the History menu in the History View, the following functions and options are available:

FunctionFunction DescriptionDescription
Undo last operation. This is the same as the Undo command on the Edit menu. You

can also Undo the last operation by clicking the green arrow icon
above the list (or in the main Control bar).

Undo until selected operation. This is only available if you have selected an operation in the
History list. Selecting this function Undoes all operations up to
and including the selected one. This is a quick way to Undo
several operations in one go.

Undo all operations since last saving. This is similar to "Revert to saved" on the File menu, with two
differences: It does not undo any View, Zoom or Position changes,
and it does not clear the History list.

Undo all operations. Undoes all operations in the list, even those done before the last
save.

Redo last undone operation. This is the same as the Redo command on the Edit menu. You can
also Redo the last Undone operation by clicking the yellow arrow
icon above the list (or in the main Control bar).

Redo all undone operations. Redoes all Undone operations in the list, i.e. all operations
displayed in yellow.

Clear History now. Removes all operations from the History list. If you use this
function, you cannot Undo any previous operations.

Clear History after each saving. When this option is activated, the History list will be cleared each
time you save the Montage.

Group similar operations. When this option is activated, and you perform several, similar
operations one after another, these will later be "compressed" into
one Undo operation. Let’s say you move a Clip in several steps
until you find the perfect position. While you are doing this, it is
still possible to Undo each separate movement as usual. However,
as soon as you perform another operation, all the previous moves
(the "similar" operations) will be considered as one single entry in
the Undo History. This saves memory, and makes work quicker
since you don’t have to Undo every single step to revert to the
Clip’s original position.

The History View also contains the Backup functions, which are described in the topic Backing up
Montages.

Using ColorsUsing Colors

Using Colors - BasicsUsing Colors - Basics
You can assign different colors to different Clips, Tracks or Groups to make it easier to find your way
through the Montage:
- To assign a color to a Track, open the Track menu and select a color from the Color submenu.

The selected color is used for all current Clips on the Track, as well as for Clips you add later on.
However, note that this color selection is overridden by the Group and Clip colors.

- To assign a color to a Group, use the "Color selected Group" options in the Groups View.
The Group color (if other than default) supersedes the Track color, but is overridden by individual Clip
color selections.

- To assign a color to an individual Clip, right click on the Clip to bring up the Clip context menu, and
select a color from the Color submenu.
Clip color selections (if other than default) override Track and Group color selections.

- The Lock and Mute colors override all color settings above.
If a Clip is both Locked and Muted, the Mute color is used.
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Defining Custom ColorsDefining Custom Colors
You can redefine all colors on the Color pop-up menus, as well as the colors for various other elements in
the Audio Montage. This is done in the Audio Montage Colors dialog, using the following procedure:
1. Pull down the View menu and select Audio Montage Colors.

The Audio Montage Colors dialog appears. For the menu item to be available, the active window must
be a Montage window.

2. Use the Items list to select the element for which you want to edit the color.
By clicking the plus sign next to a heading, you display the sub-elements for that item. The available
elements are described here.

3. Use the three sliders (red, green and blue) to adjust the color of the selected element.
The current color is displayed in the field to the right. You can also see the changes in the Audio
Montage window, while you are editing.

- If you are editing a Clip Color element, you can make separate color settings for the left and right sides
of stereo Clips.
If you want the same color for the left and right sides, you must make sure that the checkbox Edit
Left/Right is activated (it is by default). When this is activated, settings for the left side of a Clip are
automatically "mirrored" on the right side, and vice versa.

- If you activate the Link Sliders checkbox, you can adjust all three sliders at once, by moving one of
them.
This is useful if you want to adjust the brightness of the color, without affecting the hue.

- Some elements can be hidden totally, by activating the Hide checkbox.
When this is activated, it is not possible to make any color adjustments (since the element won’t be
visible in the Audio Montage anyway).

- It is also possible to select colors from a standard Windows color dialog, opened by clicking the Select
button.

4. If you make a mistake, you can Undo your latest adjustment by clicking the Undo button.
To Undo all changes you made since you opened the Audio Montage Colors dialog, click Undo All.

5. If you want to apply the same color to several elements, you can use the Copy and Paste buttons.
Set up the color, click Copy, select the next element and click Paste to apply the same color settings.

- You can also copy a whole color scheme (for example, copy all settings for one of the Custom schemes
to the Default scheme) by dragging and dropping in the Items list.

6. If you are editing one of the Color definitions (the items that appear on the Track, Group and Clip
Color menus), you can rename the Color by clicking on the name in the Item list and typing a new
name.
In the Items list, the renamable Color definitions are displayed in blue.

7. When you’re finished, click Close to close the window.
- There are many items of different color displayed in a Montage. If you redefine colors, be careful not to

choose colors which cause some elements to "disappear" (e.g. black marker lines on a black
background).

The Color ElementsThe Color Elements
In the Audio Montage Colors dialog, you can edit the color settings for the following elements.
Clip Colors
Under the heading Clip Colors, you can select colors for various elements in the following Clip types:

TypeType DescriptionDescription
Crossfade Region Allows you to set the background color for overlapping Clip sections.
Default The default colors, used for Clips for which you haven’t selected any specific color.
Locked The colors used for all locked Clips.
Muted The colors used for all muted Clips.
Others These options correspond to the items on the Color submenus (on the Track menu,

Clip context menu and Groups View : Grouping menu). You can rename these if you
wish.

For each item, you can select colors for a number of different Clip elements. For mono clips, the "Left
(mono)" settings will be used.
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The following color elements are available:

ElementElement DescriptionDescription
Background The background color of the Clip.
Background (sel. range) The background color in a selection range within a Clip.
Background (selected) The background color in a selected Clip.
Waveform The waveform color.
Waveform (sel. range) The waveform color in a selection range.
Waveform (selected) The waveform color in a selected Clip.
Edge The left and right edge of the Clip.
Edge (sel. range) The left and right edge, if within a selection range.
Edge (selected) The left and right edge, if the Clip is selected.
Axis (level zero) The color of the horizontal dotted line in the middle of a Clip, indicating

zero level.
Axis (50% level) The color of the horizontal dotted lines halfway up and down from the

middle of a Clip, indicating 50% level.
Channel separator (stereo clip) The line dividing the two sides in a stereo Clip.
Clip name The name label of the Clip.
Focused Clip name The name label of the focused Clip.
Focused Clip name background The name label background of the focused Clip.

- For the Crossfade region item, you can only select colors for Background and Background (sel. range).

Miscellaneous Colors
This section of the Items list in the dialog contains color settings for other elements in the Track View:

ElementElement DescriptionDescription
Background The background color of the Track View.
Background (selected) The background color in selected ranges.
Cursor The color of the Montage Cursor. Note that because of the blinking Cursor, the

selected colors will appear in inverse video in the Montage.
Marker The color of the Marker lines in the Montage.
Cue-Point The color of the vertical dotted cue-point lines.
Marker (source) The color of Marker lines from the source Wave windows (shown in Clips if the

option "Show source’s ruler and markers" is activated on the Clip context menu).
Time Ruler (source) The color of the source Ruler (shown in Clips if the option "Show source’s ruler

and markers" is activated on the Clip context menu).
Time Grid The color of the Time Grid (see The Ruler).

File HandlingFile Handling

Saving the MontageSaving the Montage
You save the Montage using the Save or Save As commands on the File menu. Audio Montage files have
the extension ".Mon". A couple of things to note:
- The Montage files do not contain any audio data in themselves.

Rather, they contain references to audio files. This means that you must make sure not to delete, move
or rename any audio files referenced by Montages.

- If the Audio Montage contains Clips that reference to untitled audio files, you will have to save these
audio files before you can save the Audio Montage.
WaveLab can save Montages automatically, if you wish (see Backing up Montage).
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Saving a Montage TemplateSaving a Montage Template
Once you have set up the Audio Montage window the way you want it, you can save it as a template. The
template file contains all settings and options in the Montage, but no Clips. Next time you create a new
Audio Montage (by selecting New Montage on the File menu), the template file is used as a basis for the
new Montage. This allows you to create a custom Track layout and other settings, once and for all.
- To save a template, pull down the File menu and select "Save as template..." from the Save Special

submenu.
You can only have one Montage template - saving a template will overwrite the previous template.

When a new Montage is created based on the template, the new Montage will automatically get the sample
rate saved in the template. To change this, you need to select Edit Audio Attributes from the File menu and
select another sample rate in the dialog that appears.

Opening Montage filesOpening Montage files
To open a saved Audio Montage (.Mon) file, pull down the File menu and select Audio Montage... from
the Open submenu.
- If any of the audio files referenced in the Montage cannot be found, you will be asked to locate them

manually.

Closing the MontageClosing the Montage
Closing the Montage is done as with any document window, by clicking the window’s close button or by
selecting Close from the File menu.
- If you have unsaved changes, you will be asked whether you want to save the Montage before closing it.
- If you have recorded audio files in the Montage, and close the Montage without saving it, the recorded

files will automatically be erased.

Cloning MontagesCloning Montages
There are two ways to make a "clone" of an Audio Montage: "Quick Cloning", in which the new Clips will
reference to the original audio files, and "Full Cloning", in which the actual audio files are cloned as well,
creating a new "self-contained" Montage.
Quick Cloning
This method is useful if you want to create several versions of the Montage, for example experimenting
with variations. Note however, that any processing or editing you apply to the actual audio files will be
reflected in both Montages, since they share all file references.
1. Select the Edit View by clicking the Edit tab.
2. Pull down the Edit View : Special menu and select "Quick cloning (reuse audio files)".

A clone of the Audio Montage is created and appears in a new untitled window.
You can also create a "quick clone" by clicking the Document button of the Audio Montage window and
dragging to an empty area in the WaveLab window.
Full Cloning
There are several uses for Full Cloning.
- Since the cloned Montage will have its own audio files, you can edit and process these files without

affecting any other Montages.
- It is also a good way to "pack" the Montage, removing all unused audio sections.
- Even if you don’t need a copy of the Montage as such, you can use this feature to split audio files and

give them specific names (using the "Create exactly one file per clip" option).
Note that Full Cloning doesn’t render effects to files (as does the Apply function). It merely "re-maps" file
references.
Proceed as follows:
1. Select "Full Cloning (recreate audio files)...", either from the Edit View : Special menu or from the Save

Special submenu on the File menu.
A dialog appears.

2. Specify a path and file name for the Audio Montage clone.
If you specify a folder that doesn’t exist, it will automatically be created. The cloned audio file(s) will be
stored in the same folder as the Audio Montage clone.

3. Select one of the "How to recreate audio files" options.
The options are described in the context sensitive help for the dialog.



How to...How to... WavWaveLab 3eLab 3

110110

4. If you later want to be able to lengthen the Clips in the cloned Montage, you need to specify a Clip
margins value greater than zero.
This feature allows you to add a specified number of seconds before and after the beginning and end of
the Clip range in the created audio files. This is only relevant if you have selected any other option than
the first one ("Recreate exact audio files").

5. If you want the Clips in the cloned Montage to have the names of their respective audio file, activate the
option "Reset Clip names from file names".

6. If you want the markers in the original audio files to be included in the cloned files, activate the option
"Copy wave markers".

7. Click the Schedule tab to make settings for Priority, Completion, etc.
The options are the same as when using the Apply function in the Master Section (see the context
sensitive help for the dialog). Note that the process will happen in the background, allowing you to
continue working in WaveLab (although not with the Montage being cloned).

8. Click Clone.
The audio files and the Montage are cloned. When finished, the cloned Montage will appear in a new
Montage window.

Backing Up MontagesBacking Up Montages
The Audio Montage has a special backup mechanism, which allows you to maintain previous versions of
saved Montages, and have the Audio Montage automatically saved. It works in the following way:
- Each time you save the Audio Montage, the previously saved version is copied to the subfolder

"Backup.mon" (in the same folder as the Audio Montage file).
This backup folder is automatically created by WaveLab. The backup files are named "Montage_#X",
where "Montage" is the name of the Montage and "X" is a number.

- You can specify how many previous versions you want to keep.
The maximum number of stored backup versions is 1000 (this is possible since Montage files are small,
containing no audio data). Once the specified number of backups has been created, the oldest file will
be overwritten each time the Montage is backed up.
This means that the numbers in the backup file names are not related to the age of the backup files.
Instead, you need to check the dates of the files to know which backup is the most recent.

- "Untitled" Montages (that are not yet saved) are also backed up.
The backup files for "Untitled" Montages are saved in the Windows temporary folder, and use a
number as Montage name, so that the files are called "Y_#X", where "Y" is a number identifying the
Montage and "X" is the number of the backup file. Once the Montage is saved, these "temporary
backup files" can be discarded.

Setting Up
You make backup settings in the History View:
1. Select the History View by clicking the History tab.
2. Pull down the History View : Backup menu and select "Backup options...".

The Backup options dialog appears.
3. Specify how many previous versions you want to keep (0 to 1000), in the "Number of backups" field.

Setting this to 0 is the same as turning off the backup for the Montage.
4. Activate the Auto save checkbox if you want WaveLab to automatically save the Montage.

Use the value field to the right to specify how often the Automatic save should be done (every 5 to every
120 minutes).

5 Click OK to close the dialog.
Opening the Previous Version
This feature on the History View : Backup menu works in the following way:
- If there are no unsaved changes in the Audio Montage, the most recent backup file is opened in a new

window.
- If you select the function from an open backup file, the previous backup version is opened, etc.
- If the Audio Montage has unsaved changes, the saved Montage file is opened in a new window.

This is not the same as "Revert to saved" on the File menu! The difference is that "Revert to saved" will
close the current (unsaved) Montage and open the last saved version, effectively replacing the current
Montage, while "Open previous version" will open the saved version in a new window, without closing
the current, unsaved version.
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Saving individual ClipsSaving individual Clips
It is possible to save a Clip as a file in its own right. For example, this is useful if you have created a perfect
fade, envelope or Clip effect configuration, but want to continue experimenting with the Clip in the
Montage. By saving the Clip, you can always revert to the "perfect" version later on, simply by loading it
again.
You save Clips in the following way:
1. Select the Clips View by clicking the Clips tab.
2. Select the Clip you want to save, and make sure it is focused.

A focused Clip is indicated by a highlighted name label in the Track View.
3. Pull down the Clips View : File menu and select "Save focused clip as...".

A file dialog appears.
4. Select a location and name for the Clip.

Clip files have the extension ".CLI".

Loading ClipsLoading Clips
You load saved Clip files in the following way:
1. Position the Montage Cursor at where you want to insert the Clip.
2. Click on the Track Control Area for the Track on which you want to add the Clip.

As usual, you need to select a stereo Track for stereo Clips and vice versa.
3. Select the Clips View by clicking the Clips tab.
4. Pull down the Clips View : File menu and select "Load and insert clip(s)".

A file dialog appears.
5. Locate and select the Clip(s) you want to load.
6. Click Open.

The Clip(s) are inserted on the selected Track. If you selected more than one Clip, the first one will be
positioned at the Montage Cursor, and any following Clips will be spaced according to the Default Pre-
Gap time (set on the Edit View : Options menu). When you import several files, the Clips will be
ordered alphabetically after the file names.

- If any of the Auto-Grouping options are activated in the Edit View, Clips to the right of the insertion
point will be moved to the right to "make room" for the inserted Clips.

- If "Track Auto-Grouping" is activated, only Clips on the same Track are moved. If "Global Auto-
Grouping" is activated, Clips on all Tracks are moved.

- It is also possible to load Clips via drag and drop from the Files View.
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Synchronnize WaveLab to external equipmentSynchronnize WaveLab to external equipment

Sync - IntroductionSync - Introduction
It is possible to synchronize the audio playback in WaveLab to incoming MIDI Time Code (MTC). This
allows you to play audio from WaveLab together with stand-alone recorders, MIDI sequencers etc. This is
probably most useful when playing back Audio Montages, but you can also synchronize playback of
regular Wave files.
- For MTC Sync to be possible, you need to have a MIDI Interface installed and working!
About MTC and Word clock
MIDI Time Code provides timing information, so that each time position coincides in the master (the other
recorder, MIDI sequencer, etc) and the slave (WaveLab). However, there is still one problem: Even though
WaveLab starts playback of an audio file at the exact correct position, it cannot affect the timing of the
audio file once playback is started. At that point, the playback of the audio file is only dependent on the
clock on the computer’s audio card.
Let’s say you are syncing WaveLab to a tape recorder providing MTC. As the clock on the computer’s
audio card and the internal clock of the master (in this case the tape recorder) are not synchronized, the
audio file(s) played back by WaveLab and the tape tracks will inevitably be drifting out of sync after a
period of time.
The solution is to not only synchronize WaveLab, but also the audio card! This means that you need:
- A synchronization device that can send both MTC and word clock.
- An audio card that can read and synchronize to incoming word clock.
With this setup, the master device sends MTC into WaveLab (ensuring that audio playback starts at the
correct time position) and word clock to the audio card (ensuring that audio playback continuously follows
the master device.
It is worth noting that without using a word clock based system, it is possible to synchronize WaveLab
with another device for a shorter period of time. Exactly how long depends on a number of factors, such as
the overall stability of the system (using an ADAT as master will provide higher stability than using an
analog tape machine for example) and the length of the audio files played by WaveLab etc.
Also note that if a project involves using several different types of machines as the master, the result (for
how long synchronization can be upheld) is likely to vary in an unpredictable way. For best results when
using synchronization without word clock, it is recommended that you use a fixed (and relatively stable)
setup during the course of the project.

Setting UpSetting Up
1. Make sure the desired Montage or Wave window is active.

This is important, since each Montage or Wave can have separate Sync settings.
2. Pull down the Options menu and select Preferences.

The Preferences dialog appears.
3. Click the Sync tab.
4. Pull down the MIDI Input pop-up menu and select the MIDI Input port to which your synchronization

device is connected.
If the time code in the master device is offset (so that playback starts at a time position other than zero),
you need to compensate for this in WaveLab by setting the SMPTE Offset parameter to the same value.

5. If the SMPTE Offset is positive, click the [+] button next to the SMPTE Offset parameter. If it is
negative, click the [–] button.

6. Set the SMPTE Offset parameter to the time position where you want playback to start.
This should be set according to any offset values in the master device, so that both devices have the
same start position. The offset value is subtracted from (plus button activated) or added to (minus
button activated) the incoming time code. Usually, positive offset values are used. If you edit this value
during playback you have to Stop and Restart for the change to take effect.

- Each Audio Montage can save its own SMPTE offset. When you edit the offset in the Preferences
dialog, you actually edit the offset of the currently active audio document.

7. Leave the Time Correction parameter at 0 for now.
You may need to adjust this later on, as described below.

8. Click OK to close the dialog.
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Activating syncActivating sync
To activate sync in WaveLab, proceed as follows:
1. Click the Playback Start Position button to the left on the Transport Bar.

A pop-up menu appears.
2. Select the item "Sync from MIDI Time Code" at the bottom of the pop-up menu.

The button changes shape to a MIDI symbol, to indicate that WaveLab is in Sync mode.
- You can also activate Sync mode by pressing [F9] on the computer keyboard.
Now, WaveLab is expecting MIDI Time Code, and will start playback when the master device is started. If
the MIDI Time Code stops, WaveLab will stop playback but remain in Sync mode. You can also do the
reverse: start the master (generating MTC), then press F9 to start WaveLab in sync.
- If you find that there is a slight, constant offset between the master and slave, you need to adjust the

Time Correction parameter until you get it right, either by stopping playback and going back to the
Preferences dialog, or by Nudging (if you are playing back a Montage; see Nudging).
Although rare, such an offset could occur due to audio card latency, "slow" MIDI equipment, the
coarseness of the MTC signal, etc.

3. To exit Sync mode, select another Playback Start Position option from the pop-up menu, press [F9] or
stop playback manually.

Nudging Sync OffsetNudging Sync Offset
- This is only possible when playing back an Audio Montage. For general information about Nudging,

see Nudging.
For various reasons, you may find that there is a slight constant offset between the master and the slave
during synchronized playback. This is adjusted with the Time Correction parameter in the Preferences-
Sync dialog. However, trying to guess the correct Time Correction value in Stop mode can be a time
consuming process. Instead you can Nudge the Time Correction value during playback and use your ears
to find the optimal setting:
1. Pull down the Edit View Options menu and select "Synchro Offset (SMPTE)" from the Nudge

submenu.
You may also want to deactivate the "Auto Select" option on the Nudge submenu, to avoid accidentally
changing Nudge target.

2. Activate synchronized playback as described in the previous Sync topics.
3. If WaveLab’s playback is "behind" the master, click the right Nudge icon or press [F12].

This will skip samples, effectively "speeding up" WaveLab’s playback. This may cause some clicks just
after you Nudge.
The timing adjustment will be audible after the playback latency time (displayed in the Preferences
dialog, Audio Card tab).

4. If WaveLab’s playback is "ahead of" the master, click the left Nudge icon or press [F11].
This will add blank samples, effectively "slowing down" WaveLab’s playback. This may cause some
clicks just after you Nudge. Furthermore, these blank samples will have to be played back, resulting in a
short silence, during which the Montage Cursor will stay flickering in one place.

As when Nudging other Montage elements, you can use modifier keys to determine the Nudge "impulse":

ModifierModifier ImpulseImpulse
None (standard impulse) One frame.
[Shift] (large impulse) One second.
[Ctrl] (small impulse) 1/10 frame.
[Ctrl]+[Shift] (micro impulse) 1/100 frame.

These values are fixed, and are not affected by the current setting in the Nudge Impulse dialog.
5. Repeat the Nudging procedure until you find the optimal setting (no audible offset between master and

slave).
6. Stop playback.

Now, your adjustments are added to the current SMPTE Offset and/or Time Correction settings in the
Preferences dialog, so that next time you start playback, the two devices will be in sync.
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Again, the purpose of this function is to adjust for any constant offset between master and slave. It is not
meaningful to use this for compensating for drifting sync (in a setup without word clock). Also note that
this is a function for fine adjustments, ± a few seconds at most.

Checking incoming Time CodeChecking incoming Time Code
You can inspect the incoming MIDI Time Code in the following way:
1. Enable Sync Mode as described above.

The Time Code display will only be updated in Sync mode.
2. Open the Monitor window from the Windows submenu on the View menu.
3. Click the Timecode tab at the bottom of the Monitor window.

Now, the Monitor window serves as a time code display, indicating incoming time code in the format
Hours:Minutes:Seconds,Frames:
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Write CDsWrite CDs

Intro and PreparationsIntro and Preparations

IntroductionIntroduction
WaveLab now has the ability to write red book compatible CDs using many different CD-R drives. This
allows you to create real CDs, complete with adjustable pauses, sub-indexes and automatic "PQ-coding".
In this help file you will find:
- CD Program handling and CD- writing procedures.
- CD background information.
- Troubleshooting.
- Lists of supported CD-R units.

The CD ProgramThe CD Program
The CD Program is the key to WaveLab's ability to burn real "red book compatible" CDs. It is in this
window that you assemble the files you want to include on the CD, and make settings for them.
- When a CD Program is active, a new menu appears called CD-Wizard. You can also open this menu

from the top left corner of the CD program window.
- You can have many CD Program windows open at the same time.
- The CD Program is merely a list of the file segments, it does not contain the actual files themselves.

This means that changes you make to the files will be reflected in the list as well. In other words, it is
very important to keep track of changes made to files that are used in several CD Programs, because
these changes will appear in all these lists.

About CD-R recorders - Background InformationAbout CD-R recorders - Background Information
This topic aims to provide you with some background information on the CD format, to help you better
understand how to create your own. This is a big subject, and we will only be able to touch upon it here.
For more information, try a text book on the subject, or search the Internet for more information.
The basic CD-formats
There are a number of different formats for the contents of a CD disc. You are probably familiar with audio
CDs, CD-ROMS, and CD-I. These are all slightly different, although they use the same media - CD discs.
The audio CD specification is called "red book". It is this standard that WaveLab conforms to.
Red Book CD is not a real file format
Those of you who are computer literate, might know about file formats. Please note that red book CD is
not a real file format. All the audio on the CD is stored in one big chunk, one file if you will. This is
different from hard disks for example, where each file is stored separately. Understanding the fact that all
the audio is in fact one long stream of digital data, is something that will probably help you to
betterunderstand the limitations of the format.
The different types of "events" on an audio CD
There are basically three types of events that that can be used to specify various sections of audio on the
CD. These are:
Track Start There can be up to 99 Tracks on one CD. Each is identified by its start point only.
Track Sub-Indexes On advanced CD players, you might have noted that a Track can be divided into Sub-

Indexes (sometimes just called Indexes). These are used to identify "important"
positions within a Track. There can be 98 Sub-Indexes in each Track. However, since it
is difficult and time-consuming to search for and locate to Sub-Indexes, many CD
players simply ignore this information.

Pause A pause appears before each Track. Pauses can be of variable lengths. Some CD
players indicate the pauses between Tracks on their displays.

About Frames, positions, small frames and bits
The data on an audio CD is divided into frames. A frame consists of 588 stereo samples. 75 frames make
up one second of audio. Why? Well 75*588= 44100, and since the sampling frequency of the CD format is
44100kHz (samples per second), this equals one second of audio. When you specify positions on the CD,
in WaveLab, you do it in the format mm:ss:ff, where mm is minutes, ss is seconds and ff is frames. The
frame values go from 0 to 74, since there are 75 frames to a second.
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Technically, there is no way to specify something smaller than a frame on a CD. One effect of this is that if
the length of a Track on the CD does not equal a perfect number of frames, some blank audio must be
added at the end. Another effect of this is that when you play the CD, you can never locate (position) to
anything closer than a frame. If you need some data in the middle of a frame, you still have to read the
whole frame. Again, this is unlike a hard disk, where you can retrieve any byte on the disk, without reading
the surrounding data.
But a frame isn't the smallest block of data on a CD. There is also something called a "small frame". A
small frame is a container of 588 bits. 98 small frames together make up one regular frame. In each small
frame there is actually only room for six stereo samples, which means that a lot of space is left for other
data than the actual audio. There is information for encoding, laser synchronization, error correction and
the PQ data (named so "simply" because they are stored in the "P" and "Q" bits). This PQ data is of major
importance to anyone who wants to create their own CD, so please let us explain it in further detail.
PQ codes and WaveLab's solution for handling them
The PQ codes convey information about Track Start, Sub-Indexes and Pauses, as described above. They
also contain the timing information (minutes, seconds, frames). To fit all this information in, a block of PQ
information is spread out over 98 small frames.
Specifying PQ codes is not complex. However, when creating a CD there are a number of rules you must
take into account. For example, there should be some silent frames before each track, Sub-Indexes should
be slightly early, there should be pauses at the beginning and end of the entire CD, etc.
In WaveLab, all these hidden rules are collected in a dialog box called "Advanced Settings". If you don't
change these, you will get default values that ensure your CD will work properly. On the other hand, when
the situation so requires, you can adjust them. We recommend you leave these settings as they are, unless
you are completely sure of what you are doing.
ISRC codes
In addition to the basic PQ codes, there is something called "International Standard Recording Code",
identification that is only used on CDs intended for commercial distribution. WaveLab allows you to
specify an ISRC code for each audio track but only if your CD-R burner supports it.
The ISRC code is built up as follows:
- Country Code (2 ASCII characters).
- Owner Code (3 ASCII characters).
- Recording Year (2 digits).
- Serial Number (5 digits).
UPC/EAN codes
UPC stands for "Universal Product Code". Some CD-R units allow you to specify this code, which is a
thirteen-digit catalog number for the disc. Also known as EAN.
Disc-At-Once - Writing CD-R's for duplication into "real" CDs
WaveLab only writes audio CDs in Disc-at-Once mode. There are three good reasons for this:
If you want to create a CD-R to use as a master for a real CD production, you must write the CD-R in
Disc-At-Once mode. In this mode, the entire disc is written in one pass, without ever turning of the
recording laser. There are other ways of writing a CD, namely Track-At-Once and MultiSession. If you use
these writing formats, the "link blocks" created to link the various recording passes together will be
recognized as "uncorrectable errors" when you try to master from the CD-R. These links can also result in
clicks when playing back the CD.
Disc-At-Once mode provides more flexibility when specifying pause lengths between tracks.
Disc-At-Once is the only mode that supports Sub-Indexes.
Writing on the fly vs CD images
WaveLab always writes a CD on the fly, that is, it does not create a CD image before burning. This
method makes writing CDs faster and requires much less disk space. However, if for some reason you need
to, WaveLab lets you join all audio tracks in a CD Program into one large file that can be used as an
"image" of the entire CD.
Supported CD-RecordersSupported CD-Recorders
For CD writing, WaveLab uses a software engine developed by the company CeQuadrat (this company
has also developed "WinOnCd" and "WinToGo"). This software engine relies on driver files placed inside
WaveLab’s System folder. You will be able to find new versions and additional drivers on the CeQuadrat
Internet site (http://www.cequadrat.com) whenever they become available. These files will also be
distributed with updates of WaveLab, please check the Steinberg Internet site (http://www.steinberg.net)
regularly.
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WaveLab will work with all CD recorders supported by CeQuadrat (we don’t provide a list here since it is
updated regularly), as long as they support the "Disk-at-once" mode  (required to create fully red book
compatible audio CDs).
Finally, please note that not all devices support all of WaveLab's functionality. For example, some devices
do not support track "Sub-Indexes" (which is not required for most applications).

Preparations and Installing the CD RecorderPreparations and Installing the CD Recorder
WaveLab settings
If CD burning will be your main activity in WaveLab, we recommend you to open the Preferences dialog,
click the File tab and select the "Optimize for huge files" mode.
For all general instructions on installing SCSI cards and CD-R recorders, please refer to the instructions
that came with the computer, Windows, the SCSI controller and the CD-R recorder itself.
For WaveLab, please just check the following points:
• Make sure you have the latest firmware version installed in your CD-R unit. The firmware you have

must support Disk-At-Once mode! In addition, running a unit with an older firmware might for
example prevent you from writing Sub-Indexes into the Tracks.

• It is not required by WaveLab that you have a general Windows driver installed for the unit, since
WaveLab has built in drivers for all the supported units. If you need to install (or already have installed)
another driver for the unit, please be aware that there are possibilities for driver conflicts. If things seem
to work well, don't do anything. If you run into problems, check the Troubleshoooting section.

Working with Track Lists and MarkersWorking with Track Lists and Markers

Creating, Opening and Saving CD ProgramsCreating, Opening and Saving CD Programs
• To create a CD Program, pull down the File menu, select New, and from the sub-menu that appears,

select CD Program.
You will see a blank window that you can fill with entries, as described under the topic Adding files to a
CD Program.

• To open an already existing CD Program, select Open from the File menu, and CD Program from the
sub-menu that appears. Alternatively, use the list of recently opened files at the bottom of the File
menu.
When you open a CD Program, all the files to which it refers are actually also opened. However, they
do not appear in Windows. If some files that are part of the CD Program can't be found, a warning
message appears.

• Once you have created your list, you can save it to disk like any other file, using the Save and Save As
commands.

Adding files to a CD ProgramAdding files to a CD Program
What audio file formats can be used?
You can add any type of file to a CD Program. However, when it is time to burn the CD, the files in the list
must meet the following specifications:
- 44100 Hz (44.1kHz).
- Mono, dual-mono or stereo.
- 8, 16, 20 or 24 bit resolution.

The files will be converted to 16-bit stereo on the fly, during the CD burning process.
• A given track can only appear once in each CD Program!
Using Add Track
This item, on the CD Wizard menu (which only appears if the active window is a CD Program) is used to
add Tracks directly from disk.
1. Select Add Track from the CD Wizard menu.
2. In the File dialog that appears, select as many files as you wish.
3. Click OK.

The files are now added to the list:
- If the file contains CD Start and Sub-Index markers, these are used to define the Track in the list.
- If there are several sets of markers, there will be several Track entries in the list, all "pointing" to this

file.
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- If the file does not contain any markers, a dialog box will ask you if you want to use the file start and
end as boundaries for the Track. Click OK, you can always move the markers later, to redefine the
positions.

By dragging a Waveform Selection
If you already have a Wave window open, you can drag and drop selections from it to the Track list.
1. Make a selection.

There are numerous ways of making selections. For instance, double click between two markers to
select all audio between them.

2. Position the mouse pointer over the waveform, inside the selection area and drag and drop in the Track
List.
The selection appears as a Track. If there are Sub-Index markers inside the selection, they will be part of
the Track.

By Dragging or Copying and Pasting between CD Programs
If you have several CD Programs open, you can drag and drop between them.
1. Point at a Track item in a list.
2. Press the mouse button and drag and drop the Track item into another list.

You can also use Cut, Copy and Paste to achieve the same thing:
1. Select an item in one Track list.
2. Select Cut or Copy from the Edit menu.
3. Select another CD Program.
4. Select Paste from the Edit menu.

Setting the order of Tracks on the CDSetting the order of Tracks on the CD
Once you have all the files you need in the CD Program you might want to set the order they will appear
on the CD.
Determining the current order
1. Pull down the CD Wizard menu and select "Sort by Track order".
2. Check the numbering on the side of the list, it is now consecutive and the list reflects the order of the

Tracks on the CD.
Changing the order using Drag and Drop
1. Position the mouse pointer over the name of the Track you want to move to another position.
2. Drag and drop it somewhere else in the list.

The items are resorted to reflect the new order.
Changing the order using the keyboard
1. Select the Track you want to move up/down.
2. Hold down [Control] and press the Up/down cursor keys.

The file is moved up/down, accordingly.

Deleting files from CD ProgramsDeleting files from CD Programs
There are two ways to remove a file from the Track list:
• Select it and select Delete from the Edit menu or press [Backspace].
• Drag-and-drop the track onto the trash icon.

The file disappears from the list, but is of course not deleted from the hard disk.

Managing List columnsManaging List columns
There are a couple of changes you can make to your Track columns:
• You can change the width of each column, by dragging the dividing lines between the headings

left/right.
• You can hide/show each column by clicking with the right mouse button on a heading, and select from

the menu that appears.
• You can click on the Title header to switch between three modes, which show various amounts of

details about the files the Tracks belong to. This also switches the sort modes between "Sort by Track
order" and "Sort by File".

• You can also use the CD Wizard menu (which only appears when the CD Program is the active
window), to switch between "Sort by Track order" and "Sort by File".
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Setting up a Track in the listSetting up a Track in the list
"Unfolding" a Track
Just like in the Explorer and other Windows 95 programs, you can unfold a Track, to reveal additional
settings. This can be done either by clicking the "+" and "-" symbols or by selecting the Track and using the
[+] and [-] keys on the numeric keypad.
What information is available about a Track?
For any Track you can see the following information in the columns:
Start time This shows you how far in on the CD this Track will start (in the format

minutes:seconds:frames). The Start time is calculated from the length of the
preceding Tracks.

Length This value is calculated from the position of the Track End marker, see below.
Various Settings These are all described below.

When a Track is unfolded the following additional information is shown for it:
Pause This is the pause that will precede the Track. The columns show the Start (this is a

negative value since the pause starts before the Track) and the Length of the pause.
Track Start This is a representation of the marker that indicates the Start of the Track. The

columns show the Start (always 00:00:00) and Length (calculated from the position
of the previous Track End marker, see below).

Sub-Index Markers These indicate any Track Sub-Index markers that have been defined for the Track.
The columns show the Start (the position of the marker) and Length (the time from
this marker to the next Sub-Index marker or the End of the Track, whichever occurs
first).

Track End This is a representation of the marker that indicates the end of the Track.
Adjusting Start/End points and Sub-Indexes
The items indicated by markers in the list are not adjusted in the list itself, but in the audio files! To open an
audio file for editing the markers, just double-click on the Start time field, in the list. For more information,
see the section on Markers.
Adjusting Pauses
Each Track has a pause setting. This pause will be played before the beginning of the Track.
• To change the length of the pause, double click on the value (the dark red digits). As usual, you can

right click on the numbers (after double clicking) to set the value using a slider.
Naming Tracks

• If you hold down [Alternate] and double click on a Track name, you can edit it (to be precise, what you
are editing is the name of the CD Track markers in the audio file). Please note that this name is not
stored on the CD (CD Tracks don't have names), and naming is only for your convenience.

Other settings
For background information about the following fields, see About CD-R recorders - Background
Information.
- The ISRC field can be edited by double clicking.
- The comment field is also edited by double clicking. This text is not stored on the CD, it is only here for

your convenience.
- The Key symbol indicates a track copy protection "flag" (on/off setting). Click here to activate

/deactivate this flag. Please note that this setting is hardly ever used nowadays, and not all CD-R units
can even handle it. Normally you will leave this off.

- The little Rainbow colored symbol indicates the Emphasis "flag". This setting is used to indicate if the
Track was recorded with emphasis or not. Please note that this does not apply/remove emphasis from
the audio, it is just an indication of how the file was created. Normally you will leave this off.

There is a shortcut for the last two settings: To set all Tracks to the same value, double click on the column
heading instead of the actual Track item.
Checking the Total Length of the CD
The total length of the CD is displayed at the bottom of the CD Program window.

Working with CD-MarkersWorking with CD-Markers
CD Markers appear in the audio files. They define the Start, End points and Sub-Index points for Tracks in
the Track list.
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To learn about the various Marker types, open the Edit Marker dialog (select "New Marker" from the time
ruler menu) and use the context sensitive help for the items in the dialog.
You edit and add CD Markers using any of the following methods:
• By adjusting the positions of existing CD markers.
• By converting existing "Generic" or "Temporary" type markers.

This is done by clicking on a marker with the right mouse button and selecting "Edit marker ".
• By adding markers on the fly, and then converting them into CD markers.
• By adding Markers using the New Marker function.
• By dragging waveform selections into the CD Program.
• By making a waveform selection and selection the speed-menu option "Create track from selection".
• By using Add Tracks on files that have not previously been marked for the CD Program.
Remember that if you make a mistake, you can always Undo your actions.
About the relationship between markers in a file
To understand how CD Markers relate to the items in the CD Program, please read the following:
- A Track Start or Track Boundary marker in the actual audio file defines a Track in the CD Program!

Delete the Track Start/Boundary marker, and the Track item vanishes from the list! Also, edit the Track
start or end position, and the change is reflected in all CD programs that include this track.

- Just because you create the markers for it, this does not mean the Track will be added to a CD Program
window. You have to do this "manually", using drag and drop to the desired CD program(s). As a
matter of fact, you can have several Tracks defined in a single audio file, but still decide to only use one
or a few of them in a CD Program.

- Whenever you create a Track Start marker, WaveLab will automatically create a Track End marker at
the start of the next Track or at the end of the file, whichever occurs first. It’s then up to you to adjust
the position of that End marker if necessary.

- WaveLab does not allow Tracks to have a Start without and End, nor will it allow overlapping or
nested Tracks (Tracks inside Tracks). If you try to move Track markers to invalid places (beyond the
end of the file, to a position inside another track, etc.), WaveLab will automatically reorganize the
markers to place them in a valid configuration.

- The Track Boundary Marker indicates the End of one Track and the Start of another. In other words,
it's a combined Start and End marker. If you drop a Start marker after another Start marker, it will
automatically convert into a Boundary marker since you can't have two Starts after each other without
an End between them.

- If you use one file in multiple CD Programs, beware that any changes you make to the audio file will be
reflected in all CD Programs!

- Sub-Index markers can be added between Starts and Ends as required. The only limitation is that there
can only be 98 Sub-Index markers per Track. You can’t insert a sub-index out of a CD track. If you
move a sub-index out of a CD track, it is deleted.

- Whenever you insert a sub-index, its position is quantized to a CD frame (1/75th of a second, or 588
audio frames) in relation to the Track start. If you move the CD Track Start marker, then all Sub-Index
markers will need to be re-quantized. You will be warned about this via an alert box. This is usually not
a problem, since you will normally only start defining Sub-Indexes once your start and end points have
been established.

Playing files in the Track listPlaying files in the Track list
There are several ways to play back a file in a CD Program.
• Click with the right mouse button in the Track column for an item (any type of marker will work), and

select from the menu items.
The items should hopefully be self-explanatory. Please note that clicking on a Track End marker allows
you to play a transition between two Tracks with a short pre-roll time.

• Double click on a Track name, or select it and press [Enter] or [F8].
This plays the entire list, from that point and on, including pauses. Hit [F7] or [0] on the numeric key
pad to stop.

• Double click on a Length field.
This plays the section between this and the next marker.

• You can drag and drop a Track title onto the Play button on the Transport bar.
This is the same as double clicking on the Track name.
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- Please note that what you hear during playback is identical to the way the audio will be played back
from the actual CD - all pause and other adjustments are taken into account (this includes the
Advanced Settings unless otherwise stated).

- During playback, a progress bar appears at the bottom of the window. There will be no play cursor in
the actual wave window.

- During playback, you can toggle between track-local time and CD-global time by clicking on the time
counters in the bottom right corner of the CD Program window.

- Changes to markers are not taken into account during playback (you need to stop playback and start
playback again).

Playing back via the Master Section
To make the audio play back through the Master Section, activate the corresponding option in the CD-R
tab in the Preferences dialog box, and open the Master window. The default setting for this is OFF.

Other CD OperationsOther CD Operations

Opening CD Tracks for wave editingOpening CD Tracks for wave editing
There are several ways to open a CD Program item, in a Wave window, for editing:
• Double click on the Start time field.

This opens the Wave window and selects the entire track. If you double clicked on a Sub-Index marker
or on a Track End marker, the Wave cursor is moved there. Otherwise the cursor is moved to the Track
Start marker.

• Drag and drop a Track item, a Track Start marker or a Pause item onto the WaveLab background
(outside all document windows).
This opens the corresponding wave window and selects the area inside the Track boundaries.

• Drag and drop a Sub-index or Track end marker onto the WaveLab background (outside all document
windows).
This opens the wave window and moves the Wave cursor to the corresponding position.

• Drag and drop a CD track onto an already open audio file window.
This inserts the Track into the file, as when you drag and drop between Wave windows. Please note
that this must of course be a window for another file.

Testing a CD Program before burningTesting a CD Program before burning
There are two ways to check a CD before burning:
Check
The "Check" command on the CD Wizard menu scans through the CD Program and checks that the
settings conform to the CD standard. This command does not access the CD-R recorder in any way, it only
checks the setting in the list against a set of rules. These rules are described under the context sensitive help
for the Check menu item.
This check is automatically performed when you try to actually burn a CD.
"Test 1 track" and "Test All Tracks"
These two options in the Write CD dialog (also reached from the CD Wizard menu) actually simulate
writing one or all Tracks to the CD burner. This takes all settings into account, including the writing speed
(1x, 2x, etc.).
- If the test fails, try writing at a lower speed.
- If the Test All Tracks test passes, you can be almost certain  there will be no problems when writing the

actual CD.

Writing a CDWriting a CD
Once you have set up the CD Program, we suggest the following work order for burning the CD. Please
note that these steps are not mandatory, just a recommendation.
• Please observe the precautions indicated in the Troubleshooting section, before writing your first CD!
1. Listen through the CD once more, from the CD Program window, to check that all starts, ends and

transitions are OK.
2. Select Check from the CD Wizard menu, to check that all settings conform to the red book standard.

This is done automatically before burning, but you might want to do this anyway, to be sure.
3. Insert a fresh CD-R disc into your drive.
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4. Select Write CD from the CD Wizard menu.
5. Use the pop-up menu to select your recorder.
6. From the small pop-up menu, select the speed at which you would like to burn the CD.
7. Use the test options in the dialog to check that you will actually be able to write the CD at that speed.
8. Once the CD Program has passed the test, switch to "WRITE" and press OK in the dialog.

Creating a Disk ImageCreating a Disk Image
There might be situation where you want to "freeze" an entire CD project, without actually burning a CD.
This is done with the "Save As CD Image" command.
1. Set up the Track list so that it is exactly as you want it.
2. Select "Save as CD Image" from the CD Wizard menu.
3. Find a directory for the files (we recommend that you create a new directory, because the "image" is

made up of three different files) and type in a name.
4. Click OK.
Now, the following files are created in that folder:
- A CD Program file, with the specified name. This is the file you should open the next time you want to

access this "CD image".
- A single Wave file, containing all the Tracks, with markers inserted at all the correct positions.
- A marker file with the same name (it is this file that actually contains the markers).
- A peak file for the wave file.

Exporting audio files from a Track listExporting audio files from a Track list
There are situations where you might want to save the items in a CD Program as audio files on your hard
disk. For example:
- For archiving.
- For burning a mixed mode CD in another program.
- When you use the CD Program as a general play list to prepare files for other purposes.
As separate files
To save each file in a CD Program as a separate file, in one folder, proceed as follows:
1. Set up the Track list so that it is exactly as you want it.
2. Select "Save each track as a separate audio file" from the CD Wizard menu.
3. Find a destination folder for the files.
4. Fill out the other options in the dialog.

See the context sensitive help in the dialog for details.
5. Click OK.
Now, each of the Tracks in the list is saved as one file, in the specified folder.
As one file
To turn the entire CD Program into one long file, proceed as follows:
1. Set up the Track list so that it is exactly as you want it.
2. Select "Join all tracks into one virtual file" from the CD Wizard menu.
3. Fill out the other options in the dialog.

See the context sensitive help in the dialog for details.
4. Click OK.

The new file appears in a wave window.
5. Save the file, like any other wave file.

Cue SheetsCue Sheets
Generating Cue Sheets
The Generate Cue Sheet feature allows you to create text files with information about the CD Program.
1. Make sure the CD Program, for which you want to create a Cue sheet, is the active window.
2. Open Generate Cue Sheet from the CD Wizard menu.
3. Click the folder button at the end of the Template line.
4. Navigate your way to the "CDCueSheetTemplate" folder which is located in the System folder inside

your WaveLab folder.
5. Select one of the template files in this folder and click Open.
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6. In the Cue Sheet window, enter a Title, Engineer and Comment.
7. Click OK.

The Cue Sheet appears in a text window.
8. Save the Cue Sheet text file to disk.
Creating Cue Sheet Templates
Creating a cue sheet requires an understanding of computers, and preferably some knowledge about
programming, since it makes use of the "commands and variables" concept.
How Cue Sheet Templates are Organized
Essentially, it works like this: There are a number of "codes", commands and variables, which you place in
a text file - the Template. When you ask the program to generate a Cue Sheet, it creates the text file based
on the "codes" it finds in the Template.
If the program encounters a variable, it replaces this with some information about the CD Program. For
example there’s a variable called "NUM_TRACKS". When the program finds this, it replaces it with the
actual number of Tracks in the CD Program, for example "5", "17" or "99".
Commands, on the other hand, are instructions for the program to do something. For example, the
command "TIMECODE SEPARATOR = " followed by a few special characters, instructs the program
what characters should be inserted between time code values, so that you can get time code values printed
out in the format 00:00:00.00, "00 00 00 00" or anything else you prefer.
Here are the various codes you can enter for specific purposes:

CodeCode DescriptionDescription
$ A variable. The text that follows right after the "$" is the command name, for example

"$TITLE". A variable can occur anywhere on a a line, and there can be any number of
variables on a line.

# A command. The text that follows after the "#" is the command name, for example "#FOR
EACH TRACK". There can only be one command per line and there shouldn’t be anything
else on that line.

; If a line starts with a semi-colon (;), the line is interpreted as a comment. Nothing on such a
line will be used in the Cue Sheet. This is useful for making notes, etc.

All other text characters can be entered on their own lines or among the variables, and will be used as they
are. For example if you type "Title: $TITLE" and the title you have entered is "My Greatest Hits!", the text
"Title: My Greatest Hits" will appear in the Cue Sheet.
Creating a Cue Sheet Template
To create a template, use any text editor and enter the information you want, or open one of the included
templates and modify it as needed. Then save it as a text file and load it in before you generate the Cue
Sheet as described above.

The Available Variables
Track number
Variable/GroupVariable/Group CommeComment:nt:
T0 As decimal number "1" or "22"
T1 Blank Justified Two Digit Number " 1" or "22"
T2 Zero Justified Two Digit Number "01" or "22"

Track index
Variable/GroupVariable/Group Comment:Comment:
I0 As decimal number "1" or "22"
I1 Blank Justified Two Digit Number " 1" or "22"
I2 Zero Justified Two Digit Number "01" or "22"
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Copy Protection status
Variable/GroupVariable/Group Comment:Comment:
C1 "x" or " "
C2 "Y" or "N"

Emphasis status
Variable/GroupVariable/Group Comment:Comment:
E1 "x" or " "
E2 "Y" or "N"

Absolute time of index
Variable/GroupVariable/Group Comment:Comment:
TIME_IA_0 As decimal number
TIME_IA_1 Blank justified 7 digit decimal number
TIME_IA_2 Time as "hh:mm:ss:ff"
TIME_IA_3 Time as "hh:mm:ss:ff"" blank justified e.g. leading zero not displayed
TIME_IA_4 Time as "hh:mm:ss:ff"" compressed e.g. if there are no hours, none are displayed
TIME_IA_5 Time as "mm:ss:ff" (no hours) e.g. no hours displayed at all
TIME_IA_6 Time as "mm:ss:ff" (no hours) blank justified e.g. leading zero not shown, no

hours displayed
TIME_IA_7 Time as "mm:ss:ff" (no hours) no minute displayed if not required, no hours

displayed
TIME_IA_8 Time format as "1h 2mn 3s 4f"
TIME_IA_9 Time format as "1h 2mn 3s"

Index time relative to start of CD
Variable/GroupVariable/Group Comment:Comment:
TIME_IR_0 As decimal number
TIME_IR_1 Blank justified 7 digit decimal number
TIME_IR_2 Time as "hh:mm:ss:ff"
TIME_IR_3 Time as "hh:mm:ss:ff"" blank justified e.g. leading Zero not shown
TIME_IR_4 Time as "hh:mm:ss:ff"" compressed e.g. no hour displayed if not required
TIME_IR_5 Time as "mm:ss:ff" (no hours)
TIME_IR_6 Time as "mm:ss:ff" (no hours) blank justified e.g. if no minute to display
TIME_IR_7 Time as "mm:ss:ff" (no hours) no minute displayed if not required
TIME_IR_8 Time format as "1h 2mn 3s 4f
TIME_IR_9 Time format as "1h 2mn 3s"

Index time relative to start of track
Variable/GroupVariable/Group CommenComment:t:
TIME_IT_0 As decimal number
TIME_IT_1 Blank justified 7 digit decimal number
TIME_IT_2 Time as "hh:mm:ss:ff"
TIME_IT_3 Time as "hh:mm:ss:ff"" blank justified e.g. leading Zero not displayed
TIME_IT_4 Time as "hh:mm:ss:ff"" compressed e.g. no hour displayed if not required
TIME_IT_5 Time as "mm:ss:ff" (no hours)
TIME_IT_6 Time as "mm:ss:ff" (no hours) blank justified e.g. leading Zero not displayed
TIME_IT_7 Time as "mm:ss:ff" no hours) no minute displayed if not required
TIME_IT_8 Time format as "1h 2mn 3s 4f
TIME_IT_9 Time format as "1h 2mn 3s
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Pause Length
Variable/GroupVariable/Group Comment:Comment:
TIME_PA_0 As decimal number
TIME_PA_1 Blank justified 7 digit decimal number
TIME_PA_2 Time as "hh:mm:ss:ff"
TIME_PA_3 Time as "hh:mm:ss:ff"" blank justified e.g. leading Zero not displayed
TIME_PA_4 Time as "hh:mm:ss:ff"" compressed e.g. no hour displayed if not required
TIME_PA_5 Time as "mm:ss:ff" (no hours)
TIME_PA_6 Time as "mm:ss:ff" (no hours) blank Justified leading Zero not displayed
TIME_PA_7 Time as "mm:ss:ff" (no hours) no minute displayed if not required
TIME_PA_8 Time format as "1h 2mn 3s 4f"
TIME_PA_9 Time format as "1h 2mn 3s"

Track Length
Variable/GroupVariable/Group Comment:Comment:
TIME_TR_0 As decimal number
TIME_TR_1 Blank justified 7 digit decimal number
TIME_TR_2 Time as "hh:mm:ss:ff""
TIME_TR_3 Time as "hh:mm:ss:ff" blank justified e.g. leading Zero not displayed
TIME_TR_4 Time as "hh:mm:ss:ff"" compressed e.g. no hour displayed if not required
TIME_TR_5 Time as "mm:ss:ff" (no hours)
TIME_TR_6 Time as "mm:ss:ff" (no hours) blank justified e.g. leading Zero not displayed
TIME_TR_7 Time as "mm:ss:ff" (no hours) no minute displayed if not required
TIME_TR_8 Time format as "1h 2mn 3s 4f"
TIME_TR_9 Time format as "1h 2mn 3s"

CD length
Variable/GroupVariable/Group Comment:Comment:
TIME_CD_0 As decimal number
TIME_CD_1 Blank justified 7 digit decimal number
TIME_CD_2 Time as "hh:mm:ss:ff""
TIME_CD_3 Time as "hh:mm:ss:ff"" blank Justified
TIME_CD_4 Time as "hh:mm:ss:ff"" compressed
TIME_CD_5 Time as "mm:ss:ff" (no hours)
TIME_CD_6 Time as "mm:ss:ff" (no hours) blank justified
TIME_CD_7 Time as "mm:ss:ff" (no hours) compressed
TIME_CD_8 Time format as "1h 2mn 3s 4f"
TIME_CD_9 Time format as "1h 2mn 3s"

Various
Variable/GroupVariable/Group Comment:Comment:
NUM_TRACKS Total number of tracks as decimal number
UPC UPC/EAN code
ISRC ISRC code
FILE File name (no path)
PFILE File name (with path)
TRACK_NAME Track Name
TRACK_COMMENT Track Comment

The Available Commands
To find out about the available commands and how they are used, please open the included templates and
study them. All commands are used there, as an example for you to study.
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Creating CDs from the Audio MontageCreating CDs from the Audio Montage

Preparing the CD MontagePreparing the CD Montage
1. Make sure the Audio Montage contains exactly the material you want on the CD.

Note that CD Tracks must be at least 4 seconds long.
2. Click the CD tab to select the CD View.

This contains a CD Track list, much like a CD Program. However, at this point, it will be empty (since
there are no CD Track Markers inserted yet).

3. Select "CD Wizard..." from the CD View : Functions menu (or click the "magic wand" icon).
The CD Wizard dialog appears. This contains a number of settings that help you automate the CD
creation.

4. Activate the option "Generate CD Track Markers" and activate the desired sub-options.
The options are:

- Create markers at Clip boundaries. This causes the CD Wizard to add CD Start and End Markers at the
beginning and end of all non-overlapping Clips. Most likely, you want to have this activated.

- Create markers at crossfade points. When this is activated, the CD Wizard will create CD Boundary
markers at all crossfade intersection points. Activate this if you have Clips that overlap each other, but
should become different tracks on the CD.

- Keep locked CD track markers. Normally, any previously created CD Track Markers in the Montage
will be removed by the CD Wizard. However, if this option is activated, any locked CD Track Markers
(see Editing in the Markers View) will be kept.

5. If you like, activate the option "Adjust pause before track".
This automatically adjusts the pause before each track, either to a fixed value (as specified in the Set
time value box) or to the number of whole seconds closest to each current pause in the Montage.

- Note that a 2 second pause is required before the first CD Track. Therefore, a good default setting is to
activate the "Set time" option and set this to 2 seconds.

6. Adjust the other settings if you want.
For details, use the context senstitive help in the dialog.

7. Click Apply.
The dialog closes. Now, CD Track Markers are generated and pauses are adjusted according to your
settings. The CD View will now display a list of CD Tracks, as defined by the CD Track Markers.

8. If needed, you can adjust the CD Track Markers manually in the Track View or Marker View.
An example of a situation where you would need to add Markers manually would be a continuous
recording (one Clip, e.g. a live recording), which you want to divide into separate CD Tracks. Since this
would contain neither Clip boundaries nor crossfade points, the CD Wizard would not add any
Markers (apart from at the start and end of the whole Clip). Then it would be necessary to add CD
Track Boundary Markers at the desired positions. Another instance are CD Track sub-indexes which
also have to be manually added from the Marker View.
However, in most cases the CD Wizard will do a good job, and we recommend that you don’t edit the
generated Markers unless you really need to.

9. Select "Check" from the CD View : Functions menu or click the "glasses" icon.
WaveLab will check the CD list and inform you whether it’s OK or not (this check is also performed
automatically before actually burning the CD).

10. If the Check gave a warning message, make manual adjustments and repeat the Check procedure until
the list is OK.
You may get warning messages for several reasons, including:

- You have CD Tracks that are shorter than 4 seconds.
- The pause before the first CD Track is shorter than 2 seconds.
- There are Clips (or sections of Clips) outside the CD Tracks.
- There are CD Track Start or End Markers within Clips (if you want a new CD Track to begin within a

Clip, you should use CD Track Boundary Markers).
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Editing the CD View ListEditing the CD View List
Once you have prepared a CD Track List as described above, you can go ahead and write the CD. In some
cases though, you may want to adjust settings first. This can be done in the CD View Track List, which
resembles a CD Program in many aspects.
- You can hide or show CD Track List columns by using the column pop-up menu (accessed by clicking

the arrow button to the left of the column headings).
You can also drag and resize columns as usual.

- You can adjust all settings (except the "Length" value) numerically in the list.
However, changing Track Start and End positions may result in warning messages, as described above.

- If the option "Allow reordering by drag-and-drop" is activated on the CD View : Functions menu, you
can change the order of CD Tracks by dragging Tracks in the CD View list.
There is one restriction: you can only drag Tracks that are enclosed by CD Track Start and End
Markers - not by CD Track Boundary Markers. Tracks divided by a CD Track Boundary Marker (a
combined Start and End marker) can only be moved as an entity.

- You can generate a Cue Sheet from the CD View : Functions menu.
This function is described in the topic Generating Cue Sheets.

Burning the CDBurning the CD
The final phase of CD creation from the Montage can be done in two ways:
- By using the Apply function in the Master Section.

This creates an "image file" of the whole Montage together with a CD Program, referring to this file.
Then, you write the CD from the CD Program as usual. This method is recommended if your Audio
Montage contains a lot of Clip Effects (or is otherwise CPU intensive), since it separates the audio file
rendering from the CD burning process. This method is also recommended if you want to create
multiple copies of the CD.

- By burning directly from the CD View in the Montage.
This is a slightly quicker and easier process, but puts greater demand on your computer. Keep in mind
that even if your Audio Montage plays back without problems, the CPU load will be four times as high
if you burn in 4x speed (since the audio file has to be rendered four times as fast)! In other words, no
temporary file is created, the burning takes place in real-time.

In both cases, all clip effects are used and the montage is processed through the master section, including
any activated effects and the dithering/noise shaping stage.
Using the Apply Function
1. Open the Master Section and click the Apply button.

The Process Preferences dialog appears.
2. Select the "Whole Montage" option in the Range section.
3. Select the "Create CD Program" option in the Options section.
4. Click OK.

Now, the whole Montage is rendered to an audio file, with CD Track Markers at the appropriate
positions. A new CD program is created, referring to the audio file. This new CD program should not
be edited.

5. Proceed with Writing the CD from the CD program, as described in the topic Writing a CD.
Writing the CD directly from the CD View
1. Select "Write CD" from the CD View : Functions menu, or click the CD icon.

The Write CD dialog appears.
2. Proceed with selecting CD-R Recorder, Writing Speed and Operation mode as described in the topic

Writing a CD.
- If you are not absolutely certain that your computer is fast enough to handle direct CD creation, you

should burn in Test mode first. If the CPU load is too high, you could consider burning at a slower
speed, or using the Apply method instead, as described above.



How to...How to... WavWaveLab 3eLab 3

128128

Use Samplers and Create LoopsUse Samplers and Create Loops

Receiving and Transmitting SamplesReceiving and Transmitting Samples

Setting up your Sampler(s)Setting up your Sampler(s)
The following text assumes you have made all connections as described in the installation chapter. To
enable transmitting and recieving samples, proceed as follows:
Making the Basic Settings
1. Make sure the sampler is turned on.

If you use SCSI it must have been turned on when you booted the computer.
2. Select Sampler Setup from the Sampler menu.
3. Click on the Settings tab.
4. Select the desired communications protocol from the menu.

If possible, select your sampler protocol by sampler model name, this will provide the highest level of
functionality. If your sampler can’t be found on this menu, you will have to select SDS or SMDI,
depending on the type of connection and the instrument’s capabilities.

Only select an item that corresponds to the type of connection you actually have. For example, selecting
anything that involves SCSI is pointless unless you have connected the sampler via SCSI.
5. If the sampler is connected via SCSI, pull down the SCSI Unit pop-up and select the instrument with

which you want to communicate.
If the instrument can’t be found on this menu, there may be something wrong with your SCSI
connection. Go back and check the points described in the Installation chapter.

6. If the sampler is connected via MIDI, from the MIDI pop-ups select the MIDI Input and Output to
which the instrument is connected, and set the SysEx ID (System Exclusive ID number) to the same
number as that of the instrument.
This setting is very important. If the two numbers don’t correspond, transfers won’t work. To find out
how to check the SysEx ID to which your sampler is set, consult its operation manual.

A few samplers that communicate via SCSI will use the SysEx ID for SCSI purposes as well. See your
sampler documentation for details.
Creating a Preset
Once all settings are done, you must convert them to a Preset before you can continue:
1. Click on the Presets tab.
2. Type in a name in the field to the right.

Make sure you use a name that can be used later to identify this particular sampler (if you have several).
3. Click the Add button.

This adds the Preset to the list.
If you have more samplers, you can now go back to the Settings tab and make settings for the next
instrument and create a Preset for that.

Transmitting SamplesTransmitting Samples
To Transmit a sample, proceed as follows:
1. Open the sample in a wave window and trim it to the desired length, if required.

Remember that samplers are RAM based, which normally puts severe restrictions on how much data
you can transmit to an instrument.

2. Add one or two loops as desired.
3. Pull down the Sampler menu and select Transmit.
4. Select the target sampler from the Target menu.

This menu lists all samplers for which you have created Presets. The sampler will be on the list
regardless of whether it is turned on and connected properly or not, so this list is not a verification that
things have been set up properly.
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5. If the protocol used for this sampler identifies samples by number, use the "Sample number" setting to
specify a "memory location" in the sampler where you want to store the sample.
If another sample is already stored at that location, it will most likely be overwritten when you transmit,
so it might be a good idea to use the sampler's front panel controls to make sure you have specified the
number of an empty location.

6. If the sampler uses names and/or banks instead, click the Refresh button to get a list of the current
memory contents in the sampler. Then select a bank and a sample location from the pop-up and list.
This is not always required. In many instruments, if nothing is specified, the sample will be stored in a
new memory location and no existing samples will be overwritten.

7. Click Transmit.
The sample is transmitted to the sampler. You can monitor the progress of the transmission on the status
bar at the bottom of the screen.

Receiving SamplesReceiving Samples
To receive a sample, proceed as follows:
1. Pull down the Sampler menu and select Receive.
2. Select the desired sampler from the Target menu.

As with Transmit, this menu lists the samplers for which you have created Presets.
3. If the protocol used for this sampler identifies samples by number, use the "Sample number" setting to

specify which sample to retrieve.
4. If the sampler uses names and/or banks, click the Refresh button to get a list of the current memory

contents in the sampler. Then select a bank and a sample location from the pop-up and list.
5. Click Receive.

The sample is received and opened in a new window. You can monitor the progress of the reception on
the status bar at the bottom of the screen.

About Loops
If the sample contains loops they will be converted to loop markers in WaveLab. However, remember that
the number of loops you can use is restricted.

Deleting and Getting Info about SamplesDeleting and Getting Info about Samples
In both the Transmit and Receive dialogs, you will find Info and Delete buttons. These buttons will only be
available for samplers where a specific protocol that supports this functionality is implemented. They are
not available with the generic protocols SDS and SMDI
1. If required, click Refresh to update the list of samples in the sampler.
2. Select a Bank and sample in the list.
3. Click Delete to remove the sample from memory, or click Info to get information about the properties

of a sample.

Using the Send Back featureUsing the Send Back feature
A common working procedure would be to receive a sample in from the sampler, process it in WaveLab
and then transmit it back to the sampler. The "Send Back" feature facilitates this. It is a variation on the
Transmit function. The difference is that it automatically sends the sample to the same memory location as
that from which it originally came, without presenting any dialog.
Proceed as follows:
1. Receive a sample from the Sampler.

See Receiving Samples for instructions.
2. Work on it in WaveLab as desired.
3. Select Send Back from the Sampler menu.

The sample is transmitted back to the same memory location in the sampler from which it originally
came.

Editing Sample AttributesEditing Sample Attributes
This menu item on the Sampler menu allows you to make settings for a sample. They do not process the
sample in any way, they just give it properties that the receiving sampler may or may not take advantage
of. For details about the options, use the context sensitive help.
Depending on your sampler and the protocol you use for communicating, the above features may or may
not be supported. For example, SDS and SMDI do not support names. SMDI supports Key and Detune
whereas SDS does not.
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Using the Crossfade LooperUsing the Crossfade Looper

Opening the Crossfade LooperOpening the Crossfade Looper
Before you open the Crossfade Looper we suggest you use the methods described on the previous pages to
set up a basic loop. Then proceed as follows:
1. If you have several Loops, place the wave cursor somewhere inside the one on which you want to work.

This can be done simply by clicking somewhere between the loop markers.
2. Select Crossfade Looper from the Sampler menu.
For this item to be available, the Crossfade Looper plug-in must be activated in the Plug-in Manager
dialog, on the Options menu.
3. Click on the Loop Points tab.

This tab should be your starting point, since it is the place where you adjust the loop points.

Moving loop points manuallyMoving loop points manually
There are two ways of moving the loop points: dragging in the actual waveform (position the mouse
pointer in the display and drag sideways) and using the "nudge" buttons.
- Dragging in the actual waveform allows you to perform larger moves more quickly.
- The nudge buttons are more useful for fine-tuning since they move the points by one screen pixel. This

means that in 1:1 zoom mode, each press on a nudge button moves the loop point a single sample.
Note that a good loop point isn't necessarily at a zero crossing.
The various moving options
- By moving the left part of the display, you are moving the end point to a later (left) or earlier (right)

position.
- By moving the right part of the display, you are moving the start point to a later (left) or earlier (right)

position.
- If you activate Linking, both the start and end points will move simultaneously. That is, the Loop

length will be exactly the same, but the entire loop will move.
Remember that you can at any time switch to the main wave window and adjust the markers there, if
needed.

Moving loop points automaticallyMoving loop points automatically
If desired, you can have the program search for good loop points, automatically. This is technically no
different from adjusting the loop points yourself, only that the program uses pattern matching algorithms to
suggest loop points for you.
Let’s say that you want to let the program find a better start point for the loop. You first set up a start and
end loop marker, to get a basic loop, as described above. You then invoke the automatic searching, and the
program searches the waveform from the current start point, trying to find a section that is as similar as
possible to the area just after the current end point. When it finds a match it stops.
You decide how similar the section must be to be considered a match.
Setting up the parameters
There are two parameters for the auto-find feature, Desired Correspondence and Search Accuracy.
- Search Accuracy is a parameter for how many samples should be included in the analysis. Higher

values result in greater accuracy, but also longer processing times.
- Desired Correspondence is a value for how well the found section must resemble the section with which

it is compared, in order to be considered a match. WaveLab uses two methods for comparison, "phase
match" and "join match". First phase matching is performed and then, to "fine tune", a join match is
employed. A value of 1000 will most likely fail completely, since it requires a 100% perfect match.

- The "Current" values above show how well the currently set loop points match. The value to the left is
the "phase match" result, the one to the right is the "join match" result.

Searching
1. Set up the search parameters.
2. Click on one of the buttons in between the "nudge" buttons.

Each time you click, the program scans from the current point (forwards or backwards, depending on
which button you clicked) until it finds a point that matches. It then stops. If you wish you can stop at
any time by clicking the right mouse button. The program will then jump back to the best match found
so far.

3. Check the loop by playing back.
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4. If you think there might be a better point, at some later or earlier position, just click the button again,
and scanning continues from this point and onwards.
Remember that you can always go back to the main wave window and adjust the markers manually, if
needed.

Working with "Candidates"Working with "Candidates"
Often you will want to try various alternatives before committing to a loop. In order to compare several
alternatives, WaveLab offers looping candidates. These allows you to store sets of Loop points in memory
locations, for later recall.
Storing a candidate
1. Adjust the loop points until they are as desired.
2. Pull down the pop-up options menu in the dialog and select "Save Candidate".
3. Select one of the five memory locations that appear on a sub-menu.

The loop points are stored.
Recalling a Candidate
4. Pull down the pop-up options menu in the dialog and select "Restore Candidate".
5. Select one of the five memory locations that appear on a sub-menu.

The points are now recalled and the loop points in the wave are moved to the positions stored in the
memory location.
To compare several candidates, you can for example have playback going, select them one after the
other, and listen to the difference.
Once you have found your candidate, you can select OK to exit this window, or proceed to crossfading.

Things to note about Candidates
- There is only one set of candidates per wave window, not one per set of loop points. This means that if

you have several sets of loops in your file, you must be careful so that you don’t recall the wrong set.
- Crossfading is not part of the candidate, only loop positions are. You should decide which candidate to

use before you apply crossfading.

Creating a CrossfadeCreating a Crossfade
Setting up
1. While still at the Loop points tab (in the Crossfade Looper dialog), try to create as good a loop as you

can.
2. Click on the Crossfade tab.
3. Make sure the Crossfade check box is activated.

There is a corresponding check box on the Post-Crossfade tab. This allows you to choose whether
regular crossfading and/or post-crossfading will be performed when you later click Apply.

4. Decide on a length for the crossfade either by dragging the Length handle or by adjusting the Length
value below the graph.
The length is used to adjust how much of the audio file that will be processed. This area is always
located just before the end of the loop, but the Length value adjusts how far towards the start of the loop
it stretches. As you can see, an equally large area before the Loop start is used as basis for the
processing. However, this area is not processed, just analyzed.
Generally you will want the crossfade to be as short as possible, with an acceptable result:

- Using a long crossfade is a better guarantee that the loop will be smooth. However, more of the
waveform will be processed and hence changed in character.

- Using a short crossfade will assure the sound is affected as little as possible. However, the loop might
then not be as smooth as otherwise.

5. Decide on a crossfade shape, by dragging the Shape handle or by adjusting the Shape value.
The considerations for this are the same as when creating other crossfades. However, in most cases you
can safely leave this value as is.

Applying and checking the Fade
When you click Apply, the sound is processed. If you have playback going, repeating the loop, you will
hear the change take effect after a short while.
- You can check the crossfade visually, by switching to the Loop points tab and making sure "Display

processed signal" is activated on the options pop-up in the dialog.
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When it is, the display will show the waveform as it looks when crossfaded. When this setting is
deactivated, the display will instead show the waveform as it originally was. Switching back and forth
allows you to compare the two.

- You can undo the crossfade by selecting Undo from the Edit menu.
- If you click OK, the dialog closes and crossfading is made "permanent".
- If you click Cancel instead, the dialog closes and the waveform reverts back to the way it was before

crossfading.
Do not move the loop points after performing a crossfade! The waveform has been processed specifically
for the current loop settings!

Creating a Post-CrossfadeCreating a Post-Crossfade
The Post-crossfade is accessed from its own tab.
This is identical to the regular crossfade, but it is applied to the area after the loop. This means that it is
used to fade the material so that there will be no glitch when playback continues out of the loop.
If you intend to use the sound in your sampler in such a way that the area after the loop is never played,
you don’t need to worry about this feature at all! However, if you do intend to use the area after the loop it
is very important to have post-crossfade activated!
The post crossfade looks at the part of the waveform that occurs just after the loop start and processes a
certain area beginning at the end of the loop. The Length parameter adjusts the size of this area.
Everything else is identical to regular crossfading, see Creating a Crossfade.

Using the Wave EqualizerUsing the Wave Equalizer
The Wave Equalizer is a function for looping those un-loopable sounds, for example sounds that
constantly decay in level or continuously change in timbre. The Wave Equalizer applies drastic processing
to the sound that evens out changes in level and timbral characteristics, before and during the loop.
The non-scientific explanation is that the Wave Equalizer chops up the section inside the loop into little
pieces, blends the pieces and then spreads out the result over the loop.
The more scientific explanation is this:
A number of slices is specified for the looped section. If for example you specify eight slices, the loop is cut
up into eight sections of equal length. These sections are then mixed together to one sound which is
repeated eight times. This new piece of audio replaces all audio inside the loop.
In addition to the above, the Wave Equalizer includes a crossfade facility, so that the original sound fades
into the processed sections as playback approaches the loop start.
To use the Wave Equalizer, proceed as follows:
1. Set up a basic loop of the length you desire.

This will probably not be a very good loop. If it was you wouldn’t need to use the Wave Equalizer. In
any case, make sure to apply a standard cross-fade before using the Wave Equalizer.

2. Select Wave Equalizer from the Sampler menu and click on the Wave equalizer tab.
For this item to be available on the menu, the Wave Equalizer plug-in must be activated in the Plug-in
Manager dialog, on the Options menu.
3. Make sure that Slice Mixing is activated and select a number of slices.

Only experimentation can tell how many slices are needed, but generally, the more slices, the more
natural the sound (to a certain extent). However, the program puts a restriction on the number of slices,
so that each one is never shorter than 20 milliseconds.

4. Switch to the Pre-Crossfade tab and set up a crossfade.
Generally, this is the same as the crossfade in the Crossfade Looper window. However, the difference is
that this crossfade is made before and up to the loop start. The processed material created by the Wave
Equalizer is added to the original material before the loop. This is required because the Wave Equalizer
will produce a slight timbre discontinuity at the loop start; which needs to be removed by the Pre-
Crossfade.

5. Click Apply, and the sound gets processed.
If you have playback going, repeating the loop, you will hear the change take effect after a short while.

- You can undo the crossfade by selecting Undo from the Edit menu.
- If you click OK, the dialog closes and processing is made "permanent".
- If you click Cancel instead, the dialog closes and the waveform reverts back to the way it was before

processing.
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Do not move the loop points after performing the processing! The waveform has been processed
specifically for the current loop settings!
About the end of the Loop - Post Crossfading
After using the Wave Equalizer, the transition from the end of the loop to the end of the file in many cases
won’t be very natural. This can be fixed as follows:
1. Close the Wave Equalizer and open the Crossfade Looper.
2. Click on the Crossfade tab and deactivate the Crossfade option (the check box).
3. Click on the Post-Crossfade tab and make sure Crossfade is activated.
4. Set up the Post-Crossfade parameters and click Apply.



How to...How to... WavWaveLab 3eLab 3

134134

Use DatabasesUse Databases

Add FilesAdd Files

Databases - Using Add FileDatabases - Using Add File
This procedure allows you to add files to a Database by using a file dialog.
1. Select Add from the Database menu.

You can also press the right mouse button in the Location pane and select Add from the menu that
appears.

2. Select all files you want to open (possibly using [Shift] and [Control]) and click Open.
The files appear in the List pane. Also, folders are added to the Location pane. These correspond to the
real folders on the disk, which contain the actual files.

Databases - By DraggingDatabases - By Dragging
You can drag and drop an open Wave document into a Database, by using the drag handle (the dot) on the
title bar.

Databases - Using Scan DiskDatabases - Using Scan Disk
This procedure allows you to add files to a Database by searching for all files that meet certain criteria.
1. Select Scan disk from the Database menu.

You can also press the right mouse button in the Location pane and select Scan disk from the menu that
appears.

2. Select a drive and a folder as a start point for the search.
This folder and all its sub-folders will be searched.

3. Click OK.
The search criteria dialog appears.

4 Set up the criteria in each of the three tabs and click Scan.
The files that meet all the criteria appear in the List pane. Also, folders are added to the Location pane
as needed. These correspond to the real folders on the disk, which contain the actual files.

The Three tabs
The Search dialog has three tabs for deciding which files to add to the Database - one for text criteria, one
for file format criteria and one for date and size criteria.
For a file to be added, it must meet the criteria set up in all three tabs. It might for example have to...
- have a name containing the text "piano"...
- be in stereo, and...
- be smaller than one megabyte.
You can of course set up any of the tabs so that all files meet the criteria in this tab, so that you can, for
example, add files only based on their names or only on their format.
The Text tab
This is used to specify which files to add to the Database, based on Text criteria. See the Context sensitive
help in the dialog for details.
The Format tab
This allows you to Add files based on their file format. You may activate multiple options in each section
to add files of different categories (for example both mono and stereo files). See the Context sensitive help
in the dialog for details.
The Date & Size tab
This tab allows you to specify two things:
- If the "Modified" date of the file should be included in the search criteria or not.
- If the size of the file should be included in the search criteria or not.
See the Context sensitive help in the dialog for details.
Using Presets
You can create Presets for this dialog, just as with Processing. See Preset Topics.
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Databases - Adding a Dual Mono fileDatabases - Adding a Dual Mono file
To add two files as one stereo pair (dual mono), proceed as follows:
1. Add one of the files.
2. Press the right mouse button with the pointer over the file name.
3. Select Properties from the menu that appears.
4. Activate "Other channel file name" and type in the name of the other file in the field below.

The two files will now be treated as a stereo pair when editing, playing etc.

Display Files in the ListDisplay Files in the List

Databases - Displaying all files in the DatabaseDatabases - Displaying all files in the Database
If you want to display all files in the Database, regardless of location, category, keyword or comment,
proceed as follows:
1. Select Global Find from the Database menu, and click the Preset tab.
2. Select the "All audio files" Preset and click Load.
3. Click Find.

Databases - Displaying all files in a CategoryDatabases - Displaying all files in a Category
• To display the files that belong to a certain category, click on that category name in the Category pane.

Please note that you should click on the Folder name, not on the Folder symbol.

Databases - Displaying all files in a FolderDatabases - Displaying all files in a Folder
• To display all the files that reside in a certain Folder, click on the folder in the location pane.

All the files are displayed, regardless of category.

Databases - Limiting the number of files displayedDatabases - Limiting the number of files displayed
Windows 95 puts a limitation on how many files can actually be shown in the file list at one time (around
1500).
Normally you don’t want too many files in the List anyway, since it only makes it harder to organize them
and some Database operations will take longer to finish.
1. Open the Preferences dialog and click on the Database tab.
2. Adjust the  "Maximum list size" setting.

This will set a limit on how many files will be added in one go.
If you have specified a limit, as described above, in some circumstances the list can’t show all the files you
expect. If this is the case, the Status Bar will indicate this by displaying the number of files in red.

Customize the listCustomize the list

Databases - Changing List FormatsDatabases - Changing List Formats
Just as in the Window 95 Explorer application, you can decide to display the files in different list formats.
1. Click with the right mouse button in the File list.
2. Select from the lower half of the menu.

For details about each item, select it from the menu, and with the menu still up, press [F1].

Databases - Sorting FilesDatabases - Sorting Files
If you have selected Show Details as your list format (see Changing List Formats), you can click on the
column headings to sort the list according to that column’s criteria.

Databases - Setting Column WidthDatabases - Setting Column Width
If you have selected Show Details as your list format (see Changing List Formats), the width of the column
headings can be adjusted.
• Point at the divider between two columns, in the heading, and drag left or right.

This setting is saved with the Database.
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Perform File operationsPerform File operations

Databases - SelectingDatabases - Selecting
• You can select one file by clicking on it or by using the cursor keys.
• Several files can be selected using [Shift] and [Control] as in other Windows 95 programs.
• You can drag a selection rectangle if you start to the right of the actual name.

The files that are inside the rectangle when you release the mouse button will be selected.
• To select all files, press the right mouse button in the file list and select "Select All" from the menu that

appears.

Databases - Playing FilesDatabases - Playing Files
To play a file, proceed as follows:
• Select the file and click the Play button on the Transport or press [Enter] on the computer keyboard.

If the file is not on any of the disks currently "in the computer" the required disk will be requested. If the
file is already open and has unsaved changes, the version in the window will be played rather than the
one on disk.

Databases - Opening Files for EditingDatabases - Opening Files for Editing
To open one or more files in a wave edit window, proceed as follows:
• Double click on one file, or...
• Select the file(s), press the right mouse button anywhere in the list except on a file name and select Open

from the menu that appears, or...
• Drag the file(s) out of the Database window into an "empty" area within the WaveLab application

window.
If the file is not on any of the disks currently "in the computer" the required disk will be requested.

Databases - Adding KeywordsDatabases - Adding Keywords
To set the keywords of one ore more files, proceed as follows:
1. Select the file(s), press the right mouse button anywhere in the list except on a file name, and select

Properties from the menu that appears.
If you select more than one file you will give the same keyword(s) to all the files you selected.

2. Type in each keyword, separated by semicolons (";") or commas (","), or click on the "<<" button and
select from the menus that appear.
You can enter as many keywords as you like this way.

Adding Keywords to the menus
You can add Keywords of your own by typing the desired name preceded by a backslash character ("\").
You can even create hierarchic items like those on the standard menu. If you for example type
"\Quality\Texture\Crystal", Crystal will appear on the Texture menu, which in turn is on the Quality
menu.
The new menus are automatically saved when you close the dialog. You can also modify what keywords
are available on the menu in new Databases, see Databases - Changing the Default categories.

Databases - UpdatingDatabases - Updating
If you have worked on the files since the Database was last opened, the file attributes (size, date etc) might
by "out of sync" with the real values. To update those settings, proceed as follows:
1. Select the file(s), press the right mouse button anywhere in the list except on a file name.
2. Select Update from the menu that appears.

Databases - Syncing to DiskDatabases - Syncing to Disk
If you open a Database and then edit wave files during a session you will end up with files that have
properties which don’t match those in the Database. Furthermore you might have created new files which
are not in the Database at all. The Sync to Disk feature fixes this and other "out of sync" problems.
1. In the Folder list, select the folder you want to update.

The operation will affect this folder and all its sub-folders.
2. Press the right mouse button in the Location pane and select Sync to disk.

The Find dialog appears, see the context sensitive help for details. Also refer to Using Scan Disk.



WaveLab 3WaveLab 3 How to...How to...

137137

3. Fill out the dialog or select a Preset to narrow down the operation to files that only meet certain criteria.
If you want to affect all files in the folder(s) select the "All audio files" Preset.

4. Click the Scan button.
The following operations are performed:

- Files that are not yet in the Database are added.
- Files that don’t exist any longer are removed from the Database.
- The attributes (size etc.) of all files in the Database are updated.

Databases - Dragging to Another Database or ProjectDatabases - Dragging to Another Database or Project
You can Drag and Drop the files onto other windows. You can drop on:
- The List in another Database

This copies the file(s) into that Database. If you hold down [Alt] or [Shift], this moves the file(s) rather
than copying it/them.

- A Category in another Database
If you drag a file onto a Category in another Database, the file is copied to that Database and added to
the Category you dropped it on. Use [Alt] to move the file rather than copy it.

- A Project window
This copies the file to the Project. You can aim at a certain group to add the file to it.

Databases - Removing FilesDatabases - Removing Files
To remove one or more files from the Database, without actually deleting it from disk, proceed as follows.
• Select the file(s), press the right mouse button anywhere in the list except on a file name, and select

Remove from the menu that appears.
If you want to permanently delete the file from disk, use Delete File on the File menu instead.

Databases - Renaming FilesDatabases - Renaming Files
If you want to rename the file, proceed as follows.
1. Select the file, press the right mouse button, and select Rename from the menu that appears.

If the file is not on any of the disks currently "in the computer" the required disk will be requested.
2. Type in the new name and press [Return]. Do not specify an extension, only the actual file name.

If you need to modify the extension, use the Properties dialog, see Setting Properties.
This operation permanently modifies the actual file name!

Databases - Setting File PropertiesDatabases - Setting File Properties
To set the properties of one ore more files, proceed as follows:
• Select the file(s), press the right mouse button anywhere in the list except on a file name, and select

Properties from the menu that appears.
The Properties dialog appears.

See the dialog's context sensitive help for details about the different options.
Please note that the possibility to select more than one file allows you to give a number of files the same
keyword(s) and comment, in one go.

Filter the listFilter the list

Databases - Setting up a FilterDatabases - Setting up a Filter
The Filter function allows you to set up criteria so that the list always shows only files that meet certain
criteria. You might for example want the list to only display stereo files, regardless of which category or
folder you click on.
To set up a Filter, proceed as follows.
1. Select Global Filter from the Database menu.

The dialog that appears is identical to the one used for Scan Disk.
2. Fill out the dialog or select a Preset, see Using Scan Disk.
3. Click OK.
Now when you click around on folders or categories, only files that meet the criteria set up in the dialog are
displayed. You can note that a filter is applied by checking the Status bar, where it says "Global Filter".
The filter is common to all open Databases.



How to...How to... WavWaveLab 3eLab 3

138138

Databases - Deactivating the FilterDatabases - Deactivating the Filter
To completely turn off Database Filtering, proceed as follows.
1. Select Global Filter from the Database menu.
2. Click on the Preset tab, select "All audio files" and click Load.
3. Click OK.

Find filesFind files

Databases - Performing a Find operationDatabases - Performing a Find operation
WaveLab’s Find feature allows you to find all files in the Database that match certain criteria.
Please note that the Find function only searches among files already added to the Database (which is
different from how Scan Disk works, see Using Scan Disk).
Limiting the Search

• If you want to search among all files in the Database, select Global Find from the Database menu.
• If you want to search in a folder and its sub-folders, click the right mouse button on that folder and

select Find.
• If you want to search among files in one category only, click on that category with the right mouse

button and select Find.
• If you only want to search among the files currently in the list, click the right mouse button in the list

and select Find.
In either case, the same Find dialog appears.

Performing the Find
The Find dialog is basically the same as the one used for filtering and for Scan Disk (see Using Scan Disk).
The three tabs allow you to specify different types of criteria for the search. You can also select from
Presets.
• Set up the dialog and click Find.

The found files appear in the Database.
- If you have selected Global Find, you can activate "Keep Window open". This allows you to redo the

search without closing the dialog.
- The Filter setting applies (see Setting Up a Filter). You might for example have set up a Filter which

ensures that only stereo files are shown in the list. Then when you perform a Find, you will still only see
stereo files in the list. Please note that this might result in no files at all being shown. An example of this
would be that you try to find only mono files and have a Filter that only displays stereo files.

Folder OperationsFolder Operations

Databases - Renaming FoldersDatabases - Renaming Folders
You can rename a folder in the location pane  (not the real folder on disk):
1. Click on the folder with the right mouse button.
2. Select Rename.

The folder name opens up for editing, just as on the Windows 95 Desktop.
3. Change the name and hit [Return].
Note that if the folder name in the Database and on the disk do not match, you can not open the files in
that folder from the Database.

Databases - Removing FoldersDatabases - Removing Folders
To remove a folder and all the files in it from the Database, proceed as follows:
1. Click on the folder (in the location pane) using the right mouse button.
2. Select Remove.
3. Click OK in the dialog that appears.
This does not delete the actual files from disk. It only removes them from the Database.
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Work with CategoriesWork with Categories

Databases - Adding files to a CategoryDatabases - Adding files to a Category
1. Make sure the desired category is visible in the list.

If it isn’t, open the desired folder and scroll the list, to make it visible.
2. In the list, select the Files that you want to make part of a certain category.
3. Drag the selected files and drop them on the desired Category folder.

The files disappear from the list.
Please note that you can add a file to any level in the category "hierarchy". you can for example make a file
part of the category "Instrument", you don’t have to put it into any of the subcategories ("Keyboards",
"String" etc).

Databases - Moving files between CategoriesDatabases - Moving files between Categories
If you drop a file onto a different Category from the one it is already in, it is moved from the old Category
to the new one. In other words, files can only be in one Category at a time.

Databases - Displaying all files in a categoryDatabases - Displaying all files in a category
• To display the files that belong certain category, click on the category name.

Please observe that you should click on the Folder name, not on the Folder symbol.

Databases - Displaying all files not in any CategoryDatabases - Displaying all files not in any Category
There might be instances when you want to display all the files that haven’t yet been placed into any
category:
1. Press the right mouse button in the Category pane.
2. Select "Find Unregistered items" from the menu that appears.

Databases - Checking to which Category a file belongsDatabases - Checking to which Category a file belongs
If you have a file in the list and are unsure of which category it belongs to, proceed as follows:
• Select the file, press the right mouse button in the list and select "Show Folders" from the menu that

appears, or...
• Hold down [Alt] and click on the file name or wave icon in the list.

Either way, the category folder is highlighted in the list. If no folder is highlighted, this means the file
doesn’t belong to any category.

This operation also tells you which folder the file is in, by looking at the Location pane.

Databases - Creating CategoriesDatabases - Creating Categories
• To create a new category, select the folder you want this new category to be in. Then press the right

mouse button and select "New Category". Type in the name and click OK.

Databases - Renaming CategoriesDatabases - Renaming Categories
• To rename a category, select it,  press the right mouse button, and select Rename from the menu that

appears. Type in the new name and click OK.

Databases - Removing CategoriesDatabases - Removing Categories
• To delete a category folder, select it, press the right mouse button and select Remove from the menu

that appears.
This deletes the selected category and all its sub-categories.

The files that belonged to these categories are not deleted. Rather they become "unregistered items", see
Displaying all files not in any Category.
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Databases - Changing the Default categoriesDatabases - Changing the Default categories
To change the Category hierarchy and keyword lists that appears in new Databases, proceed as follows:
1. Make copies of the files "categ.txt" and "keywords.txt"

These are located in the System folder in the WaveLab folder. You might for example name the copies
"categ.bak" and "keywords.bak".

2. Launch a regular text editor.
One of those included with Windows will work fine.

3. To Edit the categories, open the file "categ.txt". To edit the keywords, open "keywords.txt".
Note how the files are structured:

- Each level in the hierarchy begins with the name. After this, the sub-items within this level are listed
inside curly brackets ("{" and "}"). For example, in the "categ" file you will note a section that begins
with the word "Keyboards" followed by a left bracket on the next line. This category ("Keyboards")
does not end until after the word "Harpsichord", since on the line below that, a corresponding right
bracket appears.

- Within each level you will in many cases find sub-levels, also enclosed in curly brackets. (In
programmer speak, this is referred to as nested structure). In the "Keyboard" example, the sub-levels are
"Organ", "Piano", "Synth", "Celesta", "Clavinet" and "Harpsichord". The first three of these contain
their own sub-categories.

4. Change the structure, rename, add and remove items as desired.
Make sure that each left bracket is "balanced" by a right bracket ending the "level".

5. Save the file under the same name in the same location.
If something goes wrong, delete the files you have created and rename the backup files to the original
names. This will restore  the initial settings.
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Use ProjectsUse Projects

Work with GroupsWork with Groups

Projects - Creating GroupsProjects - Creating Groups
1. To create a new Group, select the Group symbol you want the new Group to appear in.
2. Click with the right mouse button in the window.
3. From the menu that appears, select Create Group.
4. Fill in the name and click OK.

Projects - Renaming GroupsProjects - Renaming Groups
1. To rename a Group, select it.
2. Click with the right mouse button in the window.
3. From the menu that appears, select Rename.
4. Type in the name, just as in the Windows 95 Explorer and hit [Return]

Projects - Removing GroupsProjects - Removing Groups
To delete a Groupand remove all files within it from the Project, proceed as follows:
1. Select the Group.
2. Click with the right mouse button in the window.
3. From the menu that appears, select Remove.
4. Click OK in the dialog that appears.
This only removes the items from the Project. It does not delete anything from your disks!

Work with FilesWork with Files

Projects - Adding FilesProjects - Adding Files
By Dragging
You can drag and drop an open Wave document into a Project, by using the drag handle (the dot) on the
title bar.
Using a dialog
To add one ore more files to a Group, proceed as follows:
1. Click on the Group you want to add the file(s) to.
2. Press the right mouse button and select Add from the menu that appears.
3. Select all the files you want to open.

You can select as many files you wish from the same folder, using [Control] and [Shift].
4. Click Open.

A file can only be added to one Group at a time.
From a Database
You can drag and drop files from a Database to a Project, see Dragging to Another Database or Project.

Projects - Renaming FilesProjects - Renaming Files
1. Click on the File.
2. Press the right mouse button and select Rename from the menu that appears.
3. Type in the name, just as in the Windows 95 Explorer and hit [Return].
This means the file on disk is actually renamed, just as if you had changed the name in for example the
Windows 95 Explorer application.

Projects - Removing FilesProjects - Removing Files
To remove a file from a Group (without actually deleting it from disk) proceed as follows:
1. Click on the File.
2. Press the right mouse button and select Remove from the menu that appears.
3. Click OK in the dialog that appears.
This removes the file from the Project but does not delete anything from your disks!
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Projects - Moving Files between GroupsProjects - Moving Files between Groups
• To move a file from one Group to another, first Remove it from one Group then Add it to another.

Projects - Playing FilesProjects - Playing Files
• To play a file, select it and press [Enter] or click Play on the Transport.

Projects - Opening FilesProjects - Opening Files
• To open a file for editing, double click on it or click on it with the right mouse button and select Open

from the menu that appears.

Handle Files and DocumentsHandle Files and Documents

Create New Wave documentsCreate New Wave documents

Creating new Documents - Using NewCreating new Documents - Using New
If you want to start with an empty file, to for example assemble material from other files into this, proceed
as follows:
1. Select New from the file menu, and Wave from the sub-menu that appears. Or, click the New icon on

the Control Bar.
2. Fill out the dialog that appears.

See the context sensitive help for details about the various options in the dialog.

   Creating new Documents - By dragging in an empty area   Creating new Documents - By dragging in an empty area
If you want to start with an empty file, for example to assemble material from other files into it, proceed as
follows:
1. Make sure "Create Windows using mouse" is activated in the Display part of the Preferences dialog.
2. Hold down [Control] and drag to make up a box in some "free" area of the WaveLab application

window.
This must be of a certain minimum size or bigger. If you don’t get any new window, try again with a
bigger box. The new window "inherits" its attributes from the last active window. If no window is open,
the dialog box settings for units are used instead.

Open and Import Wave filesOpen and Import Wave files

Opening multiple FilesOpening multiple Files
You can open a number of files at the same time.
1. In the Open dialog, select as many files as you wish.

This is done using [Shift] and [Control], as in any Windows 95 program.
2. Click Open.

They all appear in one window each.

Opening Dual Mono filesOpening Dual Mono files
If you have two mono files which are actually the left and right channels of a stereo recording (some
systems handle stereo this way), you can open these as if they were a stereo file. Proceed as follows:
Allowing Opening of Dual Mono files
1. Pull down the Options menu, select Preferences and click on the File tab.
2. Make sure the "Allow opening of dual mono files" is activated.
3. Close the dialog.
Opening Dual Mono files
1. Select Open Wave from the file menu.
2. Select the first file, hold down [Control] and select the other.
3. Click Open.

The two files are opened as one stereo file. The file names determine which file becomes the left channel
and which becomes the right. The one that comes first in the alphabet becomes the left channel. If this is
not as desired, you can Swap Channels.

You can now work on the two files as if they were one. You can later save them as a stereo file or as two
mono files. See Save Convert.
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Dragging and Dropping filesDragging and Dropping files
To open one or more files from the Desktop or the Explorer, use any of the three following possibilities:
• Drag and drop the file(s) on the WaveLab application window.
• Drag and drop the file(s) on the WaveLab program icon or a shortcut for it.

If the program isn’t already running, it will be launched. Also, this works even if the application is
running but minimized.

• Double click on the file.
This will only work if you have created an association between the file format and the WaveLab
application. Such an association can be set up automatically during installation.

Opening a recently used fileOpening a recently used file
On the bottom of the File menu, lists of the last opened files can be found. These are divided into three
categories, depending on file type. To open one of these, simply select it.
Using this option allows you to open a dual mono file (actually two files) that you have previously worked
on, with one mouse click!

Creating a Favourites menuCreating a Favourites menu
The last but one menu item on the File menu is called Favourites. This allows you to assemble a list of files
that you want to be able to open quickly, a library if you will.
- To add a file to the list, make sure it's window is activated and select "Add current document" from the

Favourites menu.
- To open a file from the list, simply select it.
- To clear the whole list, select Clear List from the Favourites menu.
- To update the list so that it only lists files that actually still exist in the specified locations on your hard

disk(s), select Validate List from the Favourites menu.
Files that can't be found are removed.

Importing CD-tracksImporting CD-tracks
For the CD-R recorders that WaveLab supports for CD burning it also provides the ability to read audio
Tracks right off regular CDs. This makes a digital copy of the audio on the CD, right into an audio file on
your hard disk.
• Please note that this only applies to the CD-R units supported directly be WaveLab, not to any CD-

ROM drive that you already have installed in your system.
• Please observe and respect any copyright notices on the CDs you are reading tracks from!

Proceed as follows:
1. Insert the CD into the CD-R unit.
2. Pull down the File menu, select Open and from the sub-menu that appears, select Import Audio CD

Track.
A window appears which lists the Tracks on the CD, plus some information about each one. Please
note that the Copy Protection and Pre-emphasis columns are only information fields, you can not
change any settings.

3. Click on the ". . ." button at the bottom of the dialog to select a folder for the file(s) and a template name
for the file. If your file template for example is "music", and more than one file will be created, the files
will be named "music_1.wav", "music_2.wav", "music_3.wav", etc.

• If some file(s) already exist(s) with the same name(s) as specified here, they/it will be replaced without
warning!!!!

4. If required, you can select one file and click Play Start.
This will play the beginning of the Track so that you can check it out.

5. Select as many the Tracks as you wish, from the list.
You can use [Control] and [Shift] to make multiple selections. There is also a Select All button.

6. If you have selected one file only, you can specify a section of this to import.
7. Click the Save button.

The Tracks are retrieved one by one, and optionally open in a window for each one.
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Notes:
- The audio files are always saved in WAV (Wave) format.
- Note that importing audio CD tracks is technically more complicated than reading files from a CD-

ROM or hard disk, because audio sectors can be hard to detect. Some CDs, which do not conform
completely to the CD standard, may cause problems. Unfortunately, this is unavoidable.

- The read speed for audio Tracks might not be the highest speed the CD-R unit is capable of. Since
audio CD reading is more prone to errors than for example CD-ROM reading, the read speed is
adjusted downwards automatically. For example, the Yamaha CDR-100, which reads CD-ROMs at 4x
speed, will only read audio tracks at 2x speed.

- The ISRC code is not displayed in the dialog, since finding this code on the disc could take several
minutes in some cases!

- If you import a CD track with Emphasis, and later want to use this on a CD of your own, remember to
activate Emphasis for that Track in the CD Program.

Saving Wave FilesSaving Wave Files

SaveSave
• If you have opened a file and modified it, you can save the changes into the same file, by simply

selecting Save from the File menu or by pressing [Control]-[S].
- When you save a new document for the first time, it doesn’t matter whether you select Save or Save As.

The Save As dialog will appear anyway, since you need to specify a file format, folder, and file name.
- Saving clears the Undo buffers, which means that after saving you cannot undo or redo.

Save AsSave As
• If you have an unsaved file, or if you want to specify a new name, location and/or file format for a

previously saved file, you should select Save As from the File menu.
A regular file dialog appears. The pop-up menu at the bottom can be used to select a file format. If a file
with the same name already exists, you are asked whether you want to back up the existing file first.

- After a file has been saved once, you can continue to edit it and then select Save to update the file and
make the changes permanent.

- Saving clears the Undo buffers, which means that after saving you can not undo or redo.

Save ConvertSave Convert
If you want to change the format (sample rate, bit resolution and stereo/mono) when saving, proceed as
follows:
1. Select Convert from the Save Special menu, on the File menu.
2. Fill out the first dialog.

See the context sensitive help for details.
3. A regular file dialog appears where you can specify a file name, folder and a file format.

A new file is created. The original file is not affected by the operation. If a file with the same name
already exists, you are asked whether you want to back up the existing file first.

The following operations are performed:

Sample Rate If a new sample rate is specified, a sample rate conversion is performed with "Standard
Quality".

Bit resolution If a different bit resolution is specified, the file is either "truncated" down to 8 bits or
"padded up" to 16 bits. If you convert to 8 bits, the audio is automatically normalized.

Mono/Stereo If the file is converted from mono to stereo, the same material appears in both
channels. If the conversion is from stereo to mono, a mix of the two channels is made.

Save EncodeSave Encode
WaveLab allows you to export files in a number of compression encoded audio formats, suitable for
multimedia, web publishing etc (see the context sensitive help). The basic functionality for this is actually
part of a software technology called Microsoft ACM.
The number of formats you can export, depend on what version of ACM you have installed on your
computer. As of this writing, ACM was included with Miscrosoft Internet Explorer 4.0 and with Microsoft
NetShow.
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The dialog used for saving in Encoded format is actually not part of WaveLab, but of ACM.
We recommend that you point your Internet browser to www.microsoft.com, for more information. From
these pages you can also download various versions of Internet Explorer and NetShow for installation on
your computer.
ACM compressed files are Wave files
When you export to encoded  files, the file that is created is technically always a Wave file, regardless of
the compression format. But instead of the regular "linear" audio data that usually makes up a wave file, a
special audio data "chunk" that contains the compressed audio, is included.
This is normally not a problem, but something to be aware of if you are planning to use these files in other
programs or on other computer platforms.

Saving one channel onlySaving one channel only
The "Save left/right channel as" menu items are also on the Save Special sub-menu. They allow you to
save each channel individually, into a separate file. A regular file dialog is used, see Save As.
This menu command is used specifically when you have been editing "dual mono" files and wish to save
the channels in the file separately.

Saving the selection onlySaving the selection only
The "Save selection" menu item is on the Save Special sub-menu. It allows you to save the selected portion
of the audio file, only. A regular file dialog is used, see Save As.

Saving a CopySaving a Copy
The  "Save Copy" item, on the Save Special sub-menu allows you to save a copy of the file, in its current
state, without affecting the original. A regular file dialog is used, see Save As.

Save AllSave All
This menu item (also on the Save Special sub menu) brings up a dialog that allows you to save some or all
of the open documents, in one go.
The list displays all open documents that currently have unsaved changes. The Show Paths check box
allows you to display/hide the complete file paths.
1. Select /deselect files by clicking on them or by using the Select/Deselect button.

Only the selected files will be saved.
2. Click "Save".

Creating Session 8 compatible filesCreating Session 8 compatible files
The Digidesign Session 8 system uses special Wave files. To make your files compatible with the Session 8,
proceed as follows:
1. Select Preferences from the Options menu.
2. Click on the File tab.
3. Make sure the "Save Session-8 compatible WAV files" option is activated.

This raises the file size by about 4 kBytes, which is a relatively small amount. Please note that the files
are still compatible with other programs that read Wave files.

Saving Databases and ProjectsSaving Databases and Projects
There is no special save command for Databases or Projects. Instead, any changes you make are
automatically saved to disk as you go along. If you close a Database or Project and then Open it, you will
find it exactly as you left it (to instead open a Database with a standard layout, hold down [Control] when
opening).
You might work a lot on your Databases, adding files into Categories etc. Please back up the Database
files, in case you experience data loss. Database files are not very big compared to Wave files.

Reverting to the last Saved versionReverting to the last Saved version
The Revert to Saved menu option, on the File menu, allows you to revert back to the state a file was in
when you last saved it (actually, the last saved version of the file is loaded from disk). This can be used as
kind of "super undo" where all the changes you have made to the file since you last saved, are undone.
1. Select Revert to Saved from the File menu.
2. Click "Yes" in the warning dialog that appears.

The files is restored to its last saved state.
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Automatic BackupsAutomatic Backups
For all save operations except a "plain Save" you will be asked whether you want to create a backup if a file
with the same name already exists in the folder. If you click Yes in this dialog, the first letter in the
extension of the existing file will be changed to "~". "AIF" for example, will become "~IF".

Editing Audio AttributesEditing Audio Attributes
Each audio file has a certain set of "attributes", that is, information about the sample rate at which it was
recorded, what the bit resolution is, etc. The Edit Attributes dialog allows you to change that information
for a file.
There are two ways to bring up this dialog:
- Select Edit Attributes from the File menu.
- Click on the attributes information field, on the Status Bar.
About Changing the values
Changing the values in this dialog does not process the file in any way, as does Convert File. However, the
following rules apply:
- If you change the sample rate, the file will play back at the wrong pitch.
- If you change the bit resolution the file will be converted to the new resolution, the next time you save

it.
There is no Undo for this item. If you save with a lower bit resolution, the file is forever converted.

Checking Document PropertiesChecking Document Properties
This item, on the File menu, brings up a dialog that displays basic information about a file.
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Create your own key commandsCreate your own key commands

Switching between the two Views for the dialogSwitching between the two Views for the dialog
There are two types of views to the list, selected via the radio buttons to the upper right.
- "Sort by Command" organizes the operations in folders, in groupings that relate to various sections in

the program.
- "Sort by Key" lists all commands in a "flat" fashion (no folders), and sorts the list alphabetically via the

defined Key Commands
Regardless of which mode you select, the available list of operations is the same, it's just the view that
changes.

Defining Key SequencesDefining Key Sequences
1. Select the operation that you want to create a Key Sequence for.
2. Click the Key Sequence button.
3. If you want to clear the current Key Sequence, click Clear.
4. Make sure Catch mode is active.
5. Press the first combination of keys that you want to use.

You can include modifiers ([Shift], [Ctrl], [Alt], etc.) if you like. There is also a setting that makes the
program distinguish between two modifiers with the same label, on each side of the space bar.

6. Proceed with the series of keu(s) which you want to store.
7. Disable Catch mode.

This is just a safety measure so that you don't accidentally erase or add to your current key sequence,
when pressing more keys.

8. Close the dialog.
It is perfectly possible to define the same Key Sequence for two operations. If you do, one of them will be
invoked. To see which, select "Sort by key" and locate the items in the list. The top one is the one that will
be used.

Setting Enable OptionsSetting Enable Options
Once the Key Sequence has been defined, you may want to set the Enable Options for the operation. This
is done by selecting from the pop-up in the middle column:
Option:Option: Description:Description:
Enable all the time This Key Sequence is always active.
Enabled if active... This Key Sequence can be used for all windows, except the ones added to the

"Exclude Windows" lists, described below.
Enabled if involved... This Key Sequence is only available if the window to which it is applied has the

focus (is active or displayed on top of all other windows).

Excluding WindowsExcluding Windows
This is mainly for plug-in windows. Since some plug-ins, especially from third-party manufacturers, have
their own set of key commands, you way want to disable key commands for these windows.
Let's say you assign a key command to "Apply in the Master section", and a certain plug-in already uses
the same key combination for an internal operation. Then, pressing this key command might lead to the
wrong operation being invoked when this plug-in has the focus.
"Exclude windows" allows you to prevent this situation:
1. Click the "Exclude windows" button.
2. Type in the name of the window.

You can include DOS "wildcard" characters. For example to exclude all products from the
manufacturer Waves, you can type "Waves*".

3. Close the window.
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Using Key SequencesUsing Key Sequences
Key Sequences can only be executed after you have closed the Key Sequence dialog.
- Simply press the keys in the order they were entered in the dialog, and the operation is performed.
There is one thing to note: If you have created a key sequence for an operation in the Master Section "Slot
Commands" group , you also need specify key sequences for selecting Slots. Let's for example say you have
created a key sequence for the "Toggle Solo" function (which turns Solo on and off for a slot). To execute
this, you must first select a slot, using the appropriate key sequence, and then use the key sequence for the
"Toggle Solo" function.

Using "Set focus on this key command"Using "Set focus on this key command"
This is used to be able to re-use key commands for certain groups.
For example, let's say you set up things so that [Ctrl]+[F10] is the key command for setting the focus to the
Master section. You then assign simple key commands to the Master section items, for example [A] for
"Apply" and [R] for "Remove all plug-ins", even though these keys may be used for other sections of the
program.
You can then Press [Ctrl]-[F10] followed by any of the single commands to control most aspects of the
Master Section.
Note that a section may have only this operation in the list. An example is the set of Loop tuners. Since
these are plug-ins, they have their own key commands. This can be combined with the above as if they
were in the same list.

Using "Bypass all defined key commands" and "Enable all keyUsing "Bypass all defined key commands" and "Enable all key
commands"commands"
This can be used when an installed plug-in, from a third party manufacturer, has its own set of key
commands. You can then temporarily disable all WaveLab key commands in order to use the plug-in's
own.

Using "Bypass all defined key commands but those set to 'Enabled allUsing "Bypass all defined key commands but those set to 'Enabled all
time'"time'"
Same as above but disables all key commands except those where you have set the Enable Option to
"Enabled all time".
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Plug-in Processor ReferencePlug-in Processor Reference

Auto PannerAuto Panner
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
An AutoPanner is an effect that causes the signals to move around in the stereo image.
- LFO Freq (0.1Hz~50Hz)LFO Freq (0.1Hz~50Hz)

This parameter sets the speed of the pan movements. The higher the value, the faster the processed
signal moves around in the stereo image.

- Width (0~100%)Width (0~100%)
Use this parameter to specify the "width" of the pan movements. The value 0% means that the panner is
effectively creating a mono sound image, while 100% causes the signal to move from the extreme left to
the extreme right (and vice versa).

- Waveform (Sine, Pulse)Waveform (Sine, Pulse)
Waveform allows you to specify the way in which the signal moves from left to right. Select Sine if you
prefer fluid movements, or Pulse to create a "jumping" movement.

- Out Left, Out Right (-96dB~6dB)Out Left, Out Right (-96dB~6dB)
These two parameters allow you to correct the level of the left or right channel in case AutoPanner
produces an unbalanced sound image. The value -96dB means that the channel in question is turned off,
while 6dB will boost the signal level. 0dB will cause no change in level.

Setting the value -96dB for a channel means that its signal is neither audible nor transmitted to subsequent
effect slots or the master faders.

Auto PanAuto Pan
This is a VST plug-in. It can be used as a Clip effect in the Audio Montage, or as a global effect in the
Master Section.
The Auto Pan is a effect that causes the signals to move around in the stereo image. The Auto Pan, like all
VST plug-ins, can be used in the Montage as a Clip effect.
- LFO Freq (0.1Hz~10Hz)LFO Freq (0.1Hz~10Hz)

This parameter sets the speed of the pan movements. The higher the value, the faster the processed
signal moves around in the stereo image.

- Width (0~100%)Width (0~100%)
Use this parameter to specify the "width" of the pan movements. The value 0% means that the panner is
effectively creating a mono sound image, while 100% causes the signal to move from the extreme left to
the extreme right (and vice versa).

- Waveform (Sine, Triangle, Sawtooth, Pulse)Waveform (Sine, Triangle, Sawtooth, Pulse)
Waveform allows you to specify the way in which the signal moves from left to right. Select Sine or
Triangle if you prefer fluid movements, or Sawtooth/Pulse to create  "jumping" movements.

- Out LevlOut Levl
The stereo output level of the effect.

Choirus2Choirus2
This is a VST plug-in. It can be used as a Clip effect in the Audio Montage, or as a global effect in the
Master Section.
Choirus2 is an effect originally intended to create the impression that a given part is being played by more
than one musician. Nowadays, it is also used to "sweeten" the sound image by adding modulation.
- TimeTime

Use this parameter to specify the basic time delay for the chorused signal with respect to the "dry"
signal. The higher the value, the more prominent the effect. Low settings create flanger-like effects,
medium settings provides classic chorus while higher settings are mainly for special effects.
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- WidthWidth
- Use this parameter to specify how much the delay time is allowed to vary with the modulation. It is this

variation in delay time that causes the sweeping effect. Note that the value 0% should probably be
avoided since it might create the impression that you are experiencing phase problems.

- Lfo FreqLfo Freq
The Frequency parameter sets the speed of the sweep (the modulation). The higher the value, the faster
the modulation. You will probably not use  higher values (above 7Hz) except for special effects.

- FeedbackFeedback
This parameter specifies how much of the output from the effect is fed back to the input (the feedback
signal is also phase inverted). The higher the value, the more prominent the effect. At short delay times,
this creates a flanger-like effect. At larger settings it creates more of a slapback repetition type of sound.

- Feed BalFeed Bal
Use this parameter to set the volume of the Feedback signal (see above) in the mix. If this is set to 100%,
and combined with a Feedback setting between 65% and 100%, the effect goes into self-oscillation.

- Glimmer 1, Glimmer 2Glimmer 1, Glimmer 2
The two Glimmer parameters allow you to specify to what extent the Chorus signal should move
around in the stereo image. They work in more or less the same way as the AutoPanner but only apply
to the Chorus signals. Glimmer 1 processes the right channel signal, while Glimmer 2 processes a
combination of the left and right channels (the actual left channel always remains at 0).

- Out LevlOut Levl
The stereo output level of the effect.

ChorusChorus
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
Chorus is an effect originally intended to create the impression that a given part is being played by more
than one musician. Nowadays, it is also used to "sweeten" the sound image by adding modulation. This a
classic chorus based on a sweeping delay and is available in real time.
- Delay (0.1~60ms)Delay (0.1~60ms)

Use this parameter to specify the basic time delay for the chorused signal with respect to the "dry"
signal. The higher the value, the more prominent the effect. Low settings (up to 7ms) create flanger-like
effects. Setting up to 25ms are for classic chorus while settings above this value are mainly for special
effects.

- Width (0~100%)Width (0~100%)
Use this parameter to specify how much the delay time is allowed to vary with the modulation. It is this
variation in delay time that causes the sweeping effect. Note that the value 0% should probably be
avoided since it might create the impression that you are experiencing phase problems.

- Frequency (0.009999~25Hz)Frequency (0.009999~25Hz)
The Frequency parameter sets the speed of the sweep (the modulation). The higher the value, the faster
the modulation. You will probably not use values above 7Hz except for special effects.

- Feedback (0~100%)Feedback (0~100%)
This parameter specifies how much of the output from the effect is fed back to the input (the feedback
signal is also phase inverted). The higher the value, the more prominent the effect. At short delay times,
this creates a flanger-like effect. At larger settings it creates more of a slapback repetition type of sound.

- Fb Balance (0~100%)Fb Balance (0~100%)
Use this parameter to set the volume of the Feedback signal (see above) in the mix. If this is set to 100%,
and combined with a Feedback setting between 65% and 100%, the effect goes into self-oscillation.

- Glimmer 1, Glimmer 2 (0~100%)Glimmer 1, Glimmer 2 (0~100%)
The two Glimmer parameters allow you to specify to what extent the Chorus signal should move
around in the stereo image. They work in more or less the same way as the AutoPanner but only apply
to the Chorus signals. Glimmer 1 processes the right channel signal, while Glimmer 2 processes a
combination of the left and right channels (the actual left channel always remains at 0).

- Stereo Spread (0~100%)Stereo Spread (0~100%)
This parameter specifies the width the Chorus effect will occupy in the stereo sound image. The value
0% creates a mono impression, and since left and right channel signals are then mixed together, the
Chorus becomes louder.
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- Mix (0~100%)Mix (0~100%)
Use this parameter to specify the balance in level between the dry and delayed signal. The value 0%
means that only the dry signal will be heard, while 100% actually means a 50/50 mix between dry and
effect signal.

- Output Lev (-48dB~0dB)Output Lev (-48dB~0dB)
This is effectively an attenuator that allows you to reduce the output level of the Chorus effect, thereby
avoiding clipping and hence distortion. If the Clip indicator lights up continuously, lower this value.

DuckerDucker
This is a special VST plug-in that can only be used as a Montage Clip effect.
It uses the " Route to Upper Track" feature which can be found on the Track menu. The Ducker is a plug-
in that can control (modulate) the volume of Clips placed on a Track with the signal of one or more Clips
placed on the next adjecent Track below it. Let's say you have a Clip containing music, and you want to
add a voice-over to  that Clip. First place the music Clip on Track 1 and assign the ducker plugin to this
Clip. Then place the voice-over Clip(s) on Track 2. On the Track menu (for Track 2), select the "Route to
Master Section and Upper Track" item. Now the signal of Track 2 will be sent to the Master Section as
usual, but also to the Ducker plug-in on Track 1. The Clip volume on Track 1 will now be automatically
lowered by the Ducker whenever there is a signal (in this example the voice-overs) on Track 2, and raised
again when the signal stops. Note that it is possible to use mono or stereo Tracks for both the modulating
and the Upper Track.
- ThresholdThreshold

This sets the loudness threshold that will trigger the Ducker. Clips on the Modulator Track with levels
above the threshold will cause the level of a Clip on the Upper Track to be lowered.

- DampingDamping
This sets the amount of level reduction that is applied to the the Clip on the Upper Track.

- Fall TimeFall Time
This sets the time it takes for the level to change from 0dB to the set damping level.

- Hold TimeHold Time
The Hold parameter controls how long it takes for the reduced level to rise to normal level when the
modulating signall falls below the set threshold.

- Mix ModeMix Mode
If this is activated, the Ducker will output a mix of the two Tracks. This is only useful if the "Route to
Upper Track only" mode has been selected for the modulating Track. Then this feature could be used
for processing several Clips through the same plug-in chain, if more plug-ins has been assigned after the
Ducker on the Upper Track. Note that the mixed output is controlled by the Upper Track, if this is not
playing a Clip both of the Tracks will be silent.

EchoEcho
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
This effect (also known as Delay) creates repetitions of the processed signals. One nice thing about this
particular Echo effect is that it will decay naturally even if applied to only a short excerpt of a wave.
- Delay 1 (0.5~1000ms)Delay 1 (0.5~1000ms)

This sets the delay time of Delay 1, with respect to the incoming signal. Please note that minimum
value (0.5ms) creates an out-of-phase impression.

- Feedback 1 (0~100%)Feedback 1 (0~100%)
This sets the amount of delayed signal fed back into the Delay 1 block, to create repetitions. The value
100% means that the echo signal is repeated indefinitely, while 0% means there is only one repetition.

- Link 1-2 (Off, Linked)Link 1-2 (Off, Linked)
Select Off if you wish to use Delay 1 and Delay 2 as two independent blocks. Select Linked if the output
of Delay 1 is to be connected to the Input of DelayÊ2.

- Delay 2, Feedback 2Delay 2, Feedback 2
See Delay 1 (0.5~1000ms) and Feedback 1 (0~100%) above. These parameters are identical to these but
apply to the second Delay block.
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- Del. Balance (0~100%)Del. Balance (0~100%)
This sets the stereo width of Delay 1 and Delay 2. When set to 100%, Delay 1 is assigned to the left
channel, while Delay 2 is assigned to the right channel. The value 0% means that both Delay blocks are
spread across the stereo field.

- Vol Left, Vol Right (-96dB~0dB)Vol Left, Vol Right (-96dB~0dB)
Use these parameters to correct volume imbalances brought about by the Delay effects. These
parameters only apply to the Echo effect, the dry signal is not affected by these settings.

EQ-1EQ-1
EQ-1 is available both as a  VST and a WaveLab plug-in. It can be used as a Clip effect in the Audio
Montage, or as a global effect in the Master Section.
This is a standard parametric equalizer with a few features found only on high-end mixing consoles. Every
frequency band (High, Mid, and Low) can be switched on or off (flat), so that you do not need to touch the
dB knob to compare the signal with and without eq. Simply click the High, Mid, or Low button to disable
the corresponding band (indicator goes out).
If you need a fully parametric multi-band equalizer, assign the EQ-1 module to three consecutive slots and
use only the Mid band, since this can be tuned to any frequency between 44.1Hz and 17.640kHz.
- dB (cut/boost) (-15dB~15dB)dB (cut/boost) (-15dB~15dB)

This parameter appears on all three bands. It is used to boost (positive values) or cut (negative values)
the level of the frequency band in question.

- High Hz (1,323~19,845Hz - dependent on sample rate)High Hz (1,323~19,845Hz - dependent on sample rate)
This button sets the frequency of the High band. This is a shelving-type filter, which means that all
frequencies above the turnover frequency will also be affected.

- Mid Hz (44.1~17,640Hz)Mid Hz (44.1~17,640Hz)
This button sets the center frequency of the Mid band. This is a peak filter.

- Mid Q (0.333~18)Mid Q (0.333~18)
Use this parameter to set the width of the Mid peak band. The higher this value, the "narrower" the Mid
band.

- Low Hz (44.1~1323Hz)Low Hz (44.1~1323Hz)
This button sets the frequency of the Low band. This is a shelving-type filter, which means that all
frequencies below the turnover frequency will also be affected.

- Volume Gain (-48~12dB)Volume Gain (-48~12dB)
This parameter allows you to reduce (negative values) or increase (values above 0dB) the level.

ExternalizerExternalizer
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
The Externalizer is a plug-in designed for headphone monitoring. It improves the sound and stereo
localization by simulating the effect of two virtual speakers in an ideal listening position. A common
problem when listening to music through headphones, is the phenomenon known as "in-head localization".
This means that each sound source appears to be located inside your head, on an imaginary line between
the ears. Naturally, this is no place where a sound source would ever be situated, and the result is therefore
perceived as unnatural. However - headphone monitoring doesn’t have to be this way! Anyone who has
listened to binaural recordings, those made with a 'dummy head' and two microphones, will confirm this,
and will probably remember the transparent and natural sound impression for a very long time. Steinberg
Externalizer provides this experience with any audio material, by recreating the effect of two virtual
speakers in an ideal listening position. This will transform any recording into something that is a pleasure,
rather than a pain, to listen to on headphones.
Since the Externalizer window only has one control, it is very simple to use:
Listen to a stereo recording in your headphones and use the fader to adjust the sound to your liking. When
you raise the fader, you will gradually move the virtual speakers apart and away from your head, as
indicated in the display.
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LevelerLeveler
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
This "effect" simply reduces or boosts the signal level. This is useful for matching levels between effects.
You may want to patch in the Leveler after an EQ-1 module, for example.
- Volume Gain (-48~+12.0dB)Volume Gain (-48~+12.0dB)

This parameter allows you to reduce (negative values) or increase (values above 0dB) the level.

Tools OneTools One
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
Tools One is an extremely useful "effect" for various applications.
- Out Level (-48~12dB)Out Level (-48~12dB)

This parameter allows you to reduce (negative values) or increase (values above 0dB) the level.
- Phase Left, Phase Right (Normal, Invert)Phase Left, Phase Right (Normal, Invert)

Use these "switches" to invert the phase of the left or right channel (or both).
- Algorithm (No algorithm, MS Process, Channel Swap)Algorithm (No algorithm, MS Process, Channel Swap)

No algorithm means that the stereo sound image is preserved as is.
MS process can be used in one of two ways:

- To transform an incoming "regular" stereo signal so that it resembles a signal recorded according to the
M-S (middle/side) principle. This technique is often used in broadcasting to record the direct signal
source (usually a voice) using one microphone, and the ambience using a second microphone
positioned at a 90_ angle.

- To transform an incoming MS signal into a "regular" stereo signal (to simulate an "XY" recording
technique, where neither microphone is placed directly in front of the signal source).

Channel Swap, finally, means that the left channel is assigned to the right side and the right channel to the
left side.

ReSamplerReSampler
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
This "effect" plays back the file at another sample rate. This is similar to the Convert Sample Rate.
However, since the ReSampler processor operates in real time, it lets you play back files at a certain sample
rate, regardless of which rate they were recorded at.
Please note that if your files already match the card’s sample rate, you do not need to use this processor at
all.
One situation where this processor is extremely useful is when you are mastering digitally to a certain
sample rate (see the Mode parameter below).
- Samp. Freq (Sample Frequency) (22,05~96kHz)Samp. Freq (Sample Frequency) (22,05~96kHz)

This is used to set the desired sample rate.
- Quality (Low, Medium, High)Quality (Low, Medium, High)

The higher the quality, the more computer processing power is required. The option you select here
depends largely on the processing capabilities of your computer and the other effects you are using.

- Fine (22,05~96kHz)Fine (22,05~96kHz)
The Fine control allows you to set any sample rate between the set Sampling Frequencies. Please note
that Fine control is not active if the Sample Frequency is set to either 22,05 or 96kHz. To access
frequencies in between 22,05 and 32kHz set the Sample Frequency to 32kHz and scale down.
Correspondingly, to access frequencies between 88,2 and 96kHz, set the Sample Frequency to the lower
rate and scale up.
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ReverbReverb
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
The Reverb adds "ambience" or "room quality" to a sound. The relationship between the parameters is a bit
intricate, so we suggest you start out by selecting a Preset as close to the desired result as possible and then
modify the settings as desired.
- Size (0~250ms)Size (0~250ms)

Affects the apparent size of the simulated room.
- Width (0~0.98)Width (0~0.98)

This parameter also affects the impression of the size and shape of the simulated room. It also affects
the "density" and clearness of the reverb.

- Time (0~1)Time (0~1)
The length of the reverberation time.

- ER Start) (0~250ms)ER Start) (0~250ms)
The start time of the Early Reflection - the first "echo" from the walls in a simulated room.

- ER Width (0~0.98)ER Width (0~0.98)
The Early Reflection "density" and clarity.

- ER Gain (-40~0)ER Gain (-40~0)
The balance between Early Reflections/direct sound in the input to the reverb. When this parameter is
fully raised, no Early Reflections will be heard.

- ER Decay (0~1)ER Decay (0~1)
Determines the speed of attenuation of Early Reflections. That is, the rate at which they die away.

- ER Outp (-40~0dB)ER Outp (-40~0dB)
The level of Early Reflections in the Effect Output.

- Output Level (-40~0dB)Output Level (-40~0dB)
The stereo output level of the effect.

Dither & NoiseShapingDither & NoiseShaping
Dithering is a method for reducing quantization errors in digital recordings. To the ear, such errors are
perceived as "graininess" during low level passages in a recording. When "truncating bits", as a result of
moving from for example 20 to 16 bit resolution, such quantization errors are added to an otherwise perfect
recording. Although the Dither function is normally accessed via the Master Section, you can also access
the Dither & Noise Shaping functions as a Plug-in during Batch Processing.
- Dither Bits (8, 16, 20, or 24)Dither Bits (8, 16, 20, or 24)

This is used to specify the intended bit resolution for the final audio, after dithering, regardless of
whether you will "Apply" the settings or use real-time processing. It is very important to set this
correctly, especially when reducing the bit resolution.

- Dither method (off, Type 1, Type 2)Dither method (off, Type 1, Type 2)
- Off: No dithering is applied.
- Type 1: Try this option first, it is the best "all-round" method.
- Type 2: This method emphasizes higher frequencies more than Type 1.

- Noise Shape (off, type 1~3)Noise Shape (off, type 1~3)
This parameter alters the character of the noise added when dithering. There are no hard and fast rules,
but you may notice that the higher the number you select here, the more the noise is moved out of the
ear’s most sensitive range, the mid-range.
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Noise GateNoise Gate
This plug-in is available both as a  VST and a WaveLab plug-in. It can be used as a Clip effect in the Audio
Montage, or as a global effect in the Master Section
The Noise Gate plug-in mutes any signal that falls below a specified threshold level. This can be useful for
removing unwanted residual noise from audio material without having to manually clean up or mute
soundfiles. Other applications include gating reverb "tails" and tightening percussion tracks.
- Threshold (-144~-12dB)Threshold (-144~-12dB)

This setting determines at what level the Noise Gate is activated. Any signal or portion of a signal that
falls below the chosen threshold will be muted.

- Rel Time (1~5000ms)Rel Time (1~5000ms)
Determinines how long the gate stays open after a signal below the Threshold level has been detected.

- Rel Sens (1~100)Rel Sens (1~100)
This setting is used to prevent the gate from being triggered on/off inadvertently when the signal is close
to the threshold level.

- Attack Sens (1~100)Attack Sens (1~100)
Determines the time it takes for the gate to open. A low setting provides a fast transient response but a
high setting will soften or mute the early portion of the sound which is triggering the gate.

Peak MasterPeak Master
This plug-in is available both as a  VST and a WaveLab plug-in. It can be used as a Clip effect in the Audio
Montage, or as a global effect in the Master Section
This plug-in provides a safe and transparent way of boosting the percieved loudness of audio material. By
limiting transients and simultaneously raising the general level by compression, the Peak Master will
increase the subjective loudness of the signal without risk of distortion inducing peaks.
- Input Gain (-12~+24dB)Input Gain (-12~+24dB)

This allows you to adjust the input level to Peak Master. Use this to (typically) raise the loudness of the
signal. Use extreme boost settings with caution as they can induce distortion.

- Out Ceiling (-18~0dB)Out Ceiling (-18~0dB)
This setting determines the maximum level at the Peak Master outputs.

- Softness (-5~5)Softness (-5~5)
This parameter affects the way the Peak Master operates. A high setting will maximise the percieved
loudness effect but can in some cases result in a slight harshness of the sound. Adjust this parameter to
optimise the balance between sound quality and the desired effect.

PuncherPuncher
This plug-in is available both as a  VST and a WaveLab plug-in. It can be used as a Clip effect in the Audio
Montage, or as a global effect in the Master Section
The Puncher plug-in works by generating additional harmonics which are added to the audio material. The
result is a more dynamic, and "punchier" sound, particularly when applied to drums and percussive
material. Compared to the PeakMaster the Puncher plug-in could be described as operating in almost the
opposite way. Puncher leaves quiter parts untouched but will add power to the louder portions without
causing clipping. The plug-in is optimized for peak signal levels between 10 and 0dB, the closer to 0dB, the
better.
- Density (Soft, Medium, Hard)Density (Soft, Medium, Hard)

The difference between these 3 settings lies in the number of added harmonics. The setting you use is
dependent on the audio material and how much Punch effect you want to add.

- Effect (0~100%)Effect (0~100%)
This adjusts the balance between the processed and the dry signal.

- Input Gain (-12~24dB)Input Gain (-12~24dB)
This sets the input level. If you boost the signal clipping could occur, so use this with caution. With no
boost, Puncher will never cause clipping.



Plug-in Processor ReferencePlug-in Processor Reference WaveLab 3WaveLab 3

156156

StereoEchoStereoEcho
This is a VST plug-in. It can be used as a Clip effect in the Audio Montage, or as a global effect in the
Master Section
The Stereo Echo is a delay with separate settings for the left and right channel. It can also be used as a
single mono delay, in which case the maximum delay time will be doubled.
The Stereo Echo has the following parameters:
- Delay 1Delay 1

The delay time for the left channel. The maximum delay time is 1486 ms, unless you link both channels
for mono operation, in which case the maximum delay time is 2972 ms - see below (1000ms = 1
second).

- Feedback 1Feedback 1
This sets the amount of delayed signal fed back into the Delay 1 block, to create repetitions. Higher
values result in a higher number of  echo repeats.

- Link 1-2 (Off, Linked)Link 1-2 (Off, Linked)
Select Off if you wish to use Delay 1 and Delay 2 as two independent blocks. Select Linked if the output
of Delay 1 is to be connected to the Input of DelayÊ2.

- Delay 2, Feedback 2Delay 2, Feedback 2
These parameters are identical to these but apply to the second Delay block.

- Del2 BalDel2 Bal
This parameter determines how much of the left channel output is sent to the right channel input. When
set to 0.0 (fully left), then none of the left channel output is added to the right channel input; when it is
set to 1.0 ( fully right), the right input receives both its normal source and the complete output of the left
channel.

- Volume LVolume L
The output level of the left channel delay.

- Volume RVolume R
The output level of the right channel delay.

StereoExpanderStereoExpander
This is a "native WaveLab plug-in". It cannot be used as a Clip effect in the Audio Montage.
The StereoExpander plugin narrows or enlarges the stereo width of an existing stereo signal. There is only
one parameter:
- Stereo effectStereo effect

A value of 0% produces two equal output channels (the original stereo image is lost). Values between 1
and 49% correspond to a narrower stereo image. A value of 50% corresponds to the original signal.
Values between 51 and 100% enlarge the stereo image.

StereoExpander VSTStereoExpander VST
This is a VST plug-in. It can be used as a Clip effect in the Audio Montage, or as a global effect in the
Master Section
The StereoExpander VST plugin narrows or enlarges the stereo width of an existing stereo signal. There is
only one parameter:
- Stereo effectStereo effect

A value of -100% produces two equal output channels (the original stereo image is lost). Values between
-99 and -1 correspond to a narrower stereo image. A value of 0 corresponds to the original signal.
Values between 1 and 100 enlarge the stereo image.
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VST DynamicsVST Dynamics

AutoGate (VST Dynamics)AutoGate (VST Dynamics)
Gating, or noise gating, is a method of dynamic processing that silences audio signals below a certain set
threshold level. As soon as the signal level exceeds the set threshold, the gate opens to let the signal
through. AutoGate offers all the features of a standard noise gate, plus some very useful additional features,
such as auto calibration of the threshold setting, a look-ahead predict function, and frequency selective
triggering. Available parameters are as follows:
- ThresholdThreshold
This setting determines the level where AutoGate is activated. Signal levels above the set threshold triggers
the gate to open, but signal levels below the set threshold will close the gate.
- AttackAttack

This parameter sets the time it takes for the gate to open after being triggered. If the Predict button is
activated, it will ensure that the gate will already be open when a signal above the threshold level is
played back. AutoGate manages this by looking ahead in the audio material, checking for signals loud
enough to pass the gate.

- Trigger Frequency RangeTrigger Frequency Range
AutoGate has a feature that allows the gate to be triggered only by signals within a specified frequency
range. This is a most useful feature because it lets you filter out parts of the signal that might otherwise
trigger the gate in places you don’t want it to, thus allowing more control over the gate function. The
Trigger Frequency Range function is controlled using the control in the upper part of the AutoGate
panel, and the slider located below it. While playing back audio, drag the slider to the "Listen" position.
You will now monitor the audio signal, and the gate will be bypassed. While listening, drag the two
handles in the Trigger Frequency window to set the frequency range you wish to use to trigger the gate.
You will hear the audio being filtered as you move the handles. Dragging the left handle to the right
will progressively cut frequencies starting from the low end of the frequency spectrum. Dragging the
right handle to the left will progressively cut frequencies starting from the high end of the frequency
spectrum. After setting the frequency range, drag the slider to the "On" position. AutoGate will now use
the selected frequency range as the trigger input. To disable the Trigger Frequency Range function, drag
the slider to "Off". AutoGate will now use the unfiltered audio signal as the trigger input.

- Calibrate FunctionCalibrate Function
This function, activated by using the Calibrate button located below the Threshold knob, is used to
automatically set the threshold level. It is especially useful for material with consistent inherent
background noise in the audio material, like tape hiss for example. This may most of the time be
masked by the audio content, but becomes noticeable during silent passages. Use as follows: Find a part
of the audio material, preferably not too short, where only the background noise is heard. If you can
only find a short background noise section, try looping it. Play it back, and click on the Calibrate
button. The button will blink for a few seconds, and then automatically set the threshold so that the
noise will be silenced (gated) during passages where there is no other signal present.

AutoLevel (VST Dynamics)AutoLevel (VST Dynamics)
AutoLevel reduces signal level differences in audio material. It can be used to process recordings where the
level unintentionally varies. It will boost low levels and attenuate high level audio signals. Only levels
above the set threshold will be processed, so low level noise or rumble will not be boosted. If the input level
is greater than 0dB, AutoLevel will react very fast, because it looks ahead in the audio material for strong
signal levels and can attenuate levels before they occur, thus reducing the risk of signal clipping.
- ThresholdThreshold

Only levels stronger than the set threshold will be processed.
- Reaction Time SwitchReaction Time Switch

This parameter sets the amount of time it takes for AutoLevel to adjust the gain. Set this according to
whether the program level changes suddenly or over a length of time.
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Compress (VST Dynamics)Compress (VST Dynamics)
Compress reduces the dynamic range of the audio, so that softer sounds get louder or louder sounds get
softer, or both. Compress functions like a standard compressor with separate controls for threshold, ratio,
attack, release and make-up gain parameters. Compress features a separate display that graphically
illustrates the compressor curve shaped according to the Threshold, Ratio and MakeUp Gain parameter
settings. Compress also features a Gain Reduction meter that shows the amount of gain reduction in dB,
and a program dependent Auto feature for the Release parameter.
- ThresholdThreshold

This setting determines the level where Compress "kicks in". Signal levels above the set threshold are
affected, but signal levels below are not processed.

- RatioRatio
Ratio determines the amount of gain reduction applied to signals over the set threshold. A ratio of 3 :1
means that for every three dB the input level increases, the output level will increase by only one dB.

- AttackAttack
This determines how fast Compress will respond to signals above the set threshold. If the attack time is
long, it means that more of the early part of the signal (attack) will pass through unprocessed.

- ReleaseRelease
Sets the amount of time it takes for the gain to return to its original level when the signal drops below
the Threshold level. If the "Auto" button is activated, Compress will automatically find an optimal
release setting, that varies depending on the audio program material.

- MakeUp GainMakeUp Gain
This parameter is used to compensate for output gain loss, caused by compression.

SoftClip (VST Dynamics)SoftClip (VST Dynamics)
SoftClip is designed to ensure that the output level never exceeds 0dB, like a limiter. SoftClip, however,
acts differently compared to a conventional limiter. When the signal level exceeds -6dB, SoftClip starts
limiting (or clipping) the signal "softly", at the same time generating harmonics which add a warm, tubelike
characteristic to the audio material. SoftClip is simplicity itself to use as it has no control parameters. The
meter indicates the input signal level, and thus the amount of "softclipping". Levels in the green area
(weaker than -6dB) are unaffected, while levels in the yellow-orange-red area indicate the degree of
"softclipping". The deep red meter area to the right indicates input levels higher than 0dB. Avoid feeding
SoftClip with excessively high signal levels as audible distortion may occur, although the output level will
never exceed 0dB.

Limit (VST Dynamics)Limit (VST Dynamics)
Limit is designed to ensure that the output level never exceeds a certain set output level, to avoid clipping
in following devices. Conventional limiters usually require very accurate setting up of the attack and release
parameters, to totally avoid the possibility of the output level going beyond the set threshold level. Limit
adjusts and optimizes these parameters automatically, according to the audio material. However, should
you want to, you can adjust the Release parameter manually.
- ThresholdThreshold

This setting determines the maximum output level. Signal levels above the set threshold are affected,
but signal levels below are left unaffected.

- ReleaseRelease
This parameter sets the amount of time it takes for the gain to return to its original level when the signal
drops below the threshold level. If the "Auto" button is activated, Limit will automatically find an
optimal release setting, that varies depending on the audio program material.
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Sampler DetailsSampler Details
SDS - Generic Sample Dump StandardSDS - Generic Sample Dump Standard

Sampler Operating system required:
Latest available.
MIDI:
Required.
SCSI:
N/A.
Loops:
One.

SMDI (Standard SCSI transfer)SMDI (Standard SCSI transfer)

Sampler Operating system required:
Latest available.
MIDI:
N/A.
SCSI:
Required.
Loops:
One.

Akai S1000/1100 including PB modelsAkai S1000/1100 including PB models

Sampler Operating system required:
4.30 or later.
MIDI:
Required. Also supports SDS.
SCSI:
Not supported.
Loops:
One.

Akai S2000/S2800/S3000/S3200, including all "i", CD, and "XL" derivatives etc.Akai S2000/S2800/S3000/S3200, including all "i", CD, and "XL" derivatives etc.

Sampler Operating system required:
1.50 or later.
MIDI:
Required. Also supports SDS.
SCSI:
Not supported.
Loops:
One.
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Ensoniq, EPS, EPS16+, ASR-10, ASR-88Ensoniq, EPS, EPS16+, ASR-10, ASR-88

Sampler Operating system required:
EPS: 2.40
ASR-10: 2.53
Other: the latest
MIDI:
Required. Also supports SDS.
SCSI:
Not supported.
Loops:
One.

E-mu Esi-32E-mu Esi-32

Sampler Operating system required:
2.10 or later
MIDI:
Not supported, unless you use SDS.
SCSI:
Required for sampler specific protocol, also supports SMDI.
Loops:
One.

E-mu EIV, e64 and other samplers running the EOS operating systemE-mu EIV, e64 and other samplers running the EOS operating system

Sampler Operating system required:
2.50 or later
MIDI:
Not supported, unless you use SDS.
SCSI:
Required for sampler specific protocol, also supports SMDI.
Loops:
One.

Kurzweil K2000 and K2500Kurzweil K2000 and K2500

Sampler Operating system required:
K2000, 3.01 or later, K2500, 2.13 or later
MIDI:
Required, unless you use SMDI. Also supports SDS.
SCSI:
Optional, also supports SMDI.
Loops:
One.

Roland S-760Roland S-760

Sampler Operating system required:
2.17 or later
MIDI:
Required. Also supports SDS.
SCSI:
Not supported.
Loops:
Two.
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TroubleshootingTroubleshooting

General problemsGeneral problems
Can't create a temporary file

• Please check again which drive is specified for your temporary files (in the Preferences dialog). You
cannot use a CD-ROM disk or a write protected drive for your temporary files.

• Is the drive full? Please select a drive with as much free space as possible.
A drive/partition can't be found

• Is this volume a removable drive, a CD-ROM or a floppy? In that case, is the correct disk really in the
drive?

• Have you renamed the Volume since you last used the program?
A file can't be deleted or renamed

• Is the volume on which the file is residing write protected? Then turn the write protection off.
• Is the file on a CD-ROM? Files can not be deleted from CD-ROMs.
The program opens/doesn't open with the same files each time

• This is not a bug, it's a feature! You can decide whether you want the program to boot up as you last left
it or not. This is done by activating/deactivating "Save window layout on exit" in the Preferences
dialog. See Preferences Topics.

My snapshots are gone!

• Snapshots are not saved with each audio file. There are two ways to make sure your snapshots "stay"
from session to session:

- Use Save Window layout on exit (described above) to restore all settings just as you left them.
- Make the file part of a Project and open it from there. Snapshots are saved with the opened windows of

a Project.
The cursor flickers

• Under Windows 95, color cursors have a tendency to flicker a bit. This is not related to WaveLab in
any way. If this is a problem, deactivate "Use mouse cursors in color" in the Preferences dialog.

The display flickers too much in general

• If you have a very slow computer we suggest you deactivate "Flicker free sample redraw" in the
Preferences dialog.

The wave cursor has the wrong color

• This is not a bug. To make screen redraws as fast and smooth as possible, the wave cursor is actually
drawn in the opposite color of the one specified. In other words, red becomes green, yellow becomes
blue and so on. While we acknowledge that this is slightly inconvenient, we hope you appreciate it
helps the program to operate as smoothly as possible.

The wave isn't styled as when I opened it last

• The styling is not saved with each audio file. There are two ways to make sure your files look the same
from session to session:

- Use "Save window layout on exit"  to restore all settings just as you left them.
- Make the file part of a Project and open it from there. The styling is saved for each opened window of a

Project.

Problems with Opening filesProblems with Opening files
The file doesn't appear in the Open dialog.

• Does the file have the right extension? Select "All files (*.*)" from the pop-up in the Open dialog and
check again.

• Is the drive on which the file is currently accessible? If you use removable hard disks or CD-ROMs,
make sure the right disk is in the drive.
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Can't open a file

• Is the file really an AIFF or WAV file?
• Does the file open in other programs that support audio files in these formats? If not, it is probably

damaged.
• If it is a WAV file, try opening it in the Media Player application, included with Windows. If that

doesn't work, the file is probably damaged. Note that WaveLab carefully checks the file headers: if any
mistake in the format is found, WaveLab does not open the file for safety reasons. This could happen
(rarely) with some files created by non professional software.

• If you use Windows 95, it is important that your virtual memory settings are correct if you work with
large audio files. In the Windows 95 Control Panel, open the System setup and click on the Virtual
Memory button. Then click on the button "Let me specify my own memory settings". Specify 40
MegaBytes as the maximum value and twice your RAM size as the maximum value.

• Is the drive in which the file is residing currently accessible? If you use removable hard disks or CD-
ROMs, make sure the right disk is in the drive.

Can't open dual mono files

• Open the Preferences dialog, click on the File tab and activate "Allow opening of dual mono files".

Problems with Saving filesProblems with Saving files
Can't save

• Is the volume on which you are trying to save write protected? You can for example not save anything
on a CD-ROM.

• Is there enough space on the drive?
• Is the drive to which the file was last saved currently accessible? If you use removable hard disks or CD-

ROMs, make sure the right disk is in the drive.
• Are you trying to overwrite another file with the same name? Is that file then write protected? If it is, it

can't be overwritten. Save under another name.
• Are you trying to overwrite another file with the same name? Is that file open? If it is, close it and try

again.
• To get around all of the problems listed above, try saving to another disk/folder.

Recording problemsRecording problems
I can't record

• Are you trying to record at a sample rate/bit resolution that your card doesn't support? Check the
documentation for the card, to find out which formats it supports.

• Is the card really installed correctly? Try using some application included with the card to see if that
works. Also try the "Sound recorder" included with Windows.

• Do you have the latest driver for your card? Is it a driver designed specifically for Windows 95? Contact
your dealer for the latest driver.

• Are your temporary files set up correctly and do you have enough free space on that drive?
My recordings are silent

• Do the meters move when you record? Do you get a waveform in the window? If you do, the recording
is not the problem, it is the playback.

• Check the Mixer. Do you have the correct recording inputs activated and the levels set properly?
• If you can't seem to activate the correct inputs and levels from WaveLab, try the mixer application that

was included with your audio card. Some card drivers do not react correctly to the standard Windows
commands transmitted by WaveLab.

• Please check your cables and the devices you have connected. Is there really a proper audio signal
coming in to the card?

My recordings contain "crackles" and "pops"

• This might be because you have an early Windows 95 driver for your card. As a temporary fix, activate
"Fix Win 95" in WaveLab's Record dialog. Please contact your dealer to make sure you have the latest
Windows 95 specific driver for the card.
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There is too much noise in my recordings

• Have you adjusted your recording levels properly?
• Is the source connected to the proper input?
• Have you specified 8 bits as your bit resolution? Try 16 bits instead. Moreover, be sure to have  the

"Play as 8 bit" item unchecked in the Option menu.
• Keep in mind that the microphones provided with sound cards are very low quality microphones.
The mixer can't be "created"

• Have you specified your audio card in the Preferences dialog? A Mixer can't be created if "Microsoft
Sound Mapper" is selected.

• Do you have the latest and correct driver for your card? We have noted that some card drivers contain
"bugs" that prevent a mixer from being created.

Playback problemsPlayback problems
No playback at all

• Is the card really installed correctly? Try using some application included with the card to see if that
works. Also try the "Media Player" included with Windows. If that doesn't work, there's something
wrong with the card or the installation.

Playback is choppy

• Are you using a compressed hard drive? You should not use WaveLab on such drives because they eat
up too much processor power! WaveLab is very CPU intensive.

• To play a quality wave (eg. 16 bit Stereo 44,1 kHz file) from a CD-ROM, your CD-ROM reader must
be at least of a "Double Speed" type.

A file can't be played

• Is the file really in a format (sample rate, bit resolution mono/stereo) supported by your audio card?
The format of the file is indicated on the status bar.

Playback is silent

• Check the Volume setting in WaveLab (the speaker button on the Control bar). Check also the global
volume of the sound card with the Windows application "SndVol32.exe".

• Do you have an application for the audio card that allows you to adjust playback volumes? Are these
settings correct?

• Check the cables and the other audio equipment you use.

Editing problemsEditing problems
After editing I get clicks and pops

• Are you making "splices" in the middle of an audio section? If you do, we recommend that you make
all cuts at zero crossings, to avoid clicks and pops.

After equalizing the sound is distorted

• It is possible to boost frequencies up to a point where clipping occurs, and the sound is distorted. If this
happens, undo the equalizing, lower the gain of the recording (by 3 or 6 dB for example) and try again.

When I drag and drop I get a crossfade

• This happens since you drop on a selection. Click once somewhere outside the selection of the
destination wave (or press [Esc]) and try again.

After crossfading I get distortion

• If both sections play at full level during the crossfade, it is possible that clipping will occur (although it is
unlikely). If this happens, undo the crossfade, lower the gain of both sections (by 3 or 6 dB for example)
and try again. The problem cannot happen if you check the "Invert of Fade In" or "Invert of Fade Out"
options.

Database and Project problemsDatabase and Project problems
Where are my files in the Database?

• See Database File Topics.
• Do you have the Global Filter activated? Turn it off.
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A new database/project can't be created

• Is the volume where you try to store the file write protected? For example, you cannot create Databases
and Projects on CD-ROMs.

• Is the disk full?
A file can't be found opened or played

• Has the name or the extension of the file been changed since you last used the Project/Database? Please
try to open the file from the Open dialog?

• Have you moved the file to another folder?
• Have you renamed the Folder (in the Database)?
• Is the drive on which the file was residing currently accessible? If you use removable hard disks or CD-

ROMs, make sure the right disk is in the drive.
Not all files get added to database as expected

• When performing a "Scan Disk" operation, the list will not display all files just registered, but only those
from the last scanned folder. Please also check the "Maximum list size" in the Database part of the
Preferences dialog.

A file can't be renamed or deleted
• Is the volume on which the file is residing write protected? Then turn the write protection off.
• Is the file on a CD-ROM? Files on CD-ROMs cannot be deleted or renamed.
• Is the drive to which the file was last saved currently accessible? If you use removable hard disks or CD-

ROMs, make sure the right disk is in the drive.

Sampler communication problemsSampler communication problems
General precuations

• Not all samplers require or even support MIDI transfers. However, in some cases, where SCSI is
supported, MIDI is required anyway! See the section Sampler Details in this on-line help, for details!

• If you use MIDI, remember that two way communication is always required!
• Some MIDI cards and drivers have problems with the heavy MIDI SysEx communication required

when transferring audio data. Serial port interfaces are not recommended for sampler communication.
Sampler Transfer doesn't work at all or not reliably

• Does the sampler have the required OS?
• Does it require MIDI? In some cases, where SCSI is supported, MIDI is required anyway!
• Does it require SCSI? Some samplers are not supported via MIDI at all.
• If the sampler supports MIDI, try only MIDI first. When this works correctly, switch to, or add SCSI

and try again.
• If MIDI is required, is two way communication really established? Check patcher, MIDI interfaces etc.

Try with a simpler connection and/or MIDI interface.
• If MIDI is required, is the interface connected properly and setup correctly?
• Is the MIDI driver installed correctly? Do other programs work?
• If MIDI is required, is some other program blocking MIDI? Is Cubase running with Play in Background

active?
• Recheck your MIDI SysEx ID settings. If these are not in accordance with the settings in WaveLab,

transfers won't work.
• If SCSI is used (or required), are IDs, terminators and everything else set up as they should be? Does the

sampler appear on the SCSI bus at all? See the installation chapter in the printed documentation.
• Try with less units on the SCSI bus, preferably only the sampler and the computer.
• Is some other program using MIDI at the same time? Make sure ReCycle has the MIDI connectors to

itself during transfers.
• For SCSI, check termination, SCSI card driver versions and everything else related to the SCSI setup.
• Try with less units on the SCSI bus, preferably only the sampler and the computer.
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CD-R Troubleshooting and PrecautionsCD-R Troubleshooting and Precautions

Troubleshooting and PrecautionsTroubleshooting and Precautions
This section is prepared for three reasons (and divided into the following sections):
- Setup and Hardware issues. This helps you check that your hard disks, system, CD-R drive etc. are

installed and set up correctly for CD-R writing.
- Day to day precautions. This is to help you ensure trouble free CD-R writing in your daily work.
- Problems and solutions. To solve any immediate problems you run into.
Please note that Steinberg can not make any guarantees about the validity of your recorded audio CDs.Please note that Steinberg can not make any guarantees about the validity of your recorded audio CDs.

Problems and solutionsProblems and solutions
General instructions

• If you run into problems, the first thing to check is your hardware and software setup. To isolate the
problem, you could try using other CD-R writing software (for example a simple CD-ROM creation
program that comes with the CD-R unit). If this doesn't work either, the problem isn't with WaveLab,
but with some other component in the system.

• When you insert a disk into the recorder, make sure you wait long enough before you start using it. You
might have to wait several seconds. Watch any possible LEDs on the front panel. They will indicate
when the unit is ready for using (see the operation manual for the unit for details).

• If your CD-R recorder doesn't respond, the first thing to do is to eject the disc and insert it again. This
will reinitialize the recorder.

• If this doesn't work, you might try switching off the recorder (even if the computer is still on), wait three
seconds and then turn it back on again. Often, only rebooting the computer is not enough.

Questions and Answers

• I can't seem to get windows 95 to recognize the CD-R unit at all under Windows 95, even though  I
have followed all instructions for installing the SCSI card and the CD-R unit.

Go back again and check all SCSI related issues: termination, IDs, cables and SCSI card installation. This
is not really a WaveLab problem but rather a hardware installation problem.
Check your CONFIG.SYS file for old SCSI drivers, such ASPICAM.SYS or DOSCAM.SYS. Remove
these and try again.

• I get SCSI communication errors and system lockups on a system with an Adaptec 2940 SCSI
controller.

If you run Windows 95, make sure you have the latest 32-bit driver (downloadable from the Adaptec FTP
site). This normally solves any problems.

• I have problems writing CDs on a system where Corel CD Creator is installed.
WaveLab is not compatible with Corel CD Creator. This is because Corel use their own SCSI drivers
whereas WaveLab relies on the standard Windows SCSI drivers. To disable the Corel drivers, remove the
following files from your WINDOWS\SYSTEM\IOSUBSYS folder: CDRASPI.VXD,
VLD_CUNI.VXD, VXDASPI.VXD and restart the computer. If you want to work with Corel CD creator
later, reinstall it from the original disc(s).

• I have problems with a Philips CDD-2000 unit.
If you have a real Philips drive or a drive that contains this Philips mechanism, you must make sure that
the firmware version is 1.25 or later. A firmware update can be found at
http://www.philips.com/sv/pcaddon.

• I get buffer under-run messages when writing to CD.
This should only happen on less powerful computers. If you have more than 16MB of RAM you can try
the following: Open the Control Panel and double click on the System icon, select the Performance tab and
click on the File System button. Change "Typical Role of this machine" to Network Server. This re-
prioritizes the internal hard disk so that it is given priority over other hardware and software functions.
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• I have other problems writing a CD and/or importing CD audio tracks.
Well of course there could be many reasons for this. Check the Day to day precautions for trouble free CD
writing topic. But, here are two more things to try:
Open the Control Panel, and double click on System. Select the Device Manager tab, select CD-R in the
list (if this entry exists, which is not mandatory) and click on the Properties button and then select Settings.
Disable the "Insert auto notification" to prevent Windows from reading from the CD-R during the writing
process.
If you have problems at 4x speed, try at 2x, then at 1x. Even if your system writes correctly at 4x most of
the time, it's safer to write at 2x or even 1x.

• I have problems writing CDs when I specify ISRC and EAN/UPS codes, but otherwise things work
fine.

If you try to write a ISRC code or EAN/UPC code, WaveLab might return an error if: a) the CD recorder
does not support this (not all do, or not all firmware versions do). b) the codes are not properly formatted:
UPC/EAN: 13 numeric characters. ISRC: 5 alphanumeric followed by 7 numeric characters.

• A CD disc that I have created doesn't play correctly on my CD player.
The reflection of a "normal" CD and a CD-R are different (a CD-R reflects less light). A dirty lens on the
CD player might disturb playback. This is more common on old CD players because their lasers do not
properly calibrate for recordable CDs. Sometimes, the combination of disc brand and CD recorder brand
can make a difference.

• Audio tracks that I copied off an audio CD contain noise.
Audio CDs were not made to be transferred digitally and for this reason, there is less error correction
available in audio tracks (an audio CD contains up to 780 MB of data, while a "file" CD can only contain
650 MB of data because a lot of space is used to store error correction data). Errors in an Audio track are
not as important as errors in CD-ROMs, since the audio CD players will correct many of the problems on
playback without audible distortion. This is not done by the CD recorder when transmitting to the SCSI
bus, which means that these errors will be part of the digital image of the track. The number of errors
depends on the quality of the CD (scratches etc.).

• I can't write track Sub-Indexes.
Some CD recorders are simply not capable of this. Some others can only write 50 Sub-Indexes per track for
example, and some others only 100 Sub-Indexes per CD. This depends on the CD-R firmware.

Day to day precautions for trouble free CD writingDay to day precautions for trouble free CD writing
The most important thing to remember is that CD writing is a real-time operation where a laser inscribes
pits into the surface of the CD. This is done at a speed which cannot be slowed down or interrupted. Any
interruption will most likely be fatal, rendering the CD-R disk useless. For these reasons you should make
sure your system does not interrupt the CD-R writing once it's under way. Read the following points:
• Keep the CD-recorder on a vibration-free surface. Sudden "shocks" could cause writing interruptions.
• Do not read files directly from a CD, copy them to a fast hard disk first.
• Do not read files across a network. Networks are usually far too slow for CD-R writing.
• Turn off networking, at least for the hard disk drive from which you are reading. If anyone tries to

access this drive while writing, this might interrupt the CD-R operation.
• It is best to store the files on a hard disk partition that is 1 gigabyte in size, or smaller (since this means

the sectors will be 16kByte rather than 32kByte).
• Do not read files from a hard disk with compression enabled !
• It is highly recommended that you keep your hard disk(s) defragmented at all times. Windows 95 has a

tool for this (right click on a drive icon and select " Properties "). For Windows NT, there is a
commercial solution called "Diskeeper" (http://www.execsoft.com).

• If you have multiple hard drives on your system, put the audio files on your fastest drive! Also use a fast
drive for WaveLab's "temp" files.
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• Turn off Auto Insert Notification for every CD unit on your SCSI bus, including the CD recorder. To
do this, open the Control Panel and double click on the System icon. Select the Device Manager tab.
Select the CD unit in the window, click on the Properties button, locate the Auto Insert Notification
setting and disable it.

• Turn off any screen savers, anti-virus, schedulers, animated icons and alarm- or reminder programs that
might interrupt the CD burning operation.

• Make sure any fax reception or background email software is disabled.
• If you use the System Agent, make sure no activities are scheduled for the time you write to the CD. Do

no use the "When Idle" option in the System Agent.
• Disable any System Monitoring programs.
• If you use the CD-R unit as a CD-ROM reader, make sure you quit the Explorer and close any "My

Computer" windows before writing.
• Stop audio playback in WaveLab before writing.

Hardware and Setup issuesHardware and Setup issues
SCSI

• Proper termination is one of the most crucial SCSI subjects! I you have an external CD-R unit, we very
strongly recommend active SCSI terminators (see your computer dealer).

• Always use high quality SCSI cables.
• Put your CD-R unit preferably as the first device in the SCSI chain.
• If possible, make sure your SCSI card, CD-R unit and any hard disks on the SCSI chain are all SCSI-2

compatible.
• To give the CD-R the highest SCSI priority, set it to the largest possible SCSI ID (usually 6, since 7 is

occupied by the SCSI controller.). Side note: On a Wide SCSI bus which has 16 available SCSI IDs, the
priority order is (from highest to lowest) 7, 6,... 0, 15, 14,...8.

• Always makes sure you have the very latest drivers installed for your SCSI card. Normally the latest
driver is available for download from the vendor's web pages or BBS.

• Make sure you don't have any non-Windows 95 32 bit drivers installed for the SCSI card. If you do,
remove them and/or replace them with the latest Windows 95 driver. If in doubt, contact the card
vendor.

• If you have installed a non-standard SCSI driver, this might prevent WaveLab from properly writing
CDs. To switch back to the standard drivers, proceed as follows: Insert your Windows95 CD. Open a
DOS window. Open the folder WIN95 on the CD (on some CDs, instead open Win95/Setup). Type in
the following DOS command: "Extract /Y /A /E /L c:\temp win95_02.cab wnaspi32.dll". If you can't
seem to find any file called win95_02.cab, try win95_03.cab. or the first file available. Once this is done,
copy the file wnaspi32.dll, located in the new temp folder on your hard disk, to the system folder in
your windows folder. Finally restart the computer.

CD-R Drivers

• If you have previously installed another CD-R software product, you may run into driver conflicts.
Normally this should not happen since WaveLab has built in drivers that are loaded as needed, and
which usually override any other installed drivers. However, if you do have problems writing to CD-R,
this is a point to check.

• If it isn't absolutely required, don't install any other driver for your CD-R unit (for example a driver that
allows you to use the CD-R as a CD-ROM drive). The drivers might make Windows try to access the
drive during writing, which can causes system interruptions.

• Do not use any old 16-bit (real-mode) device drivers in Windows 95. Disable any old CD-ROM drivers
you may have in your CONFIG.SYS file.

• In the advanced BIOS settings of your SCSI host adapter, the following should normally be disabled:
- Plug and Play SCAM Support
- Support Removable Disks Under BIOS as Fixed Disks
- BIOS Support for Bootable CD-ROM
- BIOS Support for Int 13 Extensions

• When installed under Windows95, WaveLab puts a file called "c2rec.vxd" in the folder
/Windows/system/iosubsys/. This is used for CD recording, and should in most cases be left where it
is. However, for some computer/CD-R setups, it might cause compatibility problems with other
programs after installing WaveLab. If this seems to be the case, try removing this file and rebooting.
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Networking Cards

• Network cards can produce hardware interrupts which momentarily halt operation of all software. This
can cause various problems. For CD writing, a non-networked machine is more stable than a
networked one.

• If you need to keep your machine connected to a network try to not load the network card drivers when
you plan to write CDs.

About Hard disks

• Many hard disks automatically perform something called thermal calibration at regular (but
unpredictable) intervals. For this reason, drives sold as "A/V drives" are recommended, since they have
built in "intelligence" which delays any recalibration to times when the disk is not being used. Some
drives not marketed as "A/V Drives" also have this capability, check with the vendor if in doubt.

• SCSI drives are usually better than E/IDE drivers. Having said that, we know of few problems with
E/IDE drives, and a fast EIDE drive is of course better than a slow SCSI drive.

CD-R disks

• There are many brands of CD-R disks. Always use one that has been tested and recommended by your
CD-R drive manufacturer.

• CD-R discs are not as solid as real CDs. Handle them with care! Do not expose discs to sun or other
strong light for long periods, and avoid heat and humidity.

• The top (label) side of a CD-R disc is also vulnerable. Don't use alcohol-based pens to write on discs
and don't put labels on unless they are specifically designed for CD-Rs (otherwise the glue on the label
might eat through the surface).

• Don't stack CD-R disks on top of each other without proper covers.
Links and sources for more information

• Adaptec (SCSI card manufacturers):
- CompuServe: go Adaptec.
- World-Wide Web: http://www.adaptec.com/cdrec/
http://www.adaptec.com/support/cdrec/download.html.
- FTP: ftp.adaptec.com

• A general CD-R site that might be of interest: http://www.osta.org/html/cdr2.html
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Keyboard CommandsKeyboard Commands

Key Commands - File HandlingKey Commands - File Handling
[Control]-[O] Open wave file
[Control]-[S] Save current wave
[Control]-[N] Create new wave
[Control]-[W] Close current document (and all its related windows)
[Control]-[E] Convert Wave to MP3 (Save special - Encode (MP3))

Key Commands - ZoomingKey Commands - Zooming

Main viewMain view
[G] Zoom in horizontally (or Zoom out if Cubase compatibility is enabled)
[H] Zoom out horizontally (or Zoom in if Cubase compatibility is enabled)
[J] Zoom out to display entire wave horizontally
[Shift]-[G] Zoom in vertically  (or Zoom out if Cubase compatibility is enabled)
[Shift]-[H] Zoom out vertically (or Zoom in if Cubase compatibility is enabled)
[Shift]-[J] Zoom in or out to get an optimized level display (best fit)
[K] Zoom selection

OverviewOverview
[Control]-[G] Zoom in horizontally  (or Zoom out if Cubase compatibility is enabled)
[Control]-[H] Zoom out horizontally (or Zoom in if Cubase compatibility is enabled)
[Control]-[J] Zoom out to display entire wave horizontally
[Control]+[Shift]-[G] Zoom in vertically (or Zoom out if Cubase compatibility is enabled)
[Control]+[Shift]-[H] Zoom out vertically  (or Zoom in if Cubase compatibility is enabled)
[Control]+[Shift]-[J] Zoom in or out to see an optimized level display (best fit)

Key Commands - View and SnapshotsKey Commands - View and Snapshots

Adjusting the ViewAdjusting the View
The following commands scroll the window without moving the cursor
[Control]+[Alt]-[Home] Start of Wave
[Control]+[Alt]-[End] End of Wave
[Control]+[Alt]-[Page Up] One window width to the left
[Control]+[Alt]-[Page Down] One window width to the right

SnapshotsSnapshots
The number keys referred to below are the ones on the typewriter part of the keyboard, not on the numeric
keypad. Furthermore these refer to the keys on an American keyboard. Other countries may have other key
caps on the same keys.
[1] to [8] Recall snapshot 1 to 8
[Control]-[1] to [8] Store snapshot 1 to 8
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Key Commands - Playback and Cursor positionKey Commands - Playback and Cursor position
Numeric key padNumeric key pad
[Enter] Play (from current position)
[0] Stop / Move to selection start / Move to beginning
[1] Move cursor to selection start
[2] Move cursor to selection end
[4] Move cursor to previous marker
[5] Move cursor to next marker
[.] (full stop) Scroll to cursor
[/] Loop on/off (current wave only)
[F] Scroll during playback on/off

Function keysFunction keys
The following keys are available even if a dialog is the active window!
[Space Bar] Toggle Play / Stop
 [F8] Play (from current position)
[F7] Stop / Move to selection start / Move to beginning
[F6] Play selection
[F5] Empty the playback buffers
[F9] Activate/deactivate MTC synchronization mode
[F10] Activate/deactivate Jog and Shuttle mode

Cursor keysCursor keys
[ ] Move cursor one pixel left
[ ] Move cursor one pixel  right
[Control]-[ ] Move cursor 1/10 of the window width to the left
[Control]-[ ] Move cursor 1/10 of the window width to the right
[Page Up] Move cursor 1/10 of the window width to the left (or right if Cubase

compatibility enabled)
[Page Down] Move cursor 1/10 of the window width to the right (or left if Cubase

compatibility enabled)
[Control]-[Page Up] Move cursor one window width left  (or right if Cubase compatibility enabled)
[Control]-
[Page Down] Move cursor one window width right  (or left if Cubase compatibility enabled)
[Home] Move cursor to beginning
[End] Move cursor to end
[Tab] Toggle Cursor between left/right/both channels (stereo waves only)

Key Commands - SelectingKey Commands - Selecting
[Esc] Toggle selection on/off
[Tab] Toggle selection between left/right/both channels (stereo waves only)

Extending or making selectionsExtending or making selections
The following commands create a new selection or extend the current one.
[Shift]-[ ] One pixel to the left
[Shift]-[ ] One pixel to the right
[Control]+[Shift]-[ ] 20 pixels to the left
[Control]+[Shift]-[ ] 20 pixels to the right
[Shift]-[Page Up] 20 pixels to the left  (or right if Cubase compatibility enabled)
[Shift]-[Page Down] 20 pixels to the right  (or left if Cubase compatibility enabled)
[Control]+[Shift]-
[Page Up] One window width to the left  (or right if Cubase compatibility enabled)
[Control]+[Shift]-
[Page Down] One window width to the right (or left if Cubase compatibility enabled)
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Making selectionsMaking selections
The following commands always create a new selection
[Shift]-[Home] From cursor to start
[Shift]-[End] From cursor to end
[Control]-[A] Select all

"One the fly" numeric key pad commands"One the fly" numeric key pad commands
The following commands are for selecting during playback. Please note that the keys on the numeric key
pad must be used.
[Shift]-[1] Set start of selection
[Shift]-[2] Set end of selection
[+] Press and hold to set start of selection, release to set end of selection.

Key Commands - Editing and RecordingKey Commands - Editing and Recording

Cut and PasteCut and Paste
[Control]-[X] Cut
[Control]-[C] Copy
[Control]-[V] Paste
[Control]+[Shift]-[V] Paste Append

Delete and SilenceDelete and Silence
[Backspace] Delete current selection
[Control]-[space bar] Silence current selection
[Control]+[Shift]-
[Insert] Insert silence
[Control]-
[Backspace] Trim (to selection)

RecordingRecording
[*] (Multiply on
num key pad) Open Record dialog

Undo and RedoUndo and Redo
Please note that the  function key Undo and Redo commands are available even if a dialog is the active
window!
[Control]-[Z] Undo
[F3] Undo
[Control]+[Shift]-[Z] Redo
[F4] Redo

Key Commands - ProcessingKey Commands - Processing
[N] Normalize
[D] Dynamics
[Control]-[F] Fade in/out
[X] Crossfade
[T] Time stretch
[P] Pitch Correction
[Q] EQ
[Control]-[B] Batch processor

Key Commands - MarkersKey Commands - Markers
[Control]-[M] Open marker list
[Insert] Drop new marker at cursor position (for example during playback)
[Control]-[Insert] Create Marker
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Key Commands - DatabaseKey Commands - Database
[Insert] Add file to database
[Control]-[D] Scan Disk
[Control]-[F] Global Find
[Control]-[G] Global Filter

Key Commands - MiscellaneousKey Commands - Miscellaneous
[F2] Toggle focus between the last 2 accessed windows
[Control] - [F2] Open list of open windows
[Alt] - [Control] - [M] Maximize Wave window width
[W] Show/hide Window controller
[F11] Show/hide Snapshots
[F12] Show/hide Transport
[Control]-[F9] Show/hide Master Section
[Control]-[F10] Show/hide Monitor window
[Control]-[F11] Show/hide Live-input window
[Control]-[P] Open Preferences dialog
[M] Magnetize Bounds on/off
[Z] Zero crossing on/off




